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Legal Notice

Patents

The BLADE wood processing system is made and sold under one or more of the following
patents:

US 6,539,830 ZA 2008/00280

US 6,702,096 DE 1896228

US 7870879 FR 1896228

AU 2006263691 GB 1896228

NZ 564779 US 6702096 (Auto Deck)

For use with US 6539830
For use with AU 783340
For use with CA 2398768

Other patents may apply

Return Goods Policy

Return goods cannot be accepted without prior authorization and are subject to a
restocking charge. The Seller certifies the articles specified herein were produced in
compliance with all provisions of the Fair Labor Standards Act of 1938, as amended,
including Section 12.—Rev. 6/98

Reporting Errors and Recommending
Improvements

To report errors or recommend improvements to this manual, please complete the
Document Evaluation Form in the appendices. Mail or fax the form to:

MiTek Machinery Division

301 Fountain Lakes Industrial Drive

St. Charles, MO 63301

Attn: Engineering Manager, Fax: 636-328-9218
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Notice of Change

Use this page to record Service Bulletins and Notices that you receive to keep your manual
updated.

BLADE™

Wood Processing System
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Refiérase a la
pagina
SEGURIDAD-29
para espafiol.

For safety
information in
Spanish, refer to

SEGURIDAD-29.

Safety (English)

Safety Indicators: Signal Words

The following signal words and colors are used throughout this document to indicate
safety hazards. Pay careful attention when you see them. The level of severity differs for
each signal word and color.

Signal words are accompanied by graphics showing what personnel should or should not
do. The graphics are called safety symbols and are defined on page 19, but more specific
text is provided every time a graphic is used throughout the manual. Everyone near the
machine must be trained on how to read these safety indicators.

Failure to comply with the instructions accompanying each signal word may result in
property damage, personal injury, or even death. Personnel must follow all safety
procedures and practices to ensure the safest possible operation of this equipment.
However, at no time is this document a substitute for common sense. Personnel must
ensure that the work environment is safe and free of distractions.

CAUTION

When CAUTION is used with the safety alert symbol (yellow triangle),
it indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury.

When CAUTION is used without the safety alert symbol, it indicates a
potentially hazardous situation which may result in equipment damage.

001080 rev. A Safety (English)
Original Instructions SAFETY-1



MI BLADE® Wood Processing S-

MiTek’

General Equipment Safety Rules

Because it is impossible to anticipate every circumstance that might involve a hazard, the
safety information provided in this equipment manual and on the machine is not all-
inclusive. If this machine is operated or serviced using a procedure not specifically
recommended by the manufacturer, the procedure shall be approved by a professional
engineer to ensure it will not render the equipment unsafe. Use extreme caution and
common sense at all times!

Know Your Equipment

* Read this manual completely before using or maintaining the equipment. Do not
operate this machine unless you have a thorough knowledge of the controls, safety
devices, emergency stops, and operating procedures outlined in this manual.

* Read and follow all safety notes. Failure to comply with these instructions may
result in economic loss, property damage, and/or personal injury including death.

» Refer to the lockout/tagout guidelines on the following pages to safely perform
maintenance and troubleshooting of this equipment.

* Observe and obey all safety labels. Replace worn labels immediately.
» Use this equipment solely for the purpose described in this manual.

* Only qualified personnel should attempt to operate or perform maintenance on this
equipment. “Qualified personnel” is defined as:

...a person or persons who, by possession of a recognized degree or
certificate of professional training, or who, by extensive knowledge,
training, or experience, has successfully demonstrated the ability to solve
problems relating to the subject matter and work—ANSI B30.2-1983

...one who has skills and knowledge related to the construction and
operation of the electrical equipment and installations and has received
safety training on the hazards involved—NEC 2002 Handbook

Personal Safety

* Always wear safety glasses and hearing protection in an industrial environment.
 Utilize a filtering face piece (dust mask) when working near sawdust.

* Wear proper clothing and appropriate personal protective equipment (e.g. safety
glasses and hearing protection.) Do not wear loose clothing or jewelry. Confine
long hair by tying it back.

» Use caution when lifting heavy parts or material.

001080 rev. A Safety (English)
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MI BLADE® Wood Processing -

MiTek’

Installing the Equipment

» Follow installation instructions completely.

* This equipment is not for use in a residential area.
Lockout/Tagout

* Before performing maintenance on the pneumatic or hydraulic systems, bleed the
lines to eliminate pressure.

» Lockout/tagout all energized systems before performing maintenance on them.
Refer to the Lockout/Tagout Guidelines section on page 5.

Keeping a Safe Environment
» Keep children away. All visitors should be kept a safe distance from the work area.
Hazards may not be apparent to individuals unfamiliar with the machine.

» Keep work areas well lit.

* Keep the work area clean and free of any trip or slip hazards.

* Do not use the equipment in damp or wet locations, or expose it to rain or snow.

* Minimize dust clouds and protect your equipment by cleaning dust in this manner:
* Vacuum dust prior to blowing with air
» Shut down electrical power and sources of ignition
 If using compressed air, it should be a low compression (no more than 15 psi)

* Powered cleaning equipment such as vacuums must be consistent with local
governmental codes for use in dusty conditions.
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MI BLADE® Wood Processing S-

MiTek’

Operating and Maintaining the Equipment
* Ensure that all people, tools, and foreign objects are clear of the restricted zones
before operating this equipment. The restricted zones are shown on page 17.

* Perform safety tests to ensure all E-stops are working properly before operating the
equipment at the initial startup, after performing any maintenance, and in
accordance with the maintenance schedule.

* In case of machine malfunction, stop the machine immediately using an E-stop and
report the malfunction to a supervisor.

* Never leave the machine running unattended. Turn the power off! Do not leave the
machine until all parts have come to a complete stop and all electrical power has
been shut off.

* Check for worn or damaged parts regularly. Repair or replace them immediately.

» Keep the hydraulic, pneumatic, and electrical systems in good working order at all
times. Repair leaks and loose connections immediately. Never exceed the
recommended pressure or electrical power.

» Check that all safety devices are in working order before each shift starts. All
protective guards and safety devices must be in place before and during use of the
machine. Never disconnect or bypass any safety device or electrical interlock.

* Only qualified maintenance personnel shall remove or install safety devices.

* Periodically inspect the quality of the finished product.

Electrical Safety

* Do not use any liquids in the interior of electrical cabinets.

* When using solvents on and around the machine, remove power to the machine to
eliminate the chance of sparking, resulting in explosion or fire. Wear a respirator
approved for use with solvents. Wear protective clothing, gloves, and safety glasses.

001080 rev. A Safety (English)
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MI BLADE® Wood Processin-

MiTek"
Lockout/Tagout

Lockout/Tagout Guidelines

All lockout/tagout guidelines must be met according to
OSHA 29 CFR 1910.147. A specific procedure should be
included in your company’s energy control program. This
manual is not intended to replace your company’s de-
energizing or lockout/tagout procedure required by OSHA,
but merely to provide general guidance.

The term “lockout,” as used in this manual, means placing a
lockout device on any and all energy sources to ensure that the
energy isolating device and the equipment being controlled
cannot be re-energized or operated until the lockout device is
removed. The photos on the next page show where the
electrical disconnects are located for this machine.

* Energy sources include electrical, mechanical, hydraulic, pneumatic, chemical,
thermal, or other energy.

* In the case of electrical energy sources, the main power and control power to the
machinery must be turned off and physically locked in the “off” position.

* Alockout device is usually a keyed padlock.

» [f more than one person is working in a restricted zone, use a group lockout device
that will allow each person to use a lock that can be removed only by the person
performing the maintenance.

“Tagout” means that a prominent warning is securely fastened to an energy-isolating
device to indicate that the equipment shall not be operated.

Whenever you see this symbol, lockout/tagout!

001080 rev. A Safety (English)
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MI BLADE® Wood Processing S-

MiTek’

Electrical Lockout/Tagout Procedures

When Working on a Machine Outside the Machine’s Main Electrical
Enclosure

*«_ If working on the electrical transmission line to the machine,
2_1 follow the procedure on page 9.

Before performing maintenance on any machine with electrical power, lockout/tagout the
machine properly. When working on a machine outside of the machine’s main electrical
enclosure, not including work on the electrical transmission line to the machine, follow
your company’s approved lockout/tagout procedures which should include, but are not
limited to the steps here.

1. Engage an E-stop on the machine.

2. Turn the disconnect switch handle to the “off” position. See Figure SAFETY-1.

/A  WARNING

ELECTROCUTION HAZARD.

When the disconnect switch is off, there is still live
power within the disconnect switch’s enclosure.
Always turn off power at the building’s power source
to the equipment before opening this electrical
enclosure!

3. Attach a lock and tag that meet OSHA requirements for lockout/tagout.

4. Restrain or de-energize all pneumatic components, hydraulic components, and
other parts that could have live or stored power.

001080 rev. A Safety (English)
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MI BLADE® Wood Process-

MiTek

Figure SAFETY-1: Sample of a Lockout/Tagout Mechanism on an Electrical
Enclosure

Sample of a
Lock and Tag
Attached to a

Machine’s
Electrical Enclosure
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MI BLADE® Wood Processi-

MiTek

Figure SAFETY-2: Lockout/Tagout on Additional Equipment in the System

Auto Deck Enclosure
May be replaced with
optional infeed equipment.

Power can also be disconnected
using saw’s main disconnect switch.

Powered Skewed
Conveyor Enclosure

(optional equipment)

Main Pneumatic Filter/Regulator

* Located on right side of saw.

* Yellow plate is shown in lockout position.
Place lock and tag through holes in yellow plate.

* Pneumatic lines will bleed naturally when
yellow plate is in lockout position.

* Ensure gauge reads 0 before performing replacing a
supply bottle for the printer or performing any maintenance!
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MI BLADE® Wood Processi-

MiTek’

When Working on a Machine Inside the Machine’s Main Electrical Enclosure
or in the Electrical Transmission Line to the Machine

Before opening the main electrical enclosure, or attempting to repair or replace an
electrical transmission line to the machine, lockout/tagout the machine properly. Follow
your company’s approved lockout/tagout procedures which should include, but are not
limited to the steps here.

1. Engage an E-stop on the machine.

2. Shut the power to the machine off at the machine’s power source which is usually
an electrical service entry panel on the facility wall. One example of a locked-out
power source panel is shown in Figure SAFETY-3.

3. Attach a lock and tag that meets OSHA requirements for lockout/tagout.

4. Open the door to the enclosure in which you need access, and using a multimeter,
verify that the power is off.

Figure SAFETY-3: Sample of a Lockout/Tagout
Mechanism on a Power Source Panel

001080 rev. A Safety (English)
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MI BLADE® Wood Processing S-

MiTek’
Hydraulic System Lockout/Tagout Procedure

When Lockout/Tagout is Not Required

If working on components other than the hydraulic system, but that requires you to be near
the vicinity of movable hydraulic components, you must, at a minimum, physically
restrain the hydraulic components from moving. If this is not possible, lockout/tagout the
entire hydraulic system.

When Lockout/Tagout is Required

Before attempting repair or performing maintenance on a hydraulic line or component,
lockout/tagout the machine properly. Follow your company’s approved lockout/tagout
procedures.

Pneumatic System Lockout/Tagout Procedure

When Lockout/Tagout is Not Required

If working on components other than the pneumatic system, but that requires you to be
near the vicinity of movable pneumatic components, you must, at a minimum, physically
restrain the pneumatic components from moving. If this is not possible, lockout/tagout the
entire pneumatic system.

When Lockout/Tagout is Required

Before attempting repair or maintenance on a pneumatic line or component, lockout/
tagout the machine properly. Follow your company’s approved lockout/tagout procedures.

Troubleshooting With an Energized Machine

Only a qualified electrician, using the personal protective equipment and following the
procedures recommended in NFPA 70E should ever attempt service or repair of or near an
energized area or component of the machine.

Whenever maintenance is performed while the equipment is electrically energized, there is
a potential electric arc flash hazard. Refer to NFPA 70E for the personal protective
equipment required when working with electrically energized components. Pneumatic and
hydraulic components may move unexpectedly if not de-energized. Physically restrain any
components capable of movement when working on or near those components.

001080 rev. A Safety (English)
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MI BLADE® Wood Processing S-

MiTek’

Safety Tests

This test procedure MUST be performed by qualified personnel at startup and after ANY
maintenance, adjustment, or modification. Testing ensures that the safety system and
machine control system work together to properly stop the machine.

These test procedures MUST be performed by qualified personnel every day at startup and
after ANY maintenance, adjustment, or modification. Testing ensures that the safety
system and machine control system work together to properly stop the machine.

A  WARNING

A CRUSH AND CUT HAZARD.

Before turning on the equipment, make sure that all

! personnel and equipment are clear.

Inspecting Indicators

1. While performing any of the following safety tests, check to ensure the Blade In
Motion light located on the operator interface panel lights up when the blade is
running.

2. While performing any of the following safety tests, check to ensure the beacon on
top of the main electrical enclosure lights up when cutting is taking place.

3. Verify that all safety labels are present and legible.

001080 rev. A Safety (English)
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Testing the E-stop Pushbuttons and Pull-Cords
/A  WARNING

ﬂ CRUSH AND CUT HAZARD.

Before turning on the equipment, make sure that all

! personnel and equipment are clear.

1. Start running the saw and all integrated components:
a) Power up the saw using the instructions on page OP-134.
b) Press the RESET button on the saw’s operator interface panel.

c) Start any optional infeed and outfeed equipment. To start the Powered
Skewed Conveyor, refer to page OP-158.

d) Press the Saw Motor START button on the saw’s operator interface panel
to start the motor.

e) Wait approximately 5 seconds, until the blade is up to full speed.
2. Prepare a stopwatch to time how long it takes for the saw blade to stop.
3. Activate any one of the E-stops listed here and measure the time between pressing
the E-stop and when the blade comes to a complete stop.
* Pushbutton on saw’s operator interface panel
* Pushbutton on main electrical enclosure

* Pushbutton on Auto Deck operator interface

¢ Pull-cord on Infeed Rail

4. Ensure that the blade and integrated components stop motion in a timely manner:

* [f the saw blade does not stop within 5-10 seconds, contact MiTek
Machinery Division Customer Service immediately for resolution.

+ Ifall integrated components do not stop in a timely manner, lockout/tagout
the entire wood processing system and arrange for a qualified service
technician to troubleshoot and repair the equipment.

 Ifthe blade and integrated components stop as expected, repeat the
procedure to test all E-stops listed in step 3.

001080 rev. A Safety (English)
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Testing Movement While E-stop is Active

A  WARNING

A CRUSH AND CUT HAZARD.

Before turning on the equipment, make sure that all

! personnel and equipment are clear.

Use the touch screen to manually move an axis.

e
< 2.
An E-stop must

be activated for . If movement does occur, Lockout/Tagout immediately and repair the problem.
this test be useful.

Watch the axis that was chosen to see if it moves. Because an E-stop is activated,
no movement should occur.

001080 rev. A Safety (English)
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Testing E-Stops for Optional Equipment
/A  WARNING

A CRUSH AND CUT HAZARD.

Before turning on the equipment, make sure that all

! personnel and equipment are clear.

Test E-stops for all optional equipment. The procedure below applies to the Powered
Skewed Conveyor only.

1. Ensure that the Powered Skewed Conveyor’s disconnect switch is in the ON
position.

2. Ensure all system E-stops and safety devices are reset.

3. Turn the selector switch located on the Powered Skewed Conveyor to the START
position and release the switch. The conveyor will begin movement.

4. Activate an E-stop on the Powered Skewed Conveyor.

5. Ensure that the Powered Skewed Conveyor, saw, and all peripheral equipment
stop motion.

6. If any piece does not stop, lockout/tagout and arrange for a qualified service
technician to repair the equipment.

001080 rev. A Safety (English)
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Testing Interlocked Doors

Certain doors are interlocked with the E-stop system and should not open when certain

_f-f-\ parts are in motion.
-r::\;k
1. Test that the SAW CHAMBER DOOR interlock is functioning by performing
SAW CHAMBER this procedure:
DOOR should not
open if the blade
e /A  WARNING
STROKE/
ELEVATION
CHAMBER CRUSH AND CUT HAZARD.
door should not
open if any axes Before turning on the equipment, make sure that all
are in motion. | personnel and equipment are clear.

a) Turn the saw blade on (see step 1 on page SAFETY-12).

b) Attempt to open the saw chamber door while pressing the Request to
Unlock button (see page OP-112 and page OP-113).

» The door should NOT open while the saw blade is running.
c) Press the STOP button.

d) Watch the lights on the operator interface panel.

» A red Blade In Motion light should be illuminated when blade is
moving.

» A green Blade Motion Stopped light should illuminate when blade
stops.
e) Wait until the blade stops spinning, then attempt to open the saw chamber
door again as described in step 1b.
* The door should open now.
f) With the door open, attempt to start the blade by pressing the green
START button on the saw’s operator interface panel.

¢ The blade should NOT move.

001080 rev. A Safety (English)
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g) Resolve any inconsistencies:

1) If the door opens while the blade is still moving OR the blade
spins with the door open, lockout/tagout the saw and arrange for a
qualified service technician to repair the equipment.

2) If the indicator lights are not behaving as expected, replace the
bulb or repair the light.

A  WARNING

CUT AND CRUSH HAZARD.

Never attempt to stop the saw blade with your hand or
a hand-held object.

There may be instances when access is given to the saw
@ chamber while the saw blade is coasting at a speed less than
2 | 5 RPM. This is normal and not a cause for alarm. Do not force
the blade to stop.

2. Test that the STROKE/ELEVATION CHAMBER DOOR interlock is
functioning by performing this procedure:

/A  WARNING

ﬁ CRUSH AND CUT HAZARD.

Before turning on the equipment, make sure that all

! personnel and equipment are clear.

a) Open the stroke/elevation chamber door
(see page OP-112 and page OP-113).

b) Ensure that the E-stop circuit is not engaged (no E-stops active).

c) Attempt to manually move either the angle, elevation, or stroke axis (refer
to instructions in step 1 on page SAFETY-13).

* The axis should NOT move while a door is open.

d) If an axis moves while the door is open, lockout/tagout the saw and
arrange for a qualified service technician to repair the equipment.

001080 rev. A Safety (English)
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Restricted Zone

/A DANGER
Stay out of the restricted zone when equipment is in

use. Serious injury or death may result if personnel
are in the restricted zone.

Always look for personnel in the restricted zone
before operating equipment.

Know the Restricted Zone: Shown in Red

Conveyor
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Marking the Restricted Zone

The restricted zone must be marked so everyone near the equipment can clearly see the
area where danger may exist.

MiTek offers Restricted Zone Tape that is easy to apply and has text in English and
Spanish. Some equipment comes with restricted zone tape. If your machine did not come
with restricted zone tape, you may order it from MiTek Machinery Division Customer
Service.

Instructions for where and how to apply restricted zone tape can be found in the
Installation Manual that came with your system or by obtaining Service Bulletin 181 from
the MiTek Machinery Web site.

001080 rev. A Safety (English)
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Safety Symbol Definitions

The safety symbols shown in this section can be found throughout the manual to indicate
hazards that are related to this equipment.All personnel expected to operate or maintain
this equipment should become familiar with these safety symbols and what they mean.

This is the Electrical Hazard Symbol. It indicates that there are
dangerous high voltages present inside the enclosure of this
product and/or that a power source is present. To reduce the risk
of fire or electric shock, do not attempt to open the enclosure or
gain access to areas where you are not instructed to do so. Refer
servicing to qualified service personnel only. This product should
be operated only from the type of source indicated on the
manufacturer's identification label. Installation should be in
compliance with applicable sections of the national electric code.
Consult your local building code before installing.

This is the user caution symbol. It indicates a condition where
damage to the equipment resulting in injury to the operator could
occur if operational procedures are not followed. To reduce the
risk of damage or injury, refer to accompanying documents, follow
all steps or procedures as instructed.

Hot surface! Surface temperature can exceed greater that 70°C
during normal operation. Do not touch.

Ventilation - Slots and openings in the cabinet are provided for
ventilation and to ensure reliable operation of the product. To
protect the unit from overheating, those openings must not be
blocked or covered. This product should not be placed in a built-in
installation, such as a wall cutout, unless proper ventilation is
provided. Hot temperatures will result.

B> P

Operation of this equipment may result in flying debris and
excessive noise. To reduce the risk of injury, wear only approved
PPE.

Py

001080 rev. A Safety (English)
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Crush hazard! Keep hands clear.

Keep hands away from moving parts.

High pressure hose. Use appropriate PPE when working on
equipment. Maintain safe pressure levels at all times.

Hydraulic hose is under great pressure. Use safe operating
procedures at all times.

Equipment produces loud noise in excess of 100 DBA during
operation. Use appropriate hearing protection when in vicinity of
this equipment.

Crush hazard from above

Caustic chemicals used in this area. Use appropriate PPE.

>PRPP>BRP
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Slip hazard! Use of approved footwear is required.

Keep hands clear of cutting parts.

001080 rev. A Safety (English)
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Keep hands and body clear.
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The operation of this equipment requires the use of PPE.

Do not operate without wearing required protective clothing.

000
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Refer to manual - After installation, read the user's guide carefully
before operating. Follow all operating and other instructions
carefully.

Circuits are live - Lockout/tagout the upstream power source.

Lockout in a de-energized state

Lift Point - In order to reduce the likelihood of damage to the
equipment, use only the lift points indicated in the manual.

Read all safety warnings and instructions before proceeding.

001080 rev. A Safety (English)
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Two- or three-man lift required to safely move this equipment.
Refer to installation manual.

Hazardous moving parts are located behind this access panel. Do
not operate this equipment without all guards and covers in place.

Do not place containers with liquids such as coffee, water, sodas,
etc. on this unit.

Do not operate this equipment in a wet environment.

Do not expose to water

No lift point. Do not lift this device with a hook/crane assembly.
Damage to the equipment will be incurred. Refer to the
installation instructions.

001080 rev. A Safety (English)
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Do not use non-approved lubricants in this machine.

Unauthorized persons are not allowed beyond this point.

Do not operate without guards and covers in place

Do not discard into municipal waste stream

oil drop

001080 rev. A Safety (English)
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Declaration of Safety Conformity

Conforms Electrically to:
« NFPA 79
* NEC Electrical code
* Electrical enclosures carry UL508A and the CUL for Canada

 Safety circuit conforms to Category 4 redundant monitoring

Conforms Mechanically to:
* 10CFR 1910
* ANSIBI11.19

001080 rev. A Safety (English)
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Treatment for Hazardous Substances

>
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®

FLAMMABLE!

PRINTER INK AND CLEANER IS HIGHLY

Keep away from extreme heat, sparks, or open flame.

No smoking near these substances.

Table 1: General Safety Data

Primary Flammable Flammable None
Hazards
Method of Alcohol-resistant Alcohol-resistant Water fog, foam, dry

extinguishing
fire

foam, carbon dioxide,
dry powder, water fog-

foam, carbon dioxide,
dry powder, water fog-

chemical, or carbon
dioxide

-NOT water -NOT water
Gloves Gloves
Protective
Equipment Goggles Goggles None

Eyewash station

Eyewash station

Table 2: How to Treat Contact With a Hazardous Substance

Rinse, remove

Then Do This...

Rinse, remove

Skin/Clothing | clothing, then wash clothing, then wash Low concern
skin w/soap skin w/soap
Hair Wash with soap and Wash with soap and Low Concern
water water
Flush with water,
. remove contactlenses Flush with water
Eyes Flush with water . : :
if possible, continue (low concern)
flushing
Do NOT induce Do NOT induce Do NOT induce
Ingested . . o
vomiting vomiting vomiting (low concern)
Inhalation Move to fresh air Move to fresh air Low concern

001080 rev. A
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Seguridad (Espanol)

Sea cuidadoso.
Protéjase.

3
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Indicadores de seguridad: Palabras de aviso

Las siguientes palabras y colores de aviso se utilizan a lo largo de este documento para
indicar riesgos de seguridad. Preste suma atencion cuando los vea. El nivel de gravedad es
diferente por cada palabra o color de aviso.

Las palabras de aviso van acompanadas por graficos que muestran al personal lo que
deben y no deben hacer. Los graficos se llaman simbolos de seguridad y se definen en la
pagina 56, pero se proporciona un texto mas especifico cada vez que se utiliza un grafico
por todo el manual. Todas las personas que estén cerca de una maquina tienen que ser
capacitadas en como leer estos indicadores de seguridad.

No cumplir las instrucciones que acompanan cada palabra de aviso puede producir dafios a
la propiedad, lesiones personales e incluso la muerte. El personal debe seguir todos los
procedimientos y practicas de seguridad establecidos para asegurar el uso mas seguro
posible de este equipo. No obstante, en ninglin caso este documento reemplaza el sentido
comun. El personal debe asegurarse de que el entorno de trabajo sea seguro y esté libre de
distracciones.

PRECAUCION

Indica una situacion potencialmente peligrosa que, si no se evita, puede
producir lesiones menores o moderadas.

001080 rev. A Seguridad (Espafiol)
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Reglas de seguridad para el equipo de general

Debido a la imposibilidad de anticipar todas las circunstancias que podrian constituir un
riesgo, la informacion de seguridad suministrada en este manual del equipo y sobre la
maquina no es exhaustiva. Si se utiliza o realiza el mantenimiento de esta maquina
utilizando un procedimiento no recomendado especificamente por el fabricante, el
procedimiento debera ser aprobado por un ingeniero profesional para asegurarse de que no
afecte la seguridad del equipo. jManéjese siempre con suma precaucion y sentido comun!

Conozca su equipo

* Lea este manual en su totalidad antes de utilizar o mantener el equipo. No utilice
esta maquina a menos que esté perfectamente familiarizado con los controles, los
dispositivos de seguridad, los frenos de emergencia y los procedimientos operativos
que se describen en este manual.

» Leay siga todas las notas de seguridad. El no cumplimiento de estas instrucciones
podria producir pérdidas econémicas, dafios a la propiedad y lesiones personales,
incluida la muerte.

» Refiérase a las pautas de bloqueo/etiquetado proporcionadas en las siguientes
paginas para realizar el mantenimiento y solucionar problemas de este equipo en
forma segura.

* Observe y cumpla con todas las etiquetas de seguridad. Cambie las etiquetas
gastadas inmediatamente.

+ Utilice este equipo Unicamente para el propdsito que se describe en este manual.

» Solo personal calificado debe intentar utilizar o realizar el mantenimiento de este
equipo. Por "personal calificado" se entiende:

...una persona o personas que, por el hecho de poseer un titulo o certificado
de capacitacion profesional reconocido o que, por sus amplios
conocimientos o experiencia, han demostrado con éxito estar capacitados
para resolver problemas relacionados con el tema y el trabajo en cuestion
—ANSI B30.2-1983

...una persona que posee habilidades y conocimientos relacionados con la
construccion y uso de equipos e instalaciones eléctricas y que ha recibido
capacitacion en seguridad sobre los riesgos posibles—NEC 2002 Handbook

Seguridad personal
+ Use siempre lentes de seguridad y proteccion auditiva en un entorno industrial.
+ Utilice una mascara protectora cuando trabaje cerca de aserrin.

+ Utilice ropa adecuada y equipo de proteccidon personal apropiado (por ejemplo,
lentes de seguridad y proteccion auditiva.) No use ropa suelta ni joyas. Si tiene el
cabello largo, ateselo para atras.

* Proceda con precaucion cuando levante piezas o materiales pesados.

001080 rev. A Seguridad (Espafiol)
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Instalacién del equipo
* Siga las instrucciones de instalacion al pie de la letra.

» No utilizar este equipo en zonas residenciales.

Procedimientos de Bloqueo/Etiquetado

« Antes de realizar el mantenimiento de los sistemas neumaticos o hidraulicos,
purgue las lineas para eliminar la presion.

* Bloquee y etiquete todos los sistemas energizados antes de realizar tareas de
mantenimiento en ellos. Refiérase a la seccion Pautas de bloqueo/etiquetado en la
pagina 34.

Coémo mantener un entorno seguro

* Mantenga alejados a los nifios. Todos los visitantes deben mantenerse a una
distancia segura del area de trabajo. Los riesgos pueden no ser evidentes a las
personas no familiarizadas con la maquina.

* Mantenga las areas de trabajo bien iluminadas.

* Mantenga el area de trabajo limpia y libre de cualquier riesgo de tropiezo o
resbalamiento.

* No utilice el equipo en lugares himedos o mojados y no lo exponga a lalluviao a la
nieve.

* Minimice las nubes de polvo y proteja su equipo quitando el polvo de la siguiente
manera:

* Aspire el polvo antes de soplarlo con aire
* Apague la alimentacion eléctrica y todas las fuentes de ignicion
* Siusa aire comprimido, debe ser a compresion baja (no mas de 15 psi)

* El equipo eléctrico de limpieza como las aspiradoras debe cumplir con los
codigos del gobierno local para uso en condiciones polvorientas.

Uso y mantenimiento del equipo

» Asegurese de que no haya personas, herramientas y objetos extrafios en las zonas
restringidas antes de utilizar este equipo. Las zonas restringidas se indican en la
pagina 48.

» Realice pruebas de seguridad para verificar que todos los frenos de emergencia
funcionen adecuadamente antes de utilizar el equipo por primera vez, después de
realizar cualquier tarea de mantenimiento y segun la frecuencia de mantenimiento
establecida.

* En caso de que la maquina no funcione correctamente, deténgala inmediatamente
utilizando un freno de emergencia e informe el problema a un supervisor.
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* No deje nunca la maquina encendida si no esta junto a ella. jApaguela! No la
abandone hasta que todas las piezas se detengan completamente y hasta que se haya
apagado la alimentacion eléctrica.

» Verifique periodicamente que no haya piezas gastadas o dafiadas. Reparelas o
cambielas inmediatamente.

* Mantenga los sistemas hidraulicos, neumaticos y eléctricos en buen funcionamiento
en todo momento. Repare las fugas y las conexiones sueltas inmediatamente. No
exceda nunca la presion ni potencia eléctrica recomendadas.

» Verifique que todos los dispositivos de seguridad estén en buen funcionamiento
antes de comenzar de cada turno. Todos los dispositivos protectores y de seguridad
deben estar en su lugar antes y durante el uso de la maquina. No desconecte ni evite
nunca ningun dispositivo de seguridad ni interbloqueo eléctrico.

* Solo el personal de mantenimiento calificado puede quitar o instalar los dispositivos
de seguridad.

* Inspeccione periddicamente la calidad del producto terminado.

Seguridad eléctrica
» No utilice liquidos en el interior de los gabinetes eléctricos.

* Cuando utilice disolventes sobre o alrededor de la maquina, desconecte la
alimentacion para eliminar las probabilidades de chispas, que pueden producir una
explosion o incendio. Use un respirador aprobado para el uso con disolventes. Use
ropa protectora, guantes y lentes de seguridad.
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Pautas de bloqueol/etiquetado

Deben cumplir con todas las pautas de bloqueo/etiquetado
conforme a la norma OSHA 29 CFR 1910.147. El programa
de control de energia de la compaiiia debe incluir un
procedimiento especifico. El objetivo de este manual no es
reemplazar el procedimiento de desenergizacion o bloqueo/
etiquetado requerido por la OSHA, sino proporcionar pautas
orientativas generales.

El término "bloqueo", segun se utiliza en este manual, se
refiere a la colocacion de un dispositivo de bloqueo en las
fuentes de energia para asegurar que el dispositivo aislador de
energia y el equipo controlado por éste no puedan
reenergizarse o utilizarse hasta que se retire dicho dispositivo.
Las fotos de la pagina siguiente muestran los lugares en los que se encuentran los
interruptores de desconexion eléctrica de esta maquina.

» Las fuentes de energia incluyen energia eléctrica, mecénica, hidraulica, neumatica,
quimica, térmica y otras.

* En el caso de fuentes de energia eléctrica, la alimentacion principal y la
alimentacion de control a la maquinaria deben apagarse y bloquearse fisicamente en
la posicion "off" (apagado).

* Por lo general, como dispositivo de bloqueo se utiliza un candado con llave.

» Si hay mas de una persona trabajando en una zona restringida, utilice un dispositivo
de bloqueo grupal que permita a cada persona utilizar un candado que s6lo pueda
ser retirado por la persona que realiza el mantenimiento.

"Etiquetado" significa que debe colocarse una advertencia facil de ver en un dispositivo
aislador de energia que indique que el equipo no debe utilizarse.

Siempre que vea este simbolo, {Bloquee/Etiquete!
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Procedimientos de bloqueo/etiquetado eléctricos

Cuando trabaja en una maquina fuera del gabinete eléctrico principal de la
maquina

tﬂl Si trabaja en la linea de transmision eléctrica a la maquina,
2 v-;_l siga el procedimiento de la pagina 38.

Antes de realizar el mantenimiento de cualquier maquina con alimentacion eléctrica,
bloquee y etiquete la maquina de forma adecuada. Cuando trabaje en una maquina fuera
del gabinete eléctrico principal de la maquina, salvo en el caso de trabajos en la linea de
transmision eléctrica a la maquina, siga los procedimientos de bloqueo/etiquetado
aprobados por la compaiiia, los cuales deberian incluir, entre otros, los pasos aqui
indicados.

1. Coloque un freno de emergencia sobre la maquina.

2. Coloque el mango del interruptor con fusibles en la posicion "apagado/apagada’.
Vea la page SEGURIDAD-36.

/A  WARNING

RIESGO DE ELECTROCUCION.

Cuando el interruptor con fusibles esta apagado,
sigue habiendo energia dentro del gabinete del
interruptor. jApague siempre la alimentacion en la
fuente de alimentacion del edificio antes de abrir este
gabinete eléctrico!

3. Coloque un candado y una etiqueta que cumplan con los requisitos de bloqueo/
etiquetado de la OSHA.

4. Trabe o desenergice todos los componente neumaticos, componentes hidraulicos
y otras piezas que tengan alimentacidn directa o almacenada.
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Figure SEGURIDAD-1: Un mecanismo de Bloqueo/Etiquetado en el gabinete
eléctrico

1> @

Coloque un
candado y una
etiqueta que
cumplan.

En la plataforma automatica Auto Deck se corta la corriente
t cuando se apaga el interruptor de desconexidn principal de la
% sierra en Figura SEGURIDAD SEGURIDAD-1.

La opcion de la banda transportadora eléctrica con rodillos
sesgados cuenta con un control de apagado eléctrico con el
interruptor de desconexion principal de la sierra, pero aun
existe la conexion trifasica.

El interruptor de desconexion principal de la sierra no afecta al
sistema de recuperacién de madera.
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Figure SEGURIDAD-2: Bloqueo/etiquetado en equipo otras en el sistema

Caja de la plataforma
automatica Auto Deck

Se puede reemplazar con equipo
opcional (guia de alimentacion).

Caja de la banda
transportadora eléctrica
con rodillos sesgados
(equipo opcional)

También es posible desconectar
la electricidad usando el interruptor
de desconexion principal de la sierra.

Filtro/regulador neumatico principal
(ubicado del lado derecho de la sierra)

« Se encuentra del lado derecho de la sierra.

« La placa amatrilla se muestra en posicién bloqueada.
Coloque el bloqueo y la etiqueta a través de los
orificios en la placa amarilla.

» Las mangueras neumaticas sangraran de manera natural
cuando la placa amarilla se encuentre en posicién de bloqueo.

« Verifique que la lectura del indicador sea 0 antes de
reemplazar un frasco de suministro para la impresora
o de realizar cualquier tipo de mantenimiento.
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Cuando trabaje en una maquina dentro del gabinete eléctrico principal de la
maquina o en la linea de transmision eléctrica a la maquina

Antes de abrir el gabinete eléctrico principal o intentar reparar o reemplazar una linea de
transmision eléctrica a la maquina, bloquee y etiquete la maquina en forma adecuada. Siga
los procedimientos de bloqueo/etiquetado aprobados por la compaiiia, los cuales deberian
incluir, entre otros, los pasos aqui indicados.

1.

2.

Coloque un freno de emergencia sobre la maquina.

Apague la alimentacion a la maquina en la fuente de alimentacion, que, por lo
general, es un panel de entrada de suministro eléctrico que se encuentra en una
pared de las instalaciones. En la Figura SEGURIDAD 1 se muestra un ejemplo de
panel de fuente de alimentacién bloqueado.

Coloque un candado y una etiqueta que cumplan con los requisitos de bloqueo/
etiquetado de la OSHA.

Abra la puerta del gabinete al que necesita acceder y usando un multimetro
verifique que la alimentacion esté apagada.

Figura SEGURIDAD-1: Ejemplo de un
mecanismo de Bloqueo/Etiquetado
en un panel de fuente de alimentacién

001080 rev. A Seguridad (Espafiol)
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Procedimiento de bloqueol/etiquetado del sistema
neumatico

Cuando no se requiere bloqueol/etiquetado

Si trabaja con componentes que no son del sistema neumatico pero que requieren su
presencia en la proximidad de componentes neumaticos moviles, debe, como minimo,
trabar fisicamente estos componentes para que no se muevan. Si no es posible, bloquee/
etiquete todo el sistema neumatico.

Cuando se requiere bloqueo/etiquetado

Antes de intentar reparar o realizar el mantenimiento de una linea o componente
neumatico, bloquee/etiquete la maquina en forma apropiada. Siga los procedimientos de
bloqueo/etiquetado aprobados por la compaiiia.

Solucion de problemas con una maquina
energizada

Sélo un electricista calificado que utilice el equipo de proteccion personal y siga los
procedimientos recomendados en la norma NFPA 70E debe intentar realizar tareas de
reparacion o mantenimiento en un area o componente energizados de la maquina o en su
proximidad.

Cada vez que se realizan tareas de mantenimiento mientras el equipo esta eléctricamente
energizado, existe un riesgo potencial de formacion de un arco eléctrico. Consulte en la
norma NFPA 70E el equipo de proteccion personal requerido para trabajar con
componentes eléctricamente energizados. Los componentes neumaticos e hidraulicos
pueden moverse de manera imprevista si no se desenergizan. Trabe fisicamente cualquier
componente que pueda moverse cuando deba trabajar en ellos o en su proximidad.

001080 rev. A Seguridad (Espafiol)
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Pruebas de seguridad

Estos procedimientos de prueba DEBEN ser realizados por personal calificado durante la
puesta en marcha todos los dias y despué¢s de CUALQUIER tarea de mantenimiento,
ajuste o modificacion. Las pruebas permiten verificar si el sistema de seguridad y el
sistema de control funcionan juntos y detienen la maquina de manera adecuada.

A CAUTION

ﬁ RIESGO DE APLASTAMIENTO Y CORTE.

Antes de encender el equipo, asegurese de que todo
el personal y el equipo estén alejados.

Indicadores de inspeccion

1. Mientras realiza cualquiera de las siguientes pruebas de seguridad, inspeccione
que la luz de cuchilla en movimiento situada por una interfaz del operador se
encienda cuando la cuchilla esté funcionando.

2. Mientras realiza cualquiera de las siguientes pruebas de seguridad, inspeccione
para asegurarse de que la luz en la parte superior de la caja eléctrica principal se
encienda cuando se realizan los cortes.

3. Verifique que todas las etiquetas de seguridad estén presentes y sean legibles.

001080 rev. A Seguridad (Espafiol)
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Pruebas de los botones pulsadores del freno de
emergencia y las cuerdas de parada de emergencia

A CAUTION

é RIESGO DE APLASTAMIENTO Y CORTE.
Antes de encender el equipo, asegurese de que todo

el personal y el equipo estén alejados.

1. Comience haciendo funcionar la sierra y todos los componentes integrados:
a) Encienda la sierra segun las instrucciones de la pagina OP-134.

b) Presione el boton RESET (restablecer) en la interfaz del operador de la

sierra.
A c) Arranque cualquier equipo opcional de alimentacion y de salida. Para
Auto arrancar la banda transportadora eléctrica con rodillos sesgados consulte
Mode la pagina OP-158.

d) Presione el boton START (Inicio) del motor de la sierra en la interfaz del
operador de la sierra para que arranque el motor.

e) Espere aproximadamente 5 segundos, hasta que la cuchilla avance a toda
velocidad.

2. Prepare un crondmetro para medir el tiempo que tarda en detenerse la cuchilla de
la sierra.

3. Active cualquiera de los botones pulsadores del freno de emergencia senalados
aqui y mida el tiempo entre cuando presiona el botéon y cuando la cuchilla se
detiene completamente.

* Boton en la interfaz del operador de la sierra
* Boton por la caja eléctrica principal
* Boton en la interfaz del operador de la plataforma automatica (Auto Deck)

* Cuerda de parada de emergencia en el riel en la guia de alimentacion

001080 rev. A Seguridad (Espafiol)
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4. Asegurese de que la cuchilla y los componentes integrados detengan el
movimiento de una manera oportuna:

* Si la cuchilla de la sierra no se detiene en un intervalo de 5 a 10 segundos,
comuniquese de inmediato con Servicio al Cliente de la Division de
maquinaria de MiTek para que lo solucionen.

* Si todos los componentes integrados no se detienen oportunamente, realice
procedimientos de bloqueo/etiquetado en todo el sistema de procesamiento
de madera y pida a un técnico de servicio calificado que diagnostique y
repare el equipo.

* Sila cuchilla y los componentes integrados se detienen como es de esperar,
repita el procedimiento para probar todos los botones pulsadores del freno
de emergencia sefialados en el paso 3.

001080 rev. A Seguridad (Espafiol)
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Prueba de movimiento mientras el botén pulsador del freno
de emergencia esta activo

A CAUTION

ﬁ RIESGO DE APLASTAMIENTO Y CORTE.

Antes de encender el equipo, asegurese de que todo

1 el personal y el equipo estén alejados.

1. Use la pantalla tactil para mover un eje manualmente

Observe el eje que eligié para ver si se mueve. Como esta activado un boton
pulsador del freno de emergencia, no debe haber movimiento.

Si hay movimiento, realice de inmediato los procedimientos de bloqueo/
etiquetado y repare el problema.

001080 rev. A Seguridad (Espafiol)
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Prueba de los equipo opcional

A CAUTION

A RIESGO DE APLASTAMIENTO Y CORTE.
Antes de encender el equipo, asegurese de que todo

el personal y el equipo estén alejados.

Pruebe los botones pulsadores de paro de emergencia para todo el equipo opcional. El
siguiente procedimiento se aplica solamente a la banda transportadora eléctrica con
rodillos sesgados.

1. Asegurese de que el interruptor de desconexion de la banda transportadora
eléctrica con rodillos sesgados esté en la posicion ON (encendido).

2. Asegurese de que todos los botones pulsadores del freno de emergencia y los
dispositivos de seguridad del sistema estén restablecidos.

3. Mueva el interruptor selector situado en la banda transportadora eléctrica con
rodillos sesgados a la posicion START (Iniciar) y suelte el interruptor. La banda
transportadora comenzara a moverse.

4. Active un boton pulsador de freno de emergencia en la banda transportadora
eléctrica con rodillos sesgados.

5. Asegurese de que la banda transportadora eléctrica con rodillos sesgados, la sierra
y todo el equipo periférico dejen de moverse.

6. Si alguna pieza no se detiene, realice los procedimientos de bloqueo/etiquetado y
pida a un técnico de servicio calificado que repare el equipo.
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Prueba de las puertas interbloqueadas

Ciertas puertas estan interbloqueadas con el sistema de boton pulsador de freno de
@ emergencia y no deben abrirse cuando ciertas piezas se estén moviendo.

s Y
1. Pruebe que el interbloqueo de la PUERTA DE LA CAMARA DE LA SIERRA

La PUERTA DE funcione realizando este procedimiento:
LA CAMARA DE

LA SIERRA no A CAUTION

debe abrirse si la
cuchilla esta en

movimiento.
La puerta de la A RIESGO DE APLASTAMIENTO Y CORTE.

CAMARA DE LA
CARRERA/ Antes de encender el equipo, asegurese de que todo
ELEVACION no el personal y el equipo estén alejados.

debe abrirse si
algun eje esta en
movimiento.

a) Encienda la cuchilla de la sierra (vea el paso 1 en la pagina
SEGURIDAD-41).

b) Trate de abrir la puerta de la cAmara de la sierra mientras presiona el
boton Request to Unlock.
» La puerta NO debe abrirse mientras esté funcionando la cuchilla de la
sierra.

c) Presione el boton STOP (alto).

d) Observe las luces por la interfaz del operador.
* Una luz roja debe estar encendida cuando la cuchilla se esté moviendo.
* Una luz verde (Blade Motion Stopped) debe encenderse cuando se

detenga la cuchilla.

e) Espere hasta que la cuchilla deje de dar vueltas y luego trate de nuevo de
abrir la puerta de la camara de la cuchilla, como se describio en el paso
1b.

* La puerta debe abrirse ahora.

f) Con la puerta abierta, trate de arrancar la cuchilla presionando el boton
START (Iniciar) verde en la interfaz del operador de la sierra.

¢ La cuchilla NO debe moverse.

001080 rev. A Seguridad (Espafiol)
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g) Resuelva cualquier incongruencia:

1) Si se abre la puerta mientras la cuchilla todavia esta en
movimiento O la cuchilla gira con la puerta abierta, realice los
procedimientos de bloqueo/etiquetado en la sierra y pida a un
técnico de servicio calificado que repare el equipo.

2) Si las luces indicadoras no se comportan como se esperaba,
reemplace la bombilla o repare la luz.

A CAUTION

RIESGO DE APLASTAMIENTO Y CORTE.

Nunca trate de detener la cuchilla de la sierra con la
mano o con un objeto que sostenga con la mano.

Podria haber casos en que se permita el acceso a la camara de la
@ sierra mientras la cuchilla de la sierra se desacelera a una
\_1 velocidad menor de 5 RPM. Esto es normal y no es causa de
alarma. No fuerce la cuchilla para que se detenga.
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2. Pruebe que el interbloqueo de la PUERTA DE LA CAMARA DE LA
CARRERA/ELEVACION funcione realizando este procedimiento:

A CAUTION

A RIESGO DE APLASTAMIENTO Y CORTE.
Antes de encender el equipo, asegurese de que todo

el personal y el equipo estén alejados.

a) Abra la puerta de la camara de carrera/elevacion
(vea las paginas OP-112 y OP-113).

b) Asegurese de que el circuito del boton pulsador del freno de emergencia
no esté acoplado (no hay botones pulsadores del freno de emergencia
activos).

c) Trate de mover manualmente el angulo, la elevacion o el eje de la carrera
(consulte las instrucciones en el paso 1 de la pagina SEGURIDAD-43).
* El eje NO debe moverse mientras una puerta esté abierta.

d) Sise mueve un eje mientras la puerta esta abierta, realice los

procedimientos de bloque/etiquetado en la sierra y pida a un técnico de
servicio calificado que repare el equipo.
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Zona restringida

A DANGER
Manténgase alejado de la zona restringida cuando el
equipo esté en uso. Pueden producirse lesiones
graves o incluso la muerte si el personal esta en la
zona restringida.

Siempre observe que no haya personal en la zona
restringida antes de operar el equipo.

Conocer la zona restringida
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Marcar la zona restringida

Debera marcarse la zona restringida de manera que todas las personas cerca del equipo
puedan ver claramente el area donde pueda existir peligro.

MiTek ofrece la cinta de zona restringida o “Restricted Zone Tape”, facil de aplicar y con
texto en inglés y en espanol. Algunos equipos traen la cinta de zona restringida. Si su
maquina no trajo la cinta de zona restringida, puede pedirla a MiTek Machinery Division
Customer Service (Servicio al cliente de la division de maquinaria de MiTek).

Puede encontrar las instrucciones sobre donde y como aplicar la cinta de zona restringida
en el manual de su mesa o portico incluido con su sistema o pedir el Service Bulletin Kit
181 en la pagina web de MiTek Machinery.

Informacion adicional

Para entender el circuito del freno de emergencia pagina
(Understanding the E-Stop Circuit) MT-123
Definiciones de los simbolos de seguridad pagina
(Safety Symbol Definitions) SAFETY-19
001080 rev. A Seguridad (Espafiol)
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Chapter 1

This chapter explains how to navigate through the equipment
manual and how to contact MiTek.

Introduction to the Manual

A  WARNING

Read this manual completely before using this
equipment!

Do not operate this machine until you have a thorough
understanding of all controls, safety devices,
emergency stops, and operating procedures outlined
in this manual.

All hazard instructions must be read and observed.
Failure to do so may result in economic loss, property
damage, and/or personal injury.

This manual must always be available to personnel
operating and maintaining this equipment.

Purpose and Scope of This Equipment Manual

In order for this Equipment Manual to be useful, it must be accessible. It is structured so
the Operation Manual can be kept at the machine and the Maintenance and Installation
Manuals can be kept somewhere accessible by maintenance personnel only.

This manual addresses the most recent versions of the date on the title page. For earlier
revisions, contact MiTek Machinery Division.
This manual can be a valuable tool for training.

» The Introduction and General Information chapters contains information on truss
terminology and provides basic information about the equipment.

» The Operation Manual teaches operators how to efficiently operate the machine.
» The Maintenance Manual is written specifically for maintenance personnel.

» The appendices provide valuable training materials and technical information.

001080 rev. A Introduction
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Figure 1-1: Overview of System
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Understanding This Manual

The Equipment Manual (or Manual Set)

This equipment manual is a set of three (3) books. The part number for the entire set is
001080. The manuals listed in Table 1-1 are all part of the equipment manual (also called
the manual set).

The page numbers include a prefix so it is clear in which book a page can be found when
using cross-references. The Safety (SAFETY) and Introduction (INTRO) sections have
their own prefix because they are found in all three books.

Table 1-1: Manual Set

Manual Title Page- : Description Part #
Prefix

Book 1: Includes operation procedures and

Operation oP . P proce 001080-OP
defines the control user interface

Manual

Book 2: Includes preventive maintenance,

Maintenance MT repair maintenance, troubleshooting, | 001080-MT

Manual parts list, drawing set list, and glossary

Book 3: Includes requirements prior to

Installation IN installation, installation procedures, 001080-IN

Manual and startup procedures.

Review the table of contents to understand the structure of the chapters and appendices.

The Drawing Set

The drawing set is included with this manual set. A list of the drawings can be found in the
Maintenance Manual. The actual drawings are either in a separate 11x17 binder or in the
back of the Maintenance Manual.

Screen Shots

See page OP-73 for software versions that the screen shots were taken from.

001080 rev. A Introduction
Original Instructions INTRO-52



ml BLADE " Wood Processing Sy-

MiTek’

Navigation

The graphics in Table 1-2 are used throughout the manual to quickly communicate a
specific type of information.

Table 1-2: Navigational Tools Used Throughout the Manual

Graphic Explanation

Important safety note!

Indicates that you must lockout/tagout at the disconnect
switch located on the equipment using approved methods

gl described in OSHA 29 CFR 1910.147 before continuing
with the procedure.

@ Indicates tools required before beginning a procedure.
"‘\11 Provides additional information for the steps or text.

I
;JE Indicates how to get to or from the item discussed.

Refers reader to another section, table, graphic, or drawing

.\M for further explanation.
&

PN Indicates that the part number is listed in the Parts List
appendix.

Formatting Cues

To follow the procedures in this manual, you must first understand the text formats used.
Table 1-3 describes how to read the cues provided in this text.

Table 1-3: How to Read the Text Formats

If Text Looks Like... | It Indicates... Example in Text
All caps Key on keyboard or button on screen | Press ENTER
i . Menu or field or virtual button that Click on the File
Initial cap and italic )
you must find or select menu
Initial cap only, no Menu or field or virtual button when | While in the Main
italics simply referring to it Menu
Plus sign (+) Hold buttons at the same time CTRL+ALT+DELETE
Greater Than sign (>) | Next selection File>Open
001080 rev. A Introduction
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Additional Resources

Supplemental Documentation

In addition to the equipment manual, refer to the documentation provided by the original
manufacturer for the parts that are listed in this section. The supplemental documentation
is provided at the time of installation, or it may be found inside an electrical enclosure.
Refer to these documents when you need more detailed information on these components
than the MiTek manual provides.

There is a plastic bag or a box of material sent with each system. It includes a collection of
paperwork detailing the technical components used in the system that are manufactured by
a different company. Inside this collection you will find spare internal fuses for the servo
amplifier.

Board Stretcher Software Manual

Board Stretcher software is an optimizing software independent of the BLADE equipment,
but it integrates closely with the BLADE for the most efficient lumber usage. This manual
mentions items that may appear to be controlled by the BLADE software but are actually
controlled by Board Stretcher.

To obtain the Board Stretcher manual, each Board Stretcher operator should register on
MiTek University™ for the Board Stretcher training class. The Training Manual that
accompanies the class is the official Board Stretcher manual. Once the class is complete,
the attendee can always log back on and download or print the manual. Color copies may
be requested from the MiTek University staff.

Web Site
Visit the MiTek Web site for Figure 1-2: Contacting MiTek
up'—to—date }nformatlon on all MiTek Machinery Division
MiTek equipment. Customer Service Department
301 Fountain Lakes Industrial Drive
St. Charles, MO 63301
1 Parts Orders (with part number)
Contacting Us E-mail; mitekparts@mil.com

Web Site

For technical assistance or to !
www.mitek-us.com

order parts, contact the

Machinery Division Customer Technical Assistance —
: : Phone: 800-523-3380
Service Depaﬁmeqt using one of Fax: 636-328.9218 ml
the methods listed in Figure 1-2.
001080 rev. A Introduction
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Chapter 2

This chapter provides step-by-step instructions as well as
information to help you understand how your equipment works to
enable you to make repairs and perform preventive maintenance.

Introduction to Maintaining Your Equipment

This manual contains sufficient information for proper maintenance under most
conditions. Certain operating environments may necessitate preventive maintenance at
more frequent intervals. Because consistent preventive maintenance is so important for
keeping mechanical equipment in good operating condition, MiTek recommends that you
stock certain replacement parts to minimize downtime.

Review the table of contents and utilize the index to locate the information you need. The
following appendices will also assist in maintaining and repairing your equipment:

* Troubleshooting

* Parts List

* Maintenance Checklists

* Drawing Set

Refer to pages MT-64 through MT-66 for an overview of component locations that may
require maintenance during the life of your equipment.

Read the Performing Maintenance Safely section before beginning maintenance on this
equipment.

001080 rev. A Maintenance
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Performing Maintenance Safely

Read the safety section starting on page SAFETY-1 and adhere to all rules and guidelines.
This section provides additional safety information specific to maintenance topics.

Before Operating This Equipment

Adhere to these warnings before operating this equipment:

A  WARNING

ELECTROCUTION, HIGH PRESSURE, CRUSH, AND
CUT HAZARDS!

Read this section AND the safety section in the
preliminary pages before operating or maintaining this
equipment.

Do not operate this machine until you have a thorough
understanding of all controls, safety devices, E-stops,
and operating procedures outlined in this manual.

Read and observe all hazard instructions. Failure to
do so may result in economic loss, property damage,
and/or personal injury.

This manual must always be available to personnel
operating and maintaining this equipment.

A  WARNING

CRUSH AND CUT HAZARD.

Guards must always be in place during operation to
avoid serious injury and possibly death.

Always replace guards after maintenance is complete
and before removing the lockout/tagout device.

/A  WARNING

CRUSH AND CUT HAZARD.

Before turning on the equipment, make sure that all
personnel and equipment are clear.

When an E-stop is released, the load arms on the
Infeed Rail may automatically raise with high force.

001080 rev. A Maintenance
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Lockout/Tagout

The lock and tag symbol shown to the left indicates that proper lockout/tagout procedures
must be used prior to starting the procedure where the symbol occurs.

See page OP-117 in the Operations Manual for lockout instructions.

A  WARNING

> B> B> >

ELECTROCUTION AND HIGH PRESSURE HAZARDS.

Always turn the power off by activating an E-stop
when the equipment is not in operation.

Always verify that all power to the machine has been
turned off and follow approved lockout/tagout safety
procedures (OSHA 29 CFR 1910.147) before
performing any maintenance on this equipment.

If it is absolutely necessary to troubleshoot an
energized machine, follow NFPA 70E or the governing
regulations at your location for proper procedures and
personal protective equipment.

The components on this machine can cause severe
injury if adjusted improperly. Follow all procedures in
this manual and do not make adjustments to the
machine without guidance from MiTek or MiTek
documentation.

Only trained personnel should make mechanical
adjustments to this machine.

001080 rev. A
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Important Safety Information

Your Responsibilities

Detailed descriptions of standard workshop procedures, safety principles, and service
operations are not included in this manual. Although this manual contains some
warnings and cautions against specific service methods which could cause personal
injury or damage to the machine, it does not cover all conceivable ways of service that
might be done or the possibility of hazardous consequences of each conceivable way.
If you intend to handle, operate, or service the unit by a procedure or method not
specifically recommended by the manufacturer, first make sure that such a procedure
or method will not render this equipment unsafe or pose a threat to you and others.

It is the responsibility of the mechanic performing the maintenance or service on a
particular machine to:

1. Inspect the machine for abnormal wear and damage.

2. Choose a procedure which will not endanger his/her safety, the safety of others,
the equipment, or the safe operation of the machine.

3. Fully inspect and test the machine and the pneumatic and electrical systems to
ensure that the service to the machine has been properly performed and that the
machine, pneumatic, and electrical systems will function properly.

4. Ensure only qualified electricians perform electrical service work.

A  WARNING

This machine contains high-voltage electricity that
may cause serious personal injury or death.

General Service Rules

1. The design may change or upgrades may occur for any particular component.
Always contact the factory before replacing components.

2. Ifinspection or testing reveals evidence of abnormal wear or damage to the
machine, or if you encounter circumstances not covered in the Equipment
Manual, STOP and consult MiTek. The machine must be repaired and serviced
according to the current specifications and procedures of MiTek. Replacement
parts must have properties equal to or greater than those specified by MiTek.

3. Always install new gaskets, O-rings, cotter pins, etc., and place Loctite on bolts, if
required.

001080 rev. A Maintenance
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4. Torque bolts and fasteners to the correct specifications.
5. Clean parts in a nonflammable or high-flash-point solvent only.
6. Lubricate any sliding surfaces before assembly.

7. Many components are manufactured from high carbon, heat-treated steel. Do not
attempt to cold straighten, hot straighten, bend, or weld these components, as they
may fail under load, causing serious personal injury or death.

8. After re-assembly, check all parts for proper installation and operation before
putting the machine back into service.

9. Itis beneficial to record all major maintenance and testing. This allows recurring
problems to be predicted and addressed before any production time is lost. Typical
reports and records should include:

* Date

* Serial number of machine

* Description of problem or symptoms
* Corrective action taken

* Parts required

10. MiTek will, from time to time, mail out Service Bulletins and updates for this
machine. Follow the Service Bulletins and updates accordingly and file them in
this equipment manual.

11. The keyholes in the stroke/elevation door lock and the saw chamber door lock are
intended for maintenance personnel to override the door interlock for emergency
or troubleshooting purposes only. Using the key allows the door to open without
electrical power. The maintenance office should store the key in a safe and secure
location. Two keys for each door (total of 4 keys) were delivered during
installation or startup.
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Making Adjustments and Replacing Parts

Be careful when making mechanical adjustments. Untrained personnel may damage the
machine or cause harm to themselves and others.

A  WARNING

CRUSH AND CUT HAZARDS.

Always replace guards after servicing.

Only qualified maintenance personnel shall repair,
remove, or replace guards and safety devices.

Failure to follow the step-by-step procedure may
result in incorrect adjustment of this machine and
could cause incorrect setups. Only trained personnel
should make mechanical adjustments to this machine.

Use the exact replacement parts that are specified.

Special materials have been used for some of the components of this equipment. It is
critical to the future performance of this machine that only specified replacement parts are
used. Order all replacement parts through MiTek. Do not substitute parts without first
consulting MiTek to determine if it is safe and effective. No electrical system component,
cable, connector, or device should be modified, removed, disconnected, or changed
without specific approval and guidance from MiTek.
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Wearing Personal Protective Equipment

A  WARNING

Follow OSHA guidelines to utilize the proper personal
protective equipment (PPE) while performing
maintenance. The most common include eye
protection, hearing protection, dust masks while
blowing off sawdust, gloves while working with
solvents or blades, and fire retardant clothing when
troubleshooting an energized machine.

Conducting Safety Tests

Ensure safety devices are always operating properly. Perform the safety tests beginning on
page SAFETY-11 before operating the equipment at the initial startup, after performing
any maintenance, and according to the maintenance schedule.

/A  WARNING

Perform safety tests after performing any maintenance
on this equipment!
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Overview Graphics

Figure 2-1 through Figure 2-7 provide an important overview of the equipment to help
you better understand the procedures in the Maintenance chapter.

Figure 2-1: MatchPoint BLADE Wood Processing System

Figure 2-2: MatchPoint BLADE Saw
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Figure 2-3: Auto Deck as Part of a MatchPoint BLADE Wood Processing System

Figure 2-4: Powered Skewed Conveyor as Part of a MatchPoint BLADE System
(optional equipment)

Ih k
LDE
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Figure 2-5: Major Components Visible From the Left Side of Saw

Saw
Chamber

Top
Clamp
Assy

Elevation Assy
(shown in down position)
Raises and lowers saw head.

Stroke Assy

(shown in extended position)

Moves saw head toward
front and back of saw.

) . Printer
Guard removed from this section. & Side Clamp
Assemblies

Elevation assembly shown
in up position and
Stroke assembly shown in
retracted position.

Saw Head

Left side of saw is cut off for better visibility.
Front side doors are open.

Maintenance
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Figure 2-6: Major Components Visible From the Front of Saw

Saw Chamber Door
(shown open)

Saw Head

J Outfeed Assy

Printer
Supplies
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Figure 2-7: Major Components Visible From the Right Side of Saw

Top
Half
Sawg g
Chamber
Door

Main Pneumatic
Filter/Regulator

Waste
Conveyor
(may be on opposite end)
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SECTION 1: PARTS AND PROCEDURES

Calibration

Homing the Gripper, LASM, and Stroke
Currently affects only the gripper, LASM, and stroke axes!

The primary reason the home position may become compromised and needs to home itself
is that a jam in any given axis may cause the motor collar to slip. The motors are designed
to let this happen to avoid costly damage. By automatically homing itself, occasional slips
are planned for and dealt with automatically. But, if the saw is experiencing a high number
of out-of-calibration instances on a certain axes, the root cause must be determined and
fixed. If the saw reads 4 or more slippages on the same axes within an hour, it gives the
following error: The (axis name) servo has mechanically slipped many times in a short
duration. The Online Support button will display a web page with information on how to
eliminate this issue. Online Support is accessible from this error, from the saw’s Home
Screen, and from our web site.

The counts do not reset at 4, but continue to count up within any 60-minute time frame.
Online Support describes all the points to check on each axis. Table 1 describes the
method used to track each axis position and the accuracy required.

Table 1: How Positions are Tracked

. Measures . "
Axis . How it Tracks Position
Inaccuracies

Reads where trailing edge of board passes beam of
Gripper >3/32” Leading Edge Sensor (receiver/transmitter pair on front
end of Infeed Rail), and beam reconnects.

Uses LASM Lockout Sensor (also called No Fly Zone
sensor) to tell when LASM is directly in front of blade (if

LASM >1716 blade is at 90 deg). As LASM moves toward outfeed
side and passes sensor, position is captured.
Stroke ~1/16" Uses Home Sensor on retract motion to capture posi-

tion.

Calibrating the Angle, Bevel, Elevation, and CLS

Refer to page OP-141 in the Operation Manual for basic calibration procedures. This
section provides additional technical details to assist maintenance personnel with
troubleshooting.
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Cleaning and Inspecting

To clean or inspect the equipment, disconnect the unit from its power source first.

Cleaning Debris and Dust Off the Machine

It is important to blow off the equipment daily. Saw dust acts as an insulator and will
prevent electrical components from working properly, and debris causes mechanical jams.

Never use compressed air inside the electrical
enclosures! It may force contaminates into the
electrical connections.

Use a vacuum to remove dust from electrical
enclosures. Canned air is acceptable after vacuuming.

BLOW OFF... VACUUM...

Top and sides of saw frame Inside electrical enclosures:
NEVER USE COMPRESSED AIR!

Floor of stroke/elev chamber

Auto Deck chains

Infeed rail where board travels

Gripper assembly, behind gripper Floor of saw chamber

assembly, and board slip sensor Saw chamber, especially around
blade and LASM (cover the
Crooked Lumber Sensor under
Inside top/side clamp assembly LASM to protect from saw dust)

Sensors on Infeed Rail near saw end

Outfeed clamp, lumber channel, Floor under and around system
behind outfeed clamp at cylinder

Inside stroke/elev chamber; all axes

Remove lumber scraps and anything
that doesn’t belong on equipment
surfaces & belts, and blow off surfaces

Wiping Off the Machine

Do not use liquid cleaners, aerosols, abrasive pads, scouring powders or solvents, such as
benzine or alcohol. After blowing dust off, use a soft cloth lightly moistened with a mild
detergent solution to wipe off the equipment. Ensure the surface cleaned is fully dry before
reconnecting power.
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Small brush
Cleaner fluid

Washing station

Refer to...

These instructions
are also in the
Printer appendix in
the Operation
Manual with
additional
maintenance
requirements.
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Cleaning the Printer

If ink or cleaner makes contact with a person’s skin, hair, eyes, or clothes, refer to the
treatment section on page SAFETY-28 in the Safety (English) section.

Follow this procedure carefully to clean the print heads correctly. Failing to follow these
instructions will push debris into the print head and shorten its life. When a print head is
damaged by dust and debris, it may require replacing the entire print head which is a

costly solution.

DO NOT use a cloth rag because it will push debris into the print
head nozzle including cloth lint.

A brush was provided with your new printer. It may be helpful to
trim the ends of the bristles to make them shorter, and therefore,
stiffer.

Keep the brush in a ZIPPED plastic bag. If the bag or the brush get
contaminated between uses, wash it or replace it.

Do not use other cleaning solutions! Cleaning this ink requires
100% acetone, and the Matthews cleaner has been specially
formulated to dissolve the Matthews ink. Other cleaners may
contain additional ingredients that will damage the printheads.

Do not spray the cleaner on. The spray can push debris into the
nozzles.

Always store extra bottles of cleaner in a temperature-controlled
area. When opening a bottle near the saw, set the bottle and cap
on a clean and dust-free surface.

Clean the printer face (nozzles) at least twice a day with this procedure:
1. Dip the brush in the cleaner used in the printer assembly (for flushing print heads).

2. Lightly move the brush back and forth across each nozzle, ensuring that all visible
traces of ink are gone each time.

3. Rinse the brush immediately to remove ink before it dries.

4. Place the brush in a plastic bag and seal the plastic bag.

A CAUTION
@ Wear goggles and gloves when handling ink/cleaner.
o Never wash ink or cleaner in a location where food or
@ dishes may be. Rinse area well when done.

Flushing the Printer: See page OP-177 in the Operation Manual.
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Cleaning Electrical Components

General Cleaning of Electrical Components

It is recommended to cover electrical components with a clean rag before doing any
maintenance that will disrupt existing dust.

Never use compressed air inside the electrical
enclosures! It may force contaminates into the
electrical connections.

Use a vacuum to remove dust from electrical
enclosures. Canned air is acceptable after vacuuming.

Cleaning Motor Starter Contacts

Motor starter contacts may need to be cycled to Figure 2-8: Do NOT Clean
force contaminants out. If you suspect a motor These Safety Contacts
starter contact has dirt in it, use these steps:

This procedure can be used on all motor starter
contacts EXCEPT on the red safety contacts
shown in Figure 2-8.

1. Activate an E-stop. The starter will release
(open) and the dust may fall out.

2. Release the E-stop, press RESET, and
attempt to operate the equipment.

3. If the problem continues,
activate an E-stop again, and
lockout/tagout at the equipment
power source.

4. Use canned air to blow dust
from contacts. DO NOT USE
PNEUMATIC AIR FROM
YOUR PLANT!

5. Cycle the contacts up and down
with a small screwdriver.

6. Vacuum the enclosure.
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Periodic Inspection

This inspection should periodically be done by maintenance personnel. A facility manager
should determine the frequency of this inspection, but it must be done at least once a year
to ensure the equipment will continue to operate safely.

1. Wipe down all metal surfaces with a mild cleaner.

2. Inspect all safety and operation labels for legibility.

3. Inspect all safety devices, ensuring they are intact and working.
4. Thoroughly clean the pneumatic filter sludge.

5. Check entire system for loose hardware.

6. Check for leaks at all motors, bearings, gearboxes, etc.

7. Blow out all motor vents.

8. Inspect all sprockets, replacing any that do not rotate easily.

9. Check all chains and belts for excessive wear and proper tension.

10. Measure the LASM fixed jaw. It must be at least 1-1/2” thick. See Figure 2-30 on
page MT-113.

11. Inspect and vacuum all electrical enclosures and junction boxes. Check for loose
wires.

12. Sweep and mop the area surrounding the equipment, being careful not to spray
water directly in an electrical enclosure.
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Grease points are
shown on

page MT-73 and
motor locations
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page MT-74.
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Use #2 lithium-
based grease for
all grease
applications
mentioned in this
manual.
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Lubricating

Proper amounts of motor oil and grease must be maintained at all times. The type of
lubrication used, frequency of application, oxidation, and contamination of the lubricant
affect service life and parts efficiency of gears and bearings. Follow the guidelines in this
manual to obtain improved performance.

There are synthetic fluids, synthetic blends, and hydrocarbon fluids (mineral). With these
lubricants, special consideration must be given to the seals, pump performance, paints, and
any plastics in the system. In addition, the viscosity of synthetic fluids and synthetic
blends is usually much lower than the viscosity of hydrocarbon (mineral) based fluids.

Overview of Lubrication Points

Lubrication guidelines are given in this chapter in the section for each part or system that
requires lubrication. The information is also in the Maintenance Checklist appendix.

Mixing synthetic lubricants with mineral lubricants is
not recommended. Check with your lubricant supplier.

Table 2-1: Cross-Reference Guide to Lubrication Information

Component See Page...
. There are no chains on this equipment that need to be
Chains .
lubricated regularly.
Refer to the Motors and Gearboxes section starting on page
Motors and . P .
Gearboxes MT-73 for motor oil and gearbox lubrication information. Motor
locations are shown in Figure 2-10 on page MT-74.
Linear Guide Refer to the Linear Guide Bearings section starting on page
Rails MT-89 for the lubrication procedure.
Elevation Jack Refer to page MT-96 for lubrication instructions and
Screw specifications.
Auto Deck Refer to page MT-107.

Outfeed Clamp
Camfollowers

Refer to the Lubricating the Outfeed Clamp Camfollowers
section on page MT-115.

Waste Conveyor

Refer to page MT-124.

Powered Skewed

Conveyor

Refer to page MT-130.

001080 rev. A
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Motors and Gearboxes

Maintenance and Location of Motors/Gearboxes

Certain preventive maintenance is required to keep the motor and gearbox in optimal
working order. Table 2-2 lists all motors on the system and page MT-74 shows their
locations.

Table 2-2: Detailed Maintenance Information for Motors

see page
Auto Deck 3/4 hp Nord gearbox yes MT-75 no
Powered Skewed 1h Boston see page no no
Conveyor P gearbox MT-131
Lumber Exit Chain Nord see page
Drive 1/2 hp gearmotor yes MT-75 no
Nord see page
Waste Conveyor 1/2 hp gearmotor no MT.75 no
yes see page
Blade 5hp (2 fittings) | MT-96 no
Angle servo no no internal
Elevation servo w/brake yes no external
Infeed Drive servo w/gear reducer no no no
Stroke servo w/gear reducer no no no
LASM servo w/gearbox no no no
Bevel gearbox yes no
Bevel
GAM gearbox no no no
001080 rev. A Maintenance
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Figure 2-10: Motor Locations

Elevation

Auto Deck motor
is not shown.

Bevel
,
| v

Waste
Conveyor

Front of Saw
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Filling and Replacing the Lubrication Level

Periodically check the oil in all the motors/gearboxes that are indicated on page MT-73.
Many of the gearboxes are sealed for life and do not need the oil to be filled or replaced.
For motors/gearboxes that need oil, fill with an oil recommended in Table 2-3 as needed.

Nord Gearboxes Only

When additional oil is needed in a motor/gearbox, use one of the oils recommended in
Table 2-3 for Nord motors.

Table 2-3: Recommended Motor Oil for Nord Motors

ISO VG 220 mineral oil

Brand and Type Manufacturer filled with Mobil SHC 630
(non-synthetic)

Y<oro/4

Motor locations

:/lh'?v%lz on page For Nord brand motors/gearboxes, replace the oil as indicated:

Replacing the Oil in Nord™ Gearboxes

» Standard oil: 10,000 hours or 2 years (whichever comes first)

* Synthetic oil: 20,000 hours or 4 years (whichever comes first)
When it is time to replace the oil in a Nord motor/gearbox, follow these steps:

1. Completely drain the oil by removing the drain plug. On Nord motors, it is a
metric socket-head cap screw.

2. Screw the drain plug back in place.

3. Remove the fill level plug and add new oil through the opening. On Nord motors,
the fill level plug is a hex head cap screw.

001080 rev. A Maintenance
Original Instructions MT-75



grease
hex socket set

grease nipples
and grease gun

torque wrench
seal tape

rags

ml BLADE " Wood Processing Sys.

MiTek"
Adding Lubrication to Nabtesco™ Gearbox (Bevel Axis)

Lubrication for Nabtesco Gearbox

Recommended grease: VIGOGREASE REQO™
» Operating temperature range (ambient): 14°F to 104°F (-10 to 40°C)
» Reservoir volume: Approximately 219 grams

* This is a synthetic EP lithium grease sold by Nabtesco. If substituting a
different grease, work with your supplier to ensure it is equivalent.

* Replace every 20,000 working hours

Lubrication Procedure

The bevel gearhead has a Nabtesco gearbox and a GAM gearbox (PN 410281). The
GAM gearbox is sealed, but the Nabtesco gearbox requires lubrication. Follow these
instructions for lubricating the Nabtesco gearbox.

1. Rotate and position the output shaft of the reduction gear so that the tapped holes
for injecting/draining grease are located diagonally as shown in Figure 2-11.

2. Lockout/tagout all power.

A CAUTION

LET COOL BEFORE UNPLUGGING HOLE!

If a tapped hole for injecting/draining grease is
unplugged while the reduction gear is still hot, hot
lubricant sprays out, which could cause burns.

3. Drain and add grease following these steps:

Figure 2-11: Nabtesco Gearhead Hole Identification

a) Unscrew the hexagon socket head cap plugs and other parts from holes
A and B shown in Figure 2-11.
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b) The exact location of the 2 holes will vary depending on where the shaft
stopped rotating. Drain the lubricant from the lower hole.

c) Attach a grease nipple to the lower hole, leaving the upper hole open as a
vent to protect the seals.

d) Add grease until it is visible at the edge of the top hole. The capacity of
the reservoir is 219 grams.

4. Use the torque settings listed in Table 2-4 to install the plugs and other parts:

Table 2-4: Torque Settings for Hole Plugs (for 020E Model)

A M6 cap screw & washer 121 +/-0.61
B Plug GM-1/8 12.3 +/-2.45

a) Install new seal tape onto the plugs.
b) Re-install the plugs and other parts that were removed from the holes.

¢) Wipe off the gearbox and surrounding area.
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Slippage Errors and Tightening Motor Couplings

Figure 2-12: Potential Causes of Gripper Slippage Error

1. Check for mechanical obstructions like 2. Check the home sensor, bracket,
wedges, damaged parts, etc. that may be and target plate for damage.
inhibiting the axis from moving freely. Should be 1/32” gap (paper folded

in half should slide easily under it).

3. Lubricate linear
guide bearings.

4. Check timing belt tension moves 1/4” up an down.
Check pulley: teeth should not be worn and shaft
should not have movement. o

5. Torque Setting:

309 in-Ib
use 4-mm hex key
2 places
6. Tighten coupler between
motor and gearbox.
7. Ensure gripper nor Detailed procedure is on
boards are hitting the Servo Troubleshooting web page.
infeed side clamp rollers Torque Setting: 89 in-lb
or printer at the saw frame. use 4-mm hex key
001080 rev. A Maintenance
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Figure 2-13: Potential Causes of LASM Slippage Error

1. Check for mechanical

obstructions like wedges,

damaged parts, etc. that

may inhibit the axis .
from moving freely. 6. Check the quality

2. Ensure LASM travels
smoothly, does not hit
any part of saw, and
does not show signs of
recent blade collisions.

4. Check the home sensor, bracket,
and target plate for damage.
Should be 1/32” gap (paper folded -
in half should slide easily under it). 5. Tighten coupler between motor and

of the saw blade and
ensure it spins smoothly.
Dull or wobbly blades
can put the saw in a bind.

5. Check timing belt tension
moves 1/4” up an down.
Check pulley: teeth should
not be worn and shaft
should not have movement.

3. Lubricate linear
guide bearings.

gearbox. Detailed procedure is on
Servo Troubleshooting web page.
Torque Setting: 89 in-Ib
use 4-mm hex key
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Figure 2-14: Potential Causes of Stroke Slippage Error

1. Check for mechanical obstructions like 8. Move to Min/Max positions
wedges, damaged parts, etc. that may be and ensure bumpers do
inhibiting the axis from moving freely. not hit hard stops.

2. Check the home sensor, bracket,
and target plate for damage.
Should be 1/32” gap (paper folded
in half should slide easily under it).

7. Check the quality of
the saw blade and

3. Tighten coupler between nsure it spins smoothly.
motor and gearbox. Detailed
procedure is on Servo

Troubleshooting web page.
Torque Setting: 159 in-Ib
use 5-mm hex key

4. Lubricate

linear guide

bearings.

5. Check timing belt tension 6. Ensure stroke travels smoothly
moves 1/4” up an down. and does not hit any part of saw.

Check pulley: teeth should not be worn
and shaft should not have movement.
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Figure 2-15: Tightening Motor Coupler on Servo Motors

For Gripper Coupling (Output):

1. Remove the guard to expose the coupling at Output screws.
2. With E-stop actuated, move axis with your hand.
3. Torque both screws.

For LASM, Stroke, Gripper, and Angle Servo Motors (Input):
1. Remove the plug labeled INPUT in photo to access the hole.

2. Align the screw with hole by either: Gripper motor shown here.
a) For LASM, Stroke, Other axes have similar assembly.
and Gripper only:
With E-stop actuated,
move axis by hand.
OR

b) For all 5 axes: L,
With power on, it
use the OUTPUT
Moving to a Position Hex-Head
procedure below. Motor Torque Socket INPUT Allen

3. Torque the screw to the |LASM 44 in-lbs  8-mm Motor Torque Wrench
appropriate setting using Stroke 106 in-lbs  10-mm LASM 89in-b  4-mm

a torque wrench Angle 106 in-Ibs 10-mm| | Stroke 80in-lb  5-mm
and hex key. i :
Allen Wrench ievle ?27”1 IbIb g mm

Gripper 309 in-lbs 6-mm ngle in- -mm

\_ (2 places) Gripper 89 in-lb 4-mm/

For Bevel Servo Motors (Input & Output):

Use the same steps above, but
refer to the pictures below.

GAM Input Shaft
Coupling Bolt
50 in-Ibs

GAM Output Shaft and
Nabtesco Input Shaft
Coupling Bolt

120 in-Ibs

Gearbox
Moving to a Position:

Enter small position changes in Diagnostics>Detailed Diagnostics>Move To Position
fields to move motor coupler in small increments.
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Changing the Rotation of a Motor

This system uses 3-phase power. If a 3-phase motor is rotating in the wrong direction,
swap two (2) of the 3-phase wires at the incoming power and test again.

Figure 2-16: Swap 2 of the 3-Phase Wires to Change Motor Direction on Saw

Connect
3-Phase
Power Here

Connect
Ground
Wire Here

[t s e i o e

Top Half of Main Enclosure

001080 rev. A Maintenance
Original Instructions MT-82



MI BLADE™ Wood Proce_

MiTek

If the Auto Deck motor is turning in the wrong direction, swap any 2 of the wires shown in
Figure 2-17.

Figure 2-17: Swap 2 of the 3-Phase Wires to Change
Motor Direction on Auto Deck
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Timing Belts

The timing belts in Table 2-5 may need to be tightened or replaced due to normal wear.
Instructions can be found later in this section.

Table 2-5: Belts and Belt Sizes

Belt Name Length
Gripper timing belt 552 in.
LASM timing belt 134 in.
Stroke timing belt 68 in.

A  WARNING

ELECTROCUTION AND CRUSH HAZARDS.

Always verify that all power to the machine has been
turned off and follow approved lockout/tagout safety
procedures (OSHA 29 CFR 1910.147) before
performing any maintenance on this equipment.

The components on this machine can cause severe
injury if adjusted improperly. Follow all procedures in

this manual and do not make adjustments to the
machine without guidance from MiTek or MiTek
documentation.

Only trained personnel should make mechanical
adjustments to this machine.
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Adjusting the Gripper Timing Belt Tension

1. Loosen the 4 bolts

clamping the
gearbox mounting Figure 2-18: Adjusting the Gripper Timing Belt
bracket to the
frame. Bolts
Clamping
2. Back off the jam Bracket
nut and turn the to Frame
tension bolt to (2 on bottom also)

wedge the entire
infeed drive motor
and bracket out
until the belts are
tight.

Tension should be
guitar-string tight,
but do not over-
tighten. Test the
tension at the drive
end. The top
section of the belt
should lift
approximately
3/16 in. with little
effort.

3. Re-tighten the
bolts clamping the
bracket to the frame.

4. Move the gripper assembly back and forth (from the touch screen) to test the belt
tracking. Adjust if necessary.
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Removing Top Gripper Assembly

Occasionally, during maintenance of the gripper and belts, you may need to remove
the top gripper assembly.

1. Position the gripper assembly so the screws labeled A in Figure 2-19 are
accessible.

2. Lockout/tagout.

3. Remove the back panel.
4. Remove the stop bar by removing the 3 socket head screws on top.
5. Remove the 4 flat head screws labeled A.

6. Slide the gripper assembly, following the instructions on page MT-93 to prevent
the bearing balls from falling out of the linear guide bearing block.

Figure 2-19: Gripper and Belt Assembly, View from Back Side

Timing Belt Back Panel j
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Manually Turning the Gripper Belt to Find Obstructions

If you need to manually move the gripper to

remove an obstruction or troubleshoot, the
gripper belt can be jogged from the saw’s tfﬁ
operator interface. Y

If the gripper
From the Home Screen, select the Gripper becomes difficult to
indicator and choose one of the Jog options. move, refer to the
Move the gripper assembly back and forth to Troubleshooting
test the belt tracking. Adjust if necessary. appendix.

Adjusting the Gripper Belt Tracking

If the gripper belt is not tracking on the shaft evenly, loosen the tension (see page MT-
85) and manually move the belt over to the center of the shaft. Tighten the tension,
ensuring that the motor assembly is straight and square. Manually move the gripper to
the opposite end of the Infeed Rail to test the tracking. Repeat this process until the
belt stays where it was placed on the shaft.
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LASM and Stroke Belts

The LASM assembly and the stroke assembly are each attached to their own cogged,
white belt, called a timing belt. To adjust the tension of the LASM or stroke timing belt,
perform these steps:

1. Locate the threaded rod used as a tension bolt that puts tension on the timing belt
attached to the assembly. The Stroke tension bolt is shown in Figure 2-20. The
LASM tension assembly looks similar.

2. Back off the jam nuts and adjust the bolts to tighten or loosen the tension on the
cogged, white belt.

3. Tighten the jam nuts.

4. From the saw’s Home Screen, select the Stroke or LASM indicator and choose
one of the Jog options to move the assembly back and forth to test the belt
tracking.

5. Adjust if necessary.

Figure 2-20: Stroke Timing Belt Tension Bolt, in Stroke/Elevation Chamber

v 3 -

i 8 4 daddadiad |

Tension Bolt for Timing Belt | :
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a Linear Guide Bearings

r:_:k
Prior to 2015, oil
cartridges were
used on the
bearings instead
of grease fittings.
The bearings
described here

Lubricating the Linear Guide Bearings

Grease Required

Mobilux™ EP 2

are a direct This is a general purpose, lithium-based Grade 2 grease that provides excellent
replacement for protection against rust and corrosion and resists water wash-out, corrosion protection,
those models. low temperature pumpability, and high temperature service life.

Other Grade 2 greases will not provide the necessary
properties at the high temperatures experienced in
this application. Use only the recommended grease.

Grease Gun Recommended

It is recommended to use the following grease gun to ensure the proper amount of
grease is applied. If you do not have this grease gun available for this procedure, it is
recommended that you purchase one for future use. These bearings require re-greasing
at frequent intervals. Having a policy stating the grease gun and number of pumps to
use on each bearing will elongate their life and the accuracy of the saw.

Hiwin GN-80M
Output: 0.5-0.6 cm® per stroke

If you choose to use a different grease gun, document which gun is to be used for this
procedure and ensure employees know the output per stroke. The output per stroke
should be equal to or less than 0.5 cm? per stroke.

Modifying Your Grease Gun Figure 3: Grease
Gun Tip

It may be difficult to fit the grease gun tip onto the
bearing fitting due to limited space around the
bearing. To make the greasing process easier, grind
down a flat spot on one side of the grease gun tip or
machine the outside diameter (O.D.) of the tip down
so it fits into the space around the bearing fitting.
The outside diameter is shown in Figure 3.

This requirement makes it that much more important to have a grease gun dedicated
for this procedure.
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Grease gun

Lockout/tagout
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Applying Lubrication to the Bearings

Check the quality of the lubrication on the guide rails every week to determine when
more grease is needed. The frequency of greasing depends on many factors including
amount of use and amount of dust. After enough time has passed to determine a
pattern, document how often the bearings should be greased, but continue to inspect
the rails every week.

Linear rails using the previously used bearing blocks (that have a reservoir cartridge
instead of a grease fitting) should also be inspected each week. Instructions for
maintaining those bearings are located in the first release of the BLADE Maintenance
Manual, but MiTek strongly recommends replacing them with the current bearing
style for the most successful maintenance plan.

For re-greasing the new bearings with the grease fitting:

» Use the volume of grease listed in Table 2-6.

* It is highly recommended to either use the grease gun recommended on page
MT-89 or to create an internal procedure stating the exact grease gun that
should be used and how many times to pump the gun handle to administer the
correct volume of grease.

Table 2-6: Volume of Grease

. . Grease
Applicable Kit (a0t sup i)
LASM, Stroke, & Elevation (size 25) 0.8 cm?®
Gripper, Infeed Top Clamp, Infeed Side Clamp, and 0.5cm?

Outfeed Clamp (size 20)

Add grease to these new bearings periodically to
ensure saw accuracy and prevent friction from
damaging components.

Overgreasing will cause premature failure of bearing
seals and excessive saw dust and dirt to stick to the
guide rails, negating the benefits of the grease.
Undergreasing may cause damage to components
and affect the accuracy of the saw. A thin film of
grease should be visible on the guide rails at all times.
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Bearing Locations and Quantities

Table 2-7: Assemblies Lubricated by Linear Guide Bearings

MI BLADE™ Wood Proces-

Infeed Rail Gripper 2 not shown
Top Clamp 4 Figure 2-1
Infeed Side Clamp 4 Figure 2-1
LASM 4 Figure 2-2
Stroke 4 Figure 2-3
Elevation 4 Figure 2-3
Outfeed Clamp 4 Figure 2-4

Figure 2-1: Bearing Locations for Infeed Side and Top Clamps

Infeed Side Clamp
Linear Bearings

\

3
i
y i

Infeed Top Clamp
Linear Bearings
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Figure 2-3: Bearing Locations for Stroke and Elevation

Elevation

Elevation

Stroke/elevation chamber as viewed From left side.
Oil cartridges are behind the plates
at the circled locations.

Figure 2-4: Outfeed Clamp Bearings
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Replacing a Linear Guide Bearing Block

To replace a linear guide bearing, order the appropriate kit listed in Table 2-8.

Table 2-8: Parts in SB209 Kits

Hex key wrench
set (metric)
Proper grease

3
Grease gun SB209KIT-A (size 25) for 0.8 cm
Lockout/tagout LASM, Stroke, & Elevation
SB209KIT-B (size 20) for Gripper, Infeed Top Clamp, 0.5 om?

Infeed Side Clamp, and Outfeed Clamp

1. After locking/tagout out, remove the previously used bearing block:

a) Unscrew the 4 screws from the plate. Keep the screws to use later.

b) Slide the bearing off of the rail. Be sure to keep the bearing level to
prevent the ball bearings from falling out.

2. Discard the previously used bearing, but NOT the screws.

3. Examine the new bearing block. The grease fitting must be securely attached to
the bearing block. If it is loose in the box, connect it using these steps:

a) Clean dust, metal shavings, and oil off the hole threads. Use a standard
brake cleaner or anything that removes lubrication.

b) Screw the fitting into the bearing block as shown in Figure 2-5. Ensure
the fitting is facing a direction that allows it to be easily accessed later.
The direction the fitting should face depends on its location on the saw, so
visualize its location carefully before installing the fitting.
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Make sure the
grease fitting is
pointing out, so it
is easily
accessible.

.
MI®

MiTek’

BLADE™ Wood Processin-

Figure 2-5: Important Parts of Each Bearing Block

Holes for attaching to plate are on opposite side.

Size 25 Bearing

| Grease fitting
must be accessible
after installation.

Holes for
attaching to plate.

R 0.54  TTES Size 20 Bearing

Block Insert Grease fitting
' «— € must be accessible

after installation.

=—

|

4. Clean oil and debris off of the parts listed below. A standard brake cleaner or
anything that removes lubrication will work.

a) On the new bearing, with the block insert in place to protect the ball

bearings, carefully clean the threaded screw holes. Do not get cleaner in
the ball bearing area.

b) Clean the screws that were removed from the old bearing block.

5. Install the new bearing block with the fitting facing out, so it will be accessible to
grease in the future.

)

b)

Slide the bearing block onto its rail, allowing the rail to push the block
insert completely out of the bearing block.

Slide the bearing block down until it is behind the linear guide plate and
the holes are aligned.

Using the screws removed from the previously used bearing block, apply
blue Loctite™ thread adhesive to each screw, and then screw the plate and
bearing block together.

001080 rev. A
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d) Wait 10 minutes for the Loctite thread adhesive to dry before moving the
assembly.

Use Loctite thread adhesive to prevent the bearings
from coming loose, causing costly machine damage.

The bearings are shipped with NO grease in them.
They MUST be greased before operating the saw!

6. After the Loctite thread adhesive is dry, apply the correct amount of grease to the
fitting.

* The grease volume is listed in Table 2-8 on page MT-93.
» The correct grease is specified on page MT-89.
* The grease gun recommended is described on page MT-89.
Overgreasing will cause premature failure of bearing seals and excessive saw
f dust and dirt to stick to the guide rails, negating the benefits of the grease.

=,
"w-‘\_,l Undergreasing may cause damage to components and affect the accuracy of
the saw. A thin film of grease should be visible on the guide rails at all times.

7. Remove the lockout/tagout mechanisms.

8. Run the saw for several minutes, then lockout/tagout again and look at the rail.
Check to see if a lubricant film can be seen on the rail. If not, add more grease.
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Elevation Jack
Screw

The elevation jack screw raises
and lowers the saw head. It
requires the following lubrication:

Apply grease to the 2 fittings on
the jack screw housing every

3 months using a standard grease
gun.

Use XHP222 Mobil

'{ix grease for both grease

fittings.

Saw Blade Motor

The saw blade motor has 2 grease
fittings that must have #2 lithium-
based grease added at least once a
year. See page MT-75 for saw
blade motor oil information.

Figure 2-6: Lubrication for
Elevation Jack Screw

1
Grease|
=,

==

) i‘
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To replace the
blade motor
cable, see page
MT-170.
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Saw Blade

Direction of Blade Teeth Figure 2-7: Saw Blade Assembly

The saw blade rotates toward the
operator, traveling down when the
blade is in home position (Angle at
default 90 degrees). Screws must be
torqued correctly. See page MT-99.

Specs for New or
Used Saw Blades

When Retipping Blades

The following specs are critical:

e 177 =blade diameter
o .189=kerf

Z= # of teeth

10.5= hook angle

* 0= face angle

* 15=back angle Throw away saw blades with less
e 10=top angle than 16-5/8” diameter.

For New or Used Saw Blades

When to Replace the Saw Blade

Replace the saw blade on the saw at least once a week.

The frequency of blade changes and of repairs depend on the amount of use and the
species and grade of lumber, as well as the number of hours the saw is running each week.
Your plant may need to change the blade more often for optimum saw operation.

/A  WARNING

Check torque on blade screws daily and whenever
there is visible vibration of the saw blade.

Keep saw blades sharp and in good condition. Have
the saw blade re-tipped if carbide tips become
chipped or come off. Dull blades cause high kickback
forces which can cause injury.

Use new screws, matching the specs provided, each
time a blade is replaced.
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Use only
1/4”-28x5/8”

flat head screws
of the same
strength and
specifications as
MiTek SB202KIT
supplies.
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How to Replace the Blade

A CAUTION

/f—\\ CUT HAZARD.
|" ' Saw blades are sharp. Wear gloves and eye protection
' '/' when handling blade.

=

1.

Gather the following supplies:

a) New or sharpened saw blade.

¢ For a new saw blade, order SB202KIT from MiTek.

b) Correct screws (6):

* FEach new saw blade kit comes with a box of 50 screws. Keep the extra
screws to reinstall a used blade after sharpening.

¢) Correct Torque wrench and T30 Torx™ driver
(also called star or hexalobular internal shaped driver).

After ensuring the power is locked out, loosen and remove the screws labeled in
Figure 2-8 on page MT-99. Discard the screws.

Remove the saw blade and place in a safe place for sharpening or re-tipping.

Place a new saw blade so the holes are aligned with the holes in the hub.

A  WARNING

Use new screws every time the blade is replaced.

Do NOT use thread adhesive.
Torque to specifications given in Figure 2-8!

Using new screws obtained from MiTek with your last new saw blade purchase,
install all 6 screws.

* Use the driver and screws described in step 1.

» Tighten each screw one half turn at a time, alternating between screws in a
clockwise order.

» Torque to the specification listed in Figure 2-8 on page MT-99.

To prevent the screws from shearing off, which could result in serious injury, do
not use thread adhesive.
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Figure 2-8: Torque Specs for Saw Blade and Hub
(View from outfeed side of saw, with blade at 90 degrees.)

vl Bevel Motor

§ m i
© =]
S =)
.

6 Screws holding 4 Screws shown in yellow ring

blade to hub: (holds hub to shaft):

Torque to 110 in-lb Torque to 70.8 in-lb

(12.4 Nm) (8.0 Nm)

Figure 2-9: Torque Specs When Replacing Blade Gearbox

‘” Torque to 138 in-lb
V 'yz-;-m f/w (15.6 Nm)

’.yﬂj
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- . ! Torque to 561 in-lb
e !‘ (63.4 Nm)
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Felt Strips

Felt strips provide friction resistance for the yellow plate that slides up and down with the
elevation axis located inside the stroke/elevation chamber. The felt strips are attached to
the blue wall behind the yellow plate. When the plate is showing signs of metal rubbing
metal or an uneven plate, replace the felt strips immediately to preserve the accuracy of
the cuts and prolong the life of the saw.

Trimming the Felt

If no metal wear is shown, but the felt has expanded outside of the yellow plate, just trim
the excess felt and periodically inspect the plate and frame for wear.

Replacing the Felt Strips
It is recommended to replace all 4 felt strips at the same time to keep the plate even.
1. Loosen or remove the white strips securing the yellow plate.

2. Pull the yellow plate away from the wall and scrape off the old glue.

3. Remove the adhesive backing from the new felt strip and apply it in the same
locations.

Figure 2-10: Location of the Felt Strips

White strip clamps
yellow plate against
blue wall.

Felt strip is located between
blue wall and yellow plate.

Adheres to the blue wall,
positioned along all
4 edges of yellow plate.
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Not all bumpers
are the same
size. Refer to the
Parts List
appendix or Parts
Finder online for
the correct part
number.
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Elevation
Pins

Elevation pins are used to
hold the elevation in place
and square. They provide
the ability to remove the
elevation, although
normal use of the saw
should not require this.

Bumpers

Rubber bumpers are used
on the following axes to
reduce stress on
mechanical parts when
stopping at the end of
their range:

« LASM
* Stroke
* Elevation

 Gripper

Figure2-11:
Elevation
Pin

To replace a bumper, remove the screw in the middle and discard of the damaged bumper.

Figure 2-12: Bumpers on LASM Travel
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Brushes

Figure 2-13: Brush on LASM Rail

Brushes exist at some openings and rails to keep scrap and other debris from accidentally
entering the saw chamber or sitting on a rail causing an axis obstruction. The brushes
should be inspected periodically and replaced when necessary.

As of June 2015, the LASM brushes are designed to be installed as shown in Figure 2-14.
For previous designs, this design is a direct replacement for the previous version.

Figure 2-14: Installing LASM Brushes

Top Brush: Slotted, overlap 6”

Bottom Brush: 6” under top brush
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Shock Absorbers

The following shock absorbers keep the clamps from slamming at the end of their cycle.

* Top clamp: Located on extend and retract positions.

* Infeed side clamp: Located on retract position only.

* Outfeed side clamp: Located on retract position only and controls clamp opening.

Replacing a Shock Absorber

1. Preparing the Saw:

a) Move the component requiring the shock absorber to make accessible:

* For the infeed side clamp, move the gripper to Home position.

* No positioning is required when replacing the infeed side clamp or
outfeed clamp shock absorber.

b) Lock out and tag out the source that supplies power to the saw.

2. Unscrew the locknut and damaged shock absorber and discard all pieces.

3. Install the new shock absorber into the bracket:

a) Remove the lock nut from the new shock absorber.

b) Place the collapsible end through the bracket pointing the correct
direction, and screw it in as indicated in Table 2-9.

c) Slide the lock nut over the collapsible end and tighten against the bracket.

4. Check that the sensors on the cylinder that control “fully open” and “fully closed”
are set correctly. Their location may need to be slightly adjusted.

Table 2-9: Shock Absorber Installation Properties

. PN & . Piston
Location Qty Graphic Distance points...
Top Clamp: Top 5 447010 1/2” from bottom surface of bracket Down
(retract) Figure 2-15  to end of shock absorber body.

Top Clamp: Bot- 5 447010 1/2” from top surface of bracket to U
tom (extend) Figure 2-15  end of shock absorber body. P
Infeed Side 447009 : Toward
Clamp 1 Figure 2-16 See Figure 2-16. saw front
Adjust to 2-1/2” between lumber
Outfeed Clamp 1 447009 exit chain teeth and camfollower. Toward
Figure 2-17 saw front

See
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Adjusting a Shock Absorber

Figure 2-15: Shock Absorbers for Top Clamp Retract Stroke (see Table 2-9)

Retract shock
absorbers

on top clamp
shown here.

Figure 2-16: Top View of Infeed Side Clamp Rollers

- ‘l ©
3-1/8" .

unclamped

-
©

Board Travel
@

Figure 2-17: Adjusting a Shock Absorber (shown on outfeed clamp)

Outfeed
Clamp

001080 rev. A Maintenance
Original Instructions MT-104



MI BLADE™ Wood Process-

MiTek

SECTION 2: MECHANICAL ASSEMBLIES

Auto Deck Staging Conveyor

The Auto Deck will not operate from the Auto Deck control station
"‘C\ in the forward direction unless the Infeed Rail’s load arms are up.
; }1 In the BLADE software, click the Load Arms indicator on the
Home Screen and choose Up to manually raise them.

Auto Deck Sequence of Events

To assist in troubleshooting and analyzing Figure 2-18: Lumber Pusher
the health of your Auto Deck system, here is and Sensor
a brief summary of how the system works.

1. An operator places lumber onto the
end of the Auto Deck chains,
against the angle fence.

2. The Auto Deck lumber pusher, on
the Infeed Rail-end of Auto Deck,
works with a sensor. When the
Board Sensor detects a board, the
lumber pusher pushes it away from
the fence.

3. The conveyor chain advances
and the board travels to the
load arms which are up. The
board is squared by the load
arms, then the load arms go
down, and the conveyor chain
advances until the Load Arms
Sensor detects the board and
stops the conveyor chain.

4. The load arms then flip the
board onto the Infeed Rail,
and the process starts over.
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Understanding the Lumber Stops

The lumber stops separate different jobs that may be on the Auto Deck staging conveyor at
the same time. They can also provide spacing between groups of boards to reduce the
amount of pressure placed on the board by the other boards on the Auto Deck. Excessive
pressure can cause boards to become skewed and load improperly onto the Infeed Rail.

The lumber stops are pneumatically activated up or down by turning the selector switch
shown in Figure 2-20. The operation of the Auto Deck is described on page OP-155 in the
Operation Manual.

Figure 2-20: Auto Deck Control Station for Manual Controls

E-Stop Pushbutton

Controls
Lumber
Stops

Controls
Chain
Direction

Foot Pedal

Operating the Lumber Stop Cylinders

There is no adjustment for the lumber stop cylinders. Pneumatic air causes them to raise or
lower when the selector switch shown in Figure 2-20 is turned to LOWER.

Lumber Stops Pneumatic Cylinder
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Lubricating the Auto Deck Shaft

Apply #2 lithium-based grease to the grease fittings on the Auto Deck shaft bearings once
a year. There is 1 fitting for each Auto Deck strand, so a standard-length system has 4.

Figure 2-21: Grease Fitting for Auto Deck Shaft

Tensioning the Auto Figure 2-22: Tension Take-Up
Deck Chain

To tension the chain, loosen the
locknut shown in the middle of the
take-up in Figure 2-22. Manually pry
the take-up, one notch at a time, until
the chain is the desired tension, then
re-tighten the locknut.

_ Do not over-tension the Auto Deck chain.
3},’1 An excessive load will cause the VFD to show a fault.
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Infeed Rail & Gripper

Overview of Gripper

The gripper is the assembly that moves the lumber along the Infeed Rail.

Figure 2-23: Gripper

Remove bolt and clean ink
and dust from pivot target.

Use Blue Loctite on screw
when reassembling.

Gripper Finger

Clean the grooves
thoroughly.

=

_Cl_amp Arm

Board Slip Sensor
Underneath Guards

Figure 2-24: Board Seated Properly in Gripper

Board entering gripper clamp. Board aligned and clamped.
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Gripper Clamping Finger Figure 2-25: Adjust the Jam
Maintenance Nut if Finger is Loose

If the gripper clamping finger becomes
sluggish when opening and closing, clean
as directed in Figure 2-23. If it remains
sluggish, disassemble it to clean and
lubricate the individual parts.

Adjusting the Gripper Belt

See page MT-85 for gripper timing belt adjustments.

Adjusting the Load Arms

Adjusting the Load Arm Positions

The load arms must be level with each other and at the correct angle to drop the board
on the Infeed Rail belt. They should be slightly below the height of the Auto Deck
chain when in a flat (down) position as shown in Figure 2-19.

Adjusting the Load Arm Speed

The speed at which the load arms rotate can be adjusted using the flow control valve
on the pneumatic cylinder. This should not be necessary in most circumstances, but if
you feel the arms are slamming too hard at the end of their cycle, slightly adjust the
flow control valve located on each of the cylinder ports.

Figure 2-26: Load Arms Shown in Orange
(in Horizontal Position)
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Infeed Top Clamp and Side Clamp

The top clamp and side clamp are on the infeed side of the saw, just before lumber enters
the saw chamber. They ensure that the board is in proper position for the LASM to grab it.

Both clamps operate with pneumatic power. Sensors tell the PLC when the clamps are
retracted or extended.

Figure 2-27: Clamps Used on Infeed Side of Saw

Direction of Board Travel

Raising the Clamp & Printer Assembly Figure 2-28: Raising
the Infeed Clamp &

For ease of maintenance, the assembly containing the Printer Assembly

infeed clamp, top clamp, and printer can be raised and
locked into place when the saw is not operating. To raise
and lock the assembly:

1. From the saw’s operator interface (menu for
Clamp indicator), unclamp the top clamp.

2. Open the saw chamber door.

3. Engage the lever inside the saw chamber, on the
left (infeed) side. It is shown in Figure 2-28.
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Lubricating the Linear Guide Bearings

Refer to page MT-89 for lubrication instructions.

Shock Absorbers

Refer to page MT-103 for replacement and adjustment instructions.
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Adjusting Clamp Speed

Side and Outfeed Clamps

The infeed side clamp and the outfeed clamp have a flow control valve on the cylinder
to adjust the speed of the retract stroke.

Top Clamp

The top clamp, located on the infeed side of the saw, has a speed muffler to dump the
air pressure. The screw at the bottom of the muftler can be adjusted to control how
quickly the air is dumped. Move the screw out to increase the speed of the retract
stroke or move it in to decrease the speed.

The clamp’s extend stroke uses all of the pressure passing through the clamp’s air
regulator. There is no additional adjustment.

Figure 2-29: Speed Muffler for Top Clamp
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LASM

LASM Belt and Bearings

The LASM timing belt is discussed on page MT-88.
The LASM linear guide bearings are discussed on page MT-91.

Measure the fixed jaw of LASM periodically to ensure it is not worn. It must be at least
1-1/2” thick. If worn to less than that, replace it as soon as possible.

Figure 2-30: LASM

Replacing the LASM Spikes Figure 2-31: Replacing
a LASM Spike

Spikes (socket-head cap screws) are assembled "l —1/g"

into the carriage side of the LASM jaw to hold the

board in place. When spikes become dull or =‘

damaged, unscrew each spike and replace each
with a new spike, ensuring the spike extends 1/8”
past the LASM jaw surface. Use red thread

adhesive. Use red

thread

adhesive

on spikes.
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Outfeed Assembly

The outfeed assembly consists of the following:
* A pneumatically powered outfeed clamp with camfollowers at the bottom edge

* A lumber exit chain

then opens while the LASM moves the finished part farther into the outfeed chamber.

EE If the board is long enough, the outfeed clamp holds the end of the board during the cut. It
Then, the outfeed clamp closes again to push it against the lumber exit chain, and the

Refer to lumber exit chain pulls the finished part out of the saw chamber and pushes it onto the
Figure 2-35for  outfeed table or conveyor.

outfeed

assembly Figure 2-32: Outfeed Assembly Overview

adjustments.

Back Side of Outfeed Clamp

Location of
Camfollower 4 ﬁgfﬁi‘ﬁs

Assembly L oh o Assemb

! (4 places

Bearin
(4 place%

Rai Absorber

(2 places)

Outfeed Assembly

Table 2-10: Outfeed Components Alignment Guide

LASM fixed jaw rail
sprockets
lumber exit chain

lumber exit chain
lumber exit chain
outfeed clamp camfollowers
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Lubricating the Outfeed Clamp Camfollowers

As a board exits the saw chamber, a set of camfollowers make contact with the board’s
back surface to guide it and ease its travel to the outfeed table or conveyor. Apply a

#2 lithium-based grease to each of these camfollowers once every year. Remove the top
guard to access the camfollowers.

Figure 2-33: Lubricating the Outfeed Clamp Camfollowers

Grease
Fitting

Cam
Follower,

Lumber Exit Chain

Replacing Outfeed Clamp Camfollowers

1. Remove all of the cam follower assemblies from the old outfeed clamp assembly
so they can be reused:

a) Loosen and remove the nut shown in Figure 2-33.

b) Catch the cam follower (with grease fitting attached) as it falls out when
the nut is removed. Repeat for all cam followers.

2. Install cam followers into the new outfeed clamp assembly:
a) Using the same hardware, place a washer over a cam follower shaft.

b) Place the cam follower shaft through a hole in the new outfeed clamp
assembly, place a lock washer over the top of the shaft and screw on the
nut. Tighten the nut with a hex socket. The shaft has a flat surface to
prevent it from spinning while tightening the nut. Repeat for all
camfollowers.
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Lubricating the Lumber Exit Chain Drive Motor & Bearings

The lumber exit chain drive motor and idle-end bearings require #2 lithium-based grease
once a year.

Figure 2-34: Lubricate the Lumber Exit Chain Assembly Bearings

Bearings
&3 S

Lumber
Exit Chain
Drive Motor

Sy

Front of Saw

Maintaining the Lumber Exit Chain

The lumber exit chain does not require lubrication. Occasionally blow off the area around
the chain and outfeed assembly to reduce debris and the risk of jams.
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Adjusting the Lumber Exit Chain Tension

1. Loosen 4 bolts labeled B in Figure 2-35, on the back side of the motor plate.

2. Loosen the jam nut and adjust tension bolt labeled C to slightly move the motor.
3. Tighten the jam nut and bolts B.

Figure 2-35: Adjustments on Chain Side of Outfeed Assembly, Top View

(not shown)
i
o)
) () ©
A A A

Adjusting the Lumber Exit Chain Location

The lumber exit chain must be perfectly parallel with the LASM jaws. All other
alignments are measured off of the lumber exit chain, so it must be straight and in a
location as described here. To adjust the location of the entire lumber exit chain assembly:

a) Ensure the lumber exit chain is parallel with the travel rail for LASM
fixed jaw and the chain teeth protrude 1/16” in front of the rail.

Check this measurement with LASM at left end of the lumber exit chain,
and again with the LASM all the way to the right. Both ends must be
identical indicating the lumber exit chain and LASM rail are parallel.

b) Ensure the channel for the lumber is approximately 2-1/2” wide from tip
@ of chain teeth to surface of cam followers when fully unclamped.
Refer to c) Ifitis necessary to adjust the lumber exit chain, follow these steps:
Figure 2-35 1) Loosen the 3 bolts labeled A in Figure 2-35.

2) Push or pull on the lumber exit chain assembly to align as
described previously.

3) Tighten the 3 bolts labeled A in Figure 2-35.
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Adjusting the Chain Guide Bracket

The chain guide bracket shown in yellow in Figure 2-36 holds the lumber exit chain so
that it does not sag and stays in line with the sprockets. To adjust the location of the chain
guide bracket, follow these steps using the following graphics as reference.

Figure 2-36: Bottom View of Chain, Lumber Exit Chain Guide Highlighted
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Figure 2-37: Outfeed Assembly Adjustments, Top View

(not shown)
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1. Loosen the 3 bolts labeled D in Figure 2-37.

2. Using the 2 jack screws labeled E in Figure 2-36 and Figure 2-37, loosen the jam
nuts and adjust the jack screws to slightly move each end of the chain in or out.
The chain must be in this position:

» Lumber exit chain must be tangent with the sprockets.

* If the lumber exit chain is a straight line between the sprockets, it will also be
parallel to the LASM fixed jaw as described on page MT-117.

* There must not be any sag or wave in the lumber exit chain.

3. Tighten the jam nuts on bolts E and tighten bolts D.
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Adjusting the Outfeed Clamp

The outfeed clamp camfollowers must be parallel to the lumber exit chain at all times.

1. Mechanically adjust the clamp location using these steps. Steps for adjusting in
smaller increments occur in the next step.

a) Set the lumber exit chain location EXACTLY as described on
page MT-117.

’ The lumber exit chain MUST be parallel and 1/16”
"ngx forward of LASM as described on page MT-117.

2. Use these steps to align the outfeed clamp assembly and sensors to accomplish
these bullet points:

* Outfeed clamp assembly is parallel to the lumber exit chain.

* More than 2-1/2” gap between tip of chain teeth and edge of cam followers
(with clamp fully retracted). This measurement will be refined with sensor
location and shock absorber later.

* 1-3/8” or less gap when fully extended without board in it.

» Should have slight offset between front edge of outfeed clamp cam followers
and front edge of powered skewed conveyor cam followers. This can be
adjusted on the powered skewed conveyor.

a) To make adjustments, loosen the bolts circled in Figure 2-39 and adjust
the entire clamp assembly so it is parallel with the lumber exit chain.
Tighten the bolts securely when done.

Figure 2-38: Bolts Holding
Outfeed Clamp Assembly
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b) Adjust the outfeed clamp sensors so the clamp opens and clamps to the
proper dimensions given previously.

Figure 2-39: Outfeed Clamp Adjustment

Outfeed Clamped Sensor Outfeed Unclamped Sensor

¢) To adjust the outfeed clamp in small increments to reach the correct

lumber channel, adjust the shock absorber as described in Figure 2-17 on
page MT-104.
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Removing the Existing Outfeed Clamp Assembly

If there is ever a need to remove or replace the entire outfeed clamp assembly, familiarize
yourself with Figure 2-32 to assist in following these steps.

1. Verify the LASM is all the way toward the infeed side of the saw chamber and the
electrical power is locked and tagged out.

2. Remove the outfeed clamp assembly by following these steps:
a) Remove the guards shown in Figure 2-40 with a hex key.

Figure 2-40: Remove These Guards

17 L i AW

b) Remove the 2 sensors shown in Figure 2-41 from the outfeed clamp
cylinder as described:

1) Mark each sensor to identify it as “outfeed fully clamped” and
“outfeed unclamped”.

2) Document how the wires are attached to the sensor so it can be re-
attached in the same way.

3) Inspect the wires and connection to the sensors.

Figure 2-41: Label and Remove These Sensors From the Cylinder

Outfeed . Outfeed
Fully Clamped "5 -h _._.,“ Unclamped
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If the frame
does not have
alignment holes,
SB220KIT that
was sent to all
existing saws in
2016 has not
been installed
correctly. Locate
and install
SB220KIT.
SB220
instructions can
be found on the
MiTek web site.
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¢) Blow off the entire area to facilitate the rest of this procedure.

d) Remove the 4 socket-head cap screws shown in Figure 2-42 with a hex
key and remove the lock washers. These can be discarded.

A CAUTION

2-man lift required to safely lift the outfeed assembly!
It may weight as much as 120 Ib.

Figure 2-42: Screws
Requiring Attention

e) Lift off the entire outfeed clamp assembly.

Jam Nuts for Standoff
Screws Holding Set Screw
Assembly to Adjust

Installing the Existing Outfeed Clamp Assembly (2016)

L.

Measure the fixed jaw of LASM to ensure it is at least 1-1/2” thick. If worn to less
than that, replace it before making final adjustments to the Outfeed Clamp.

Align the lumber exit chain EXACTLY as described on page MT-117.
Attach the new outfeed clamp assembly to the saw by following these steps:

a) Set the outfeed clamp assembly in place, making sure not to damage the
wires, sensors, or air lines.

b) Place the four (4) 3/8-16x1-3/4” screws and lock washers provided at the
locations show with arrows in Figure 2-42.

c) 3 of the 4 Stand-Off Set Screws are preset. Adjust the 1 Stand-Off Set
Screw indicated in Figure 2-42 until it bottoms out on the base face and
stop. Do not adjust the other 3 Stand-Off Set Screws.

d) Lock the jam nut in for the Stand-Off Set Screw circled in Figure 2-42.
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4. Align the outfeed clamp assembly EXACTLY as described on page MT-119.

5. Make adjustments in small increments by adjusting the shock absorber as shown
on page MT-104

6. Place a board in the LASM and outfeed clamp, then manually clamp both. Ensure
the board is securely clamped, verify all rollers and cam followers engage, and
everything is aligned.

7. Once everything is aligned, pin the assembly to keep it from slipping.

a) Pick any of the three existing outfeed clamp alignment holes shown in
Figure 2-43 and drill a through-hole through the frame directly behind the
existing alignment hole. Use a 3/16” drill bit.

b) Repeat at the alignment holes on the other end of the outfeed clamp.

¢) Place a pin in the newly drilled hole on each end to keep the outfeed
clamp assembly from slipping on the saw frame.

Figure 2-43: Place Pin in
Alignment Hole

@ Alignment
e Holes

8. Ifyour system has the optional Powered Skewed Conveyor, it is important that it
aligns perfectly with the outfeed assembly on the saw EXACTLY as described on
page MT-130.

9. Install the sensors. They are shown in Figure 2-41. Refer to the electrical drawing
located in your Equipment Manual if necessary.
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Waste Conveyor

Lubricating the Drive Shaft

Lubricate the waste conveyor bearings with #2 Lithium-based grease once a year. There is
1 grease fitting on each end of the drive shaft.

001080 rev. A Maintenance
Original Instructions MT-124



MI BLADE™ Wood Processing-

MiTek’

Adjusting the Belt Tension

Tighten the roller on the idle end. Start with the take-up bolt at approximately 2-1/2”.
Adjust as needed so the belt runs smoothly.

Figure 2-45: Adjust the Take-Up Bolt on Non-Drive End
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Adjusting the Belt Tracking

The belt will not track perfectly the first time. Some minor adjustments are needed at this
point. The key to perfect tracking is to make each adjustment very small and to remain
patient as it may require more than one roller to be adjusted. Expect several adjustment
cycles before the belt tracks perfectly.

A CAUTION

Use your company’s approved lockout/tagout guide-
lines while adjusting the belt. Ensure that nobody can
turn on the conveyor without notifying all personnel in
the restricted zone.

1. After tensioning the belt, test the tracking:
a) Remove lockout/tagout devices and power up the saw.
b) Run the conveyor and watch how the belt tracks.

2. If the belt walks toward one side, adjust it as described here.

a) Determine which way the belt needs to move toward, and address THAT
end.

b) Refer to the correct graphic on page MT-127 to locate the tracking roller.

c) Adjust the angle of the tracking roller so THAT end angle back, away
from the drive end.

YOU ARE DONE WHEN:

The belt should stay approximately centered on the conveyor bed. Some minor back and
forth motion is normal, but it should never rub the side of the conveyor bed frame.
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Figure 2-46: Tracking and Tensioning Waste Conveyors Made 2016 or Later

Belt Tension
Adjustment

_ Loosen screws to slightly
angle roller to adjust tracking.
(Are also located on opposite side.)

Note: Incline Waste Conveyor made in 2016 or later are adjusted as shown here also.

Figure 2-47: Tracking and Tensioning for Waste Conveyors Made Through 2015

DRIVE SIDE

Ensure Drive Roller

at this end is in-line
b, /(stra|ght ) with the

gear reducer axis

Belt—"
Routing

=N Side-to-Side
_LI_JP/ Down—>"#8&  Tracking NON-DR!
ensioner

VE SIDE

If the Side-to-Side adjustment is not

enough or you need to fine tune,

adjust the Up/Down Tensioner shown

Locking in Figure 2-46. Move the non-drive side

Nut T down slightly. Do not adjust this roller
s too much or it will be in a bind and

/ gd{tUStment damage the roller. If more adjustment

(o}

Adjusting is needed, you can slightly adjust the
Nut drive side up.
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Replacing a Waste Conveyor Belt

The waste conveyor belt should be replaced about every 3 years, depending on use and
maintenance. Use the following steps as a guide for replacing the main or optional belt.

1. Run the waste conveyor until the lacing connection is near the head roller at the
drive end.

a) Inthe BLADE software, go to Diagnostics>Detailed
Diagnostics>Machine tab

b) Turn the waste conveyor on and off with the button by Waste Conveyor.

2. Turn off all power to the saw, following approved lockout/tagout procedures.

3. Remove the old belt by following these steps:

a) Relieve the tension on the belt using the tensioning bolts. See page MT-
125.

b) Remove the end washers (if present), then remove the wire that is
threaded through the lacing. Save the wire for reassembly.

¢) Remove the old belt.
4. Clean the sawdust and chips from the entire length of the metal conveyor bed.

5. Install a new belt by following these steps:

e

N | a) Thread the belt as shown in Figure 2-48, keeping the lacing connection
near the head roller.

To pull the new

belt through Figure 2-48: Path for Conveyor Belt
the machine approx.

more easily, 1-3/16"
thread the new {

belt to the old
one and pull it
through the
machine. This
will help thread

the belt into

the rollers on

the bottom. Belt New New
Roller #1 Roller #2
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b) Bring the belt together Figure 2-49: Connecting Wire on Belt
so the lacing
intermeshes, and slide Connecting wire —
the rod or wire through A
the lacing as shown in ‘
Figure 2-49.

Figure 2-50: Two Different
Connecting Wire Styles

6. Adjust the belt tension evenly at the head roller adjusting bolts. See Figure 2-45
on page MT-125.

7. Run the conveyor for at least five (5) minutes and check the belt tracking. If the
belt does not track correctly, follow the instructions on page MT-126.
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Powered Skewed Conveyor (optional equipment)

The Powered Skewed Conveyor is an option that replaces the outfeed table. It is a
powered conveyor that drives the lumber away from the saw’s outfeed chamber to be
offloaded or directed onto other conveyors. A separate VED controls the Powered Skewed
Conveyor, but no adjustments or maintenance should be needed on this VFD.

Aligning/Adjusting the Powered Skewed Conveyor

» The side skatewheel fence and adjustable side skatewheel assembly must be parallel
with each other. The gap should allow the exiting lumber to travel freely without
rubbing hard on either side.

8. Ifyour system has the optional Powered Skewed Conveyor, it is important that it
aligns perfectly with the outfeed assembly on the saw.

a) Check the alignment of the Powered Skewed Conveyor’s side guide:

¢ [t should measure 2-17/32” skatewheel to skatewheel.

* The skatewheels on the front side of the Powered Skewed Conveyor
(closest to the operator) should be even with and in-line with the tips of
the outfeed chain.

» The skatewheels on the back side of the Powered Skewed Conveyor
(the side farthest away from operator) must be slightly farther back
than the outfeed clamp rollers when retracted.

» Skewed conveyor rollers should be slightly lower than exit ramp roller
on the saw.
b) Ifneeded, adjust the Powered Skewed Conveyor side guide location:

* The short side of the Powered Skewed Conveyor fence is adjustable.
The long side is fixed.

* Depending on which option you have, adjust the short side to the right
depth and/or move the entire Powered Skewed Conveyor using the
slots in the feet.

Lubricating the Powered Skewed Conveyor

Lubricating Wheels

There are 2 drive wheels that drive the belts. Each of the drive wheels have 2 bearings
with grease fittings on them. Use a #2 lithium-based grease every 6 months. The non-
powered wheels that guide the belt require no lubrication. The conveyor rollers and
skatewheels on the Powered Skewed Conveyor require no lubrication.

001080 rev. A Maintenance
Original Instructions MT-130



MI BLADE™ Wood Processi-

MiTek’

Lubricating Motor & Gearbox

Grease is required once a year for the Powered Skewed Conveyor motor, located in
the center of the conveyor. Use #2 lithium-based grease.

The gearbox is sealed and requires no oil or oil changes. Do not remove the vent plug.

Adjusting Belt Tension on Powered Skewed Conveyor

The Powered Skewed Conveyor belt is driven by 2 drive wheels, both powered by the
same motor. The belt should be tensioned so it moves easily and smoothly without much
slack. To adjust the tension, refer to Figure 2-52 and these steps:

1. Loosen the 2 bolts holding the bearing on the frame.
2. Adjust the drive wheel in or out using the lag nuts on the tensioning bolt.

3. Re-tighten the 2 bolts.
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Figure 2-52: Tensioning Assembly for Powered Skewed Conveyor Belt

Adjusting Sheaves Supporting the Belt

If the belt tension seems correct, but the belt is not making consistent and smooth contact
with the rollers, adjust the sheaves that support the belt (located under the rollers) using
this procedure. The belt should make just enough contact to drive the rollers, but not be
too tight.

1. Determine which sheaves need to be raised or lowered.
2. Loosen the bolt in the middle of each sheave needing adjustment.

3. Adjust the location of each sheave in its slotted hole, then tighten each bolt.
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SECTION 3: PNEUMATICS & ELECTRICAL

Pneumatic System

A CAUTION

HIGH PRESSURE HAZARD.

To avoid injury, bleed all pressure from the lines
& before performing any maintenance on the pneumatic
3 components!

Pneumatic Components and Settings

The pneumatic system controls all of the components listed on page MT-134.

There are a minimum of 5 pneumatic regulators on this system. The main filter/regulator
manages incoming air from the air source, keeping it at the pressure needed for the
strongest pneumatic component on the system. It is the only regulator than needs to be
connected to an air source. Some components have their own regulator to further reduce
the pressure. See page MT-134 for the optimum pressure settings for each.

Figure 2-53: Location of Main Filter/Regulator and Cooler Filter
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The system pressure should be 110 psi.

Table 2-11: Overview of Pneumatic Components

The lowest pressure the saw can safely operate at is 75 psi.

Auto Deck Pushes each board onto thee load arms to system
Pusher be loaded onto the Infeed Rail. valve 3
Auto Deck Provides separation between two jobs on system
Lumber Stops Auto Deck conveyor. valve 7
Loads the lumber from the lumber feed system
Load Arms .
system onto the Infeed Rail. valve 5
Gripoer Clam Holds the end of the board as it is traveling system
PP P along the Infeed Rail. valve 2 110
Holds each board inside the saw chamber system
LASM Clamp and delivers each cut piece to the outfeed
clamp. valve 1
Touch Screen Keeps the touch screen enclosure at a
system
Enclosure Cooler | constant temperature.
D Provides a curtain of air at the infeed and system
Air Knives .
outfeed areas to contain dust. valve 8
i i side clam
Side Clamp Holds the lumber while entering the saw Y 30
chamber. valve 4 clamp
Too Clam Holds the lumber flat while entering the saw tob clam 110
P P chamber, applied pressure from the top. P P | unclamp
60
i iti outfeed clam
Outfeed Clamp Holds the lumber while exiting the saw p
chamber. valve 6 110
unclamp
Prints identification on board for each cut
piece using air powered print heads.
Printer SETTING THIS PRESSURE HIGHER printer 12
THAN RECOMMENDED WILL DAMAGE
THE PRINT HEADS!
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Replacing the Filter Element on the Main Regulator

A CAUTION

HIGH PRESSURE HAZARD.

To avoid injury, bleed all pressure from the lines
‘ before removing the filter guard.
& Ensure that the filter guard is securely attached to the

T regulator body before returning pressure to the lines.

All regulators for this system can be purchased directly from MiTek.

The main regulator has a filter element that must be replaced or cleaned every 6 months.
Refer to Figure 2-59 on page MT-140 to see the components of this assembly.
1. When replacing the filter Figure 2-54: Main Filter/Regulator
element, the system cannot be G
pressurized. Bleed the pressure
from all the lines and ensure the
gauge reads “0” before
unscrewing the filter guard.

2. Remove the bowl from the
regulator body by twisting
counterclockwise while pushing
up on the filter bowl. Then pull
down to remove the filter bowl
from the body.

3. Unscrew the filter element and
remove it from the regulator. Be
sure to keep the spring and any
other parts resting in the filter
element.

4. Place the spring (and any other parts removed) into the new filter element.
5. Screw the new filter element in its place.
6. Clean the bowl with mild soap and warm water.

7. Place the bowl back onto the regulator body by pushing up and turning clockwise.
Make sure it is securely attached before returning pressure to the lines.

' If the saw has a right-hand waste conveyor, the guard under the
{':\ filter may need to be removed to replace or clean the filter element.
?3‘1 Two (2) socket head cap screws hold the guard in place.
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Replacing Filter Element for Touch Screen Cooler

The touch screen enclosure cooler system uses the main regulator for system air pressure
but it has a secondary filter. The cooler’s filter element should be cleaned or replaced
every 6 months following these steps:

A CAUTION

FILTER ELEMENT BOWL MAY BE HOT!

Wear gloves or wait at least 10 minutes after locking
out power and air before unscrewing the filter element

bowl.
1. Lockout/tagout all saw systems Figure 2-55:
(pneumatic and electrical). Cooler Filter

2. Unscrew the filter element bowl.

3. Unscrew the filter element from the head.
4. Clean filter bowl with soapy water.
5. Clean or replace filter element:

a) Clean filter element with naphtha
and let dry before re-installing, OR

b) Install new element.

6. Screw the filter bowl back into to place
carefully to avoid stripping threads.
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Location of main
filter/regulator is
shown on page
MT-66.
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Adjusting the Overall System Pressure

The main regulator keeps the Figure 2-56: Main Pneumatic Regulator

system pressure correct. To
adjust the system pressure:

1.

Unlock the pressure
adjustment knob on
the Regulator by
pulling it straight up.

Turn the knob
clockwise to increase
pressure or
counterclockwise to
decrease pressure.

Once the ideal system
pressure is obtained,
push handle down to
lock in place.

'z See page MT-134 for pneumatic pressure settings.

Never exceed the recommended pressure settings.
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Draining Condensation & Sludge

At the bottom of the main regulator’s filter and the touch screen enclosure cooler’s filter is
a condensation reservoir. In healthy pneumatic lines, only a few drips a day should expel
from the lines. If excess water is gathering, investigate the reason for high condensation in
the lines.

Main Filter/Regulator

Open the valve shown in Figure 2-56 at the bottom of the reservoir every day to
release condensation. It requires a 1/4 turn to completely open. After moisture has
drained, close the drain and continue saw operation.

Filter for Touch Screen Enclosure Cooler

At the bottom of the main regulator’s filter and the touch screen enclosure cooler’s
filter is a condensation reservoir that automatically drains when needed. In healthy
pneumatic lines, only a few drips a day should expel from the lines. If water is pooling
on the floor, investigate the reason for high condensation in the lines.

Water in the pneumatic system can cause significant
damage to cylinders, valves, and the print head.
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Temperature Setting

The touch screen enclosure has a
cooler to ensure a healthy
environment for the touch screen
computer. The cooler kicks on when
the thermostat located inside the
touch screen enclosure indicates
that the interior of the enclosure is
above the set point. The set point
can be adjusted using the dial at the
thermostat. It should be set between
85-90 degrees Fahrenheit.

Figure 2-58: Thermostat Inside the

Touch Screen Enclosure

Figure 2-57: Cooler on
Outside of Touch Screen
Enclosure
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Adjusting the Main Pressure Switch

The pressure switch labeled in Figure 2-59 prevents the system from operating with
inadequate air pressure. It sets the pressure at which the saw will no longer operate
because it will not have enough pressure to perform its tasks. If the pressure drops below
the minimum requirement, determine and fix the issue before attempting to cut boards.

'_ If the system pressure drops below 75 psi, an error will
{ﬁ appear on the saw’s operator interface and the saw won’t
operate until the problem has been resolved.

The pressure switch should not need to be adjusted under normal circumstances. However,
knowing how to adjust this setting may assist in troubleshooting. Minor adjustments can
be made using an Allen wrench in the hole pointed out in Figure 2-59.

Figure 2-59: Pressure Switch Adjustment on Main Filter/Regulator

=g

NEHS SN {:,
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Printer System Relief Valve

The printer’s pneumatic system has a non-adjustable relief valve set at 15 psi. It is located
on the front of the saw with the printer supplies.

The regulator that affects the printer system’s pressure is located next to the relief valve.
See page MT-134 for the maximum setting allowed. Exceeding this recommended setting
will damage the print heads.

Figure 2-60: Printer Relief Valve
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Air Knives Figure 2-61: Air Knife Inside Saw Chamber

Air knives provide a curtain of air at
the infeed and outfeed areas to
contain dust.

Additional Pneumatic
Maintenance

If a regulator is not operating at its
optimum capacity, we recommend
cleaning the regulator and replacing
the O-rings, gaskets, diaphragm,
and valve assembly. You can order
a service kit including these
preventive maintenance parts from
the manufacturer.
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Using the Pull-Cord

A properly tensioned pull-cord will trip the E-stop switch when someone pulls it to
approximately 1 in. from its rest position.

Resetting the Pull-Cord Switch

Once a cable is pulled, the red light on the pull-cord switch that was activated illuminates.
Reset the E-stop circuit by pressing the pull-cord Reset button. The pull-cord Reset button
is labeled in Figure 2-62. The reset action must occur at the same switch that was
activated.

Adjusting the Pull-Cord Tension

To align the perimeter safety cable tension, turn the adjusting nut until the switch is
centered in the switch alignment indicator.

Figure 2-62: Pull-Cord Switch Overview

llluminates

When Reset

is Needed " g
(if equipped) Switch

Alignment

Indicator

If saw will not operate,
the switch may need to be re-aligned!

fﬂ After resetting the pull-cord switch, the RESET button on the operator
w-},‘k interface panel must also be pressed before the saw will operate.
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Main Electrical Enclosure

The major electrical components located in the top half of the main electrical enclosure are
shown in Figure 2-63.

Figure 2-63: Electrical Components in Top Half of Main Electrical Enclosure

PLC is located in the bottom half of the main electrical enclosure (not shown here).

Table 2-12: Cross-Reference for Figure 2-63

Safety Motion Sensor

VFD for saw blade

Motor Starter Overloads
Braking Resistor Overload
Main Disconnect Fuses
Terminal Block Fuses
Branch Circuit Protection for Servo Motors
Class J Fuses

Servo Amplifiers

VFD-2, for Waste Conveyor
VFED-4, for Outfeed Chain

O O|IN[O|O|Rh|WIN|~

—_
o

-_—
-_—
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See page MT-162
for more

information on the
E-stop module.

See page OP-107
in the Operation
Manual to see the
location of
E-stops and other
safety devices.
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Understanding the Safety Features/Circuits

Understanding the Safety Relay and E-Stop Circuit
This section is valuable for any person responsible for operating or maintaining the

equipment to better understand the safety features and functionality. It is absolutely
necessary for maintenance personnel to read and understand this section.

LEDs

The Power LED is on when 24VDC power has been applied to the E-stop module.
(Al & A2)

Figure 2-64: E-Stop Module Indicators, in Ready State

13 83 X1 12 X3 4 37 47| Power (GREEN)- llluminates when power on

AL snsizsse] T T 1 Start (GREEN) -  Hluminates when $33-534 Is closed

® Pover CH1 IN (GREEN) - llluminates when channel | input Is dosed
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Inputs

INPUT channels (CH1 IN and CH2 IN) are the input circuits that monitor the E-stop
circuit for CLOSED/OPEN circuit path.

The Blade saw is considered a dual-channel E-stop circuit because it monitors 2
independent circuits on its input channels, and is consider a redundant self-checking
safety circuit. When the power supply is switched on and the emergency stop,
feedback, and reset circuits are closed, the unit is ready for operation.
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When ALL E-stops are clear (Normally

1 _s02
Closed contacts are closed) current travels == = =
from S11 to S12 for Channel #1 and from S22 !
to S21 for Channel 2. The internal safety 501

circuitry confirms that both channels are 50| 503 S04

continuously conducting a signal. The power
flow of each input channel energizes the

associated LED and once the E-stop module
is ready will also energize the internal relay gE3 o $2 £

coils K1 & K2. l_C)J l_(:)]

Figure 2-65 shows how the channel of
normally closed contacts of all the E-stops complete the circuit path to turn on the
LEDs and the relay coils K1(CH1) and K2(CH2).

Figure 2-65: E-Stop Circuit
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<—— E-Stop Pushbuttons <€———

In monitored reset mode, the reset circuit is interrogated each time the unit is switched
on. If the reset contact is closed prior to an E-stop or power on, the E-stop module
cannot enter into the “ready state”. This means the E-stop module requires the RESET
PB to be open and inputs clear before you can reset/start the E-stop module.

001080 rev. A Maintenance
Original Instructions MT-146



MI BLADE™ Wood Processi-

MiTek

Figure 2-66: E-Stop Module Indicators, in Monitored Reset Mode
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Once the inputs channels are clear (no E-stops) and both CH1 IN & CH2 IN LEDs are
on when the reset button is pressed the START LED will turn on. If the feedback
circuit is closed, CH1 & CH2 will turn on and the corresponding relays will be
energized. Once the Reset PB is released, the START LED will be off and the system
is ready for operation.

Figure 2-67: E-Stop Module Light Pattern When in READY STATE
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The E-stop module will energize the safety relays only if the feedback circuit is also
closed.

Specific information on safety while the interlocked saw chamber
‘C%:l door is open can be found on page OP-114 in the Operation Manual.
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Feedback Circuit

Devices Monitored and Their Relationship

The feedback circuit assures the system that all devices monitored are in their “Safe
State” before allowing the E-stop module to be in its Ready State.

The Chart below lists all the devices that are being monitored by the feedback circuit.
If any of these device contacts are OPENED, then the E-stop module cannot be ready.
If you are trying to reset the E-stop module and it will not reset, troubleshoot the most
obvious first, check and make sure the Saw & Stroke doors are closed and the Safety
switches are NOT physically unlocked. Any of these following conditions will
prevent the E-stop module from resetting.

Figure 2-68: Devices Monitored by the Safety Circuit

Device Monitored .I;e;:onse
Servo Power Contactor Immediate
Infeed Power Contactor Immediate
Conveyor Power Contactor Immediate
Waste Conveyor Contactor Immediate
Incline Conveyor Contactor Immediate
Outfeed Chain Contactor Immediate
AXIS_6 Bevel Contactor Immediate
AXIS_5 Angle Contactor Immediate
AXIS_4 Stroke Contactor Immediate
AXIS_3 Elevation Contactor Immediate
AXIS_2 LASM Contactor Immediate
AXIS_1 G Contactor Immediate
VFD Power Contactor Delayed
Saw Blade Contactor Delayed
Saw Chamber Door Closed Switch
Stroke Chamber Door Closed Switch
Immediate E-stop Aux Contact
Timed E-stop Aux Contact
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Output Function of E-Stop Module

Once you understand the required inputs necessary to put the E-stop module into
“Ready State” you are now ready to review the output functions of the E-stop module
and the function of the Safety Circuit SR 1 and SR 2 and how they work together to
create an immediate and a controlled stop of the Blade saw components.

SR 1 is the Delayed Module. When the system is ready for operation, CH1 & CH2
relays are energized and the contacts of 13-14, 23-24, 37-38, 47-48 close and 55-56
open. When an E-stop is actuated there are 2 different stop conditions, Immediate and
Delayed. The Delay should be set to the maximum setting @ 10 seconds.

Figure 2-69: Inmediate and Delayed Circuits
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Delayed
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001080 rev. A Maintenance

Original Instructions MT-149



MI BLADE™ Wood Processing -

MiTek’

Immediate Module

The immediate contacts open as soon as an E-stop condition exists. The 2 immediate
contacts control SR_2, which controls all the devices & functions we want to shut
down immediately upon an E-stop condition.
The immediate devices include:

* K2 Waste/Incline/Outfeed Power Contactor

* K3 Infeed Power Contactor

» K4 Servo Power Contactor

* LT 1 E-stop Engaged Light

* LT 2 Reset Light
The immediate functions include breaking the signal to the Skewed Conveyor VFD
circuit, alerting the PLC of E-stop condition, alerting the Saw Blade VDF of E-stop

condition, disabling the Servo Control Enable circuits, and preparing the Safety
Feedback Loop for a RESET.

Delayed Module

Figure 2-70: Controlled Stop is Active
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The Delayed contacts are what we are going to consider as the Controlled Stop
Function. When an E-stop condition happens, the delayed contacts will hold their
current state for the time set by the E-stop module and let the controlled devices and
functions come to a controlled stop.

On the Blade Saw, there is only one function, and that is the control of stopping the
saw blade. The device contactors MS 1 and K1 need to stay engaged while the signal
to the VFD alerts the VFD to start its Emergency stop routine built inside the VFD
parameters. Once the time of the delay has elapsed, the E-stop module will open/close
all the delayed contacts and the safety feedback loop will be ready for a reset of the E-
stop module.
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Understanding the Door Lock Safety Circuit

The door safety switches are electromagnetic devices for guard locking. They provide
protective guarding of dangerous movable axis and motion on the saw. When the door is
shut, the actuator is automatically locked into the safety switch. The control system will
allow the operator to open the door as long as the machine is in a safe state and there is
power to the machine.

Figure 2-71: Door Switch Actuator Stages

1]
Actunior
Actuator ksarted 11| Removed
Locked Unlocked
| '-I e "T"-:T-_:' -'l -
TR PR

When the actuator is LOCKED within the Safety Switch, the 2 safety contacts (21-22) and
(41-42) are closed allowing power to flow through the circuit that is attached to these two
closed contacts. Looking at the physical cam itself in Figure 2-71, the locking pin of the
solenoid is up in the cam, as shown in the diagram labeled Locked.

Figure 2-72: Door Switch Circuits Shown Locked and Unlocked
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When someone physically unlocks the switch or the control system unlocks the switch,
notice how the contacts respond as well as the physical cam. The locking pin of the
solenoid is pulled down and out of the cam. See picture “Unlocked”. Safety contacts (21-
22) and (41-42) are opened and contact (33-34) is now closed which tells the control
system the door is UNLOCKED. Notice also the Door Closed contact is still closed
because the actuator is still in the switch body.
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When the physical door is opened, the Figure 2-73: Door Switch Control
actuator is removed from the switch

and the Door Closed signal is now =
open, telling the control system that - e =
. . = 3 C32 ']

the physical door of the machine has & = = =
been opened.

. . — e 4 )
Figure 2-72 shows the electrical = : o = -

. o 4 =18 I

representation of the control inside 54 g3 [: ol E‘
the safety switch that will connect to CES = N P ]
the safety monitoring relay and the

control system. The “Door Closed”
circuit of both the Saw Chamber and
the Stroke Chamber safety switches are embedded into the Feedback Circuit on the main
safety level. Review the section Understanding the Safety Relay and E-Stop Circuit
starting on page MT-145 for further information on the Main Safety level.

The Door Unlocked circuit of both the Saw Chamber and the Stroke Chamber safety
switch is sent to the PLC control system that also monitors the state of the doors. They are
hardwired to the Safety Monitoring Relays (SR4 and SR5) which is another safety device
that interlocks the Servos and the VFD Enable (Saw Blade) circuit.

Figure 2-74 shows the circuit of the safety module and how the safety door switch safety
contacts are wired into the relay, the internal function of the relay, and the power path for
the green LEDs on the module to turn ON. Notice how the redundant circuit works that
both Safety Contacts “Locked” must be closed for the internal relays to energize. The
Safety Monitoring Relay also watches the timing of both circuits. The maximum delay of
circuit S12 before S13 is 300mS. If S13 circuit closes after the max delay, one or NONE of
the LEDs will be on. The door must then be opened and re-shut to automatically re-test the
circuit.

Figure 2-74: Safety Monitoring Relay Circuit
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When both K1 (IN1) and K2 (IN2) LEDs are ON, the circuit is valid and the door is
closed. The Safety Monitoring Relay will then close its safety contacts. (13-14), (23-24),
and (33-34).

Figure 2-75: E-Stop Module Assembly

J -

E-stop Module

E-stop Module
Extension

Saw Chamber
Door Switch

| <€— Stroke/Elevation Chamber
Door Switch

The Saw Chamber Safety Relay SR4A has an Expansion Unit that it also controls SR4B.
When the door is closed, the contact (33-34) from SR4A becomes the input to SR4B and
the IN1 & IN2 channels are then valid and the LEDs will turn ON. The Stroke Chamber
Safety Relay is SR5 and works exactly like SR4A.

The circuit of both the Saw Chamber and the Stroke Chamber Safety Monitoring Relay is
embedded into the main circuit on the main safety level and completes the interlock of the
Servo Enable and VFD Enable (Saw Blade) power sections.

The Drawing below represents ALL the Safety Contacts from all the different safety
relays that must be valid before a function is capable of operating. This covers all safety
relays on the Blade Saw except SR3, which is the motion detection of the spinning blade.

When these safety input channel lights on ON, the corresponding Normally Open contacts
are closed and the Normally Closed contacts are open.
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Figure 2-76: Safety Contact Control
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PLC (Programmable Logic Controlier)

What the PLC Controls

The PLC is the brain between the mechanics and the electronics. LED lights display the
active inputs and outputs. Among other things, it provides the following:

* Motion module

* Error recognition

* Error logging

* Communication method for sensors

* Remote capabilities

* Communication with printer

+ Safety features

'_ The PLC still has power when the E-stop circuit is tripped
{ﬁ because the bottom half of the main enclosure is not part of
the E-stop circuit.

Operating and Maintaining the PLC

The PLC downloads the PLC software to the PLC’s memory each time power is restored
to the PLC. A battery may be present in the PLC, but it is not used.

Figure 2-77: Bottom Half of Main Electrical Enclosure
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Troubleshooting Tips for the PLC

If the PLC is not communicating with the saw, check the PLC rack for the presence of
power. It is most likely that the 24 VDC power supply (PS 2) is not operational or the
output is shorted to ground.

If there is power there will be many LEDs lit throughout the PLC rack.

f,,,\_ The “Power” light located on the left end of the PLC rack may still be

"w-:_l lit even though a full 24 VDC is not present. If the PLC rack does not
have multiple LEDs lit then a full 24 VDC is not present.

1. Test the power supply:
a) Disconnect (with main disconnect off) the positive output of the power
supply.
b) Test (with main disconnect on) the output of the power supply

» [f24 VDC is not present the power supply is not operational (assuming
input AC power is present)

» 1f24 VDC is present then look for shorts in the wiring.
2. Check fuse FU 25, and replace if it is blown.
3. Test the sensors:

Since this power supply also is used for sensors on the machine it is possible a
sensor or its cabling is shorted. Unplug sensors one at a time until the PLC rack is
powered again.

',A‘ If the PLC problem is software related, contact MiTek

w-zﬁl Customer Service for the latest software version.
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Safety Motion Sensor

Understanding the Safety Motion Sensor

The safety motion sensor measures when the blade motion has stopped. It reads EMF
feedback on the 3-phase line to monitor movement. After the saw is installed or the Safety
Motion Sensor is replaced, a tamper-proof seal should be placed over the 2 pot switches
shown in Figure 2-78 to ensure the safety of the system remains intact.

Two separate channels are utilized to measure when there is “zero”” motion present. Both
channels must recognize “zero” speed at or close to the same time before the interlocked
doors are released.

' “Zero” speed, as defined by the safety motion sensor, is the amount of allowable
.,(:\ movement determined by the sensor settings. The safety motion sensor was set
}"}k to the most sensitive level during manufacturing. Never change this setting.

A CAUTION

NEVER TOUCH A MOVING SAW BLADE!

The saw blade may still have slight coasting motion
when the interlocked doors are allowed to open.

The safety motion sensor and a definition of the LED lights are shown in Figure 2-78. All
4 LED lights should be lit when the motor is a “zero” speed.

Figure 2-78: Safety Motion Sensor in Top of Main Enclosure

A1/A2: Supply voltage present on terminals
Ch.1: Zero speed detected by channel 1
Ch. 2: Zero speed detected by channel 2

Zero Speed: Zero speed detected by both
channels within the time scope.

Potentiometer (Pot) Switches

WARNING: Do NOT adjust the pot
switches unless replacing a module!
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Replacing the Safety Motion Sensor

If the safety motion sensor must be replaced, follow these instructions and the electrical
schematic carefully.

How It Works

When the motor is started, the internal relays K1 and K2 immediately drop in voltage,
and open the output terminals 13-14 and close the output terminals 21-22.

When the motor is turned off and is coasting to a stop, it generates a residual voltage
which is proportional to the motor speed. It is measured at the motor winding with the
highest number of windings and then monitored by the input terminals Z1-Z2 and
73-72. When the motor speed decreases and the voltage generated in the motor
windings fall below the threshold value, both internal relays pick up, close the output
circuit between terminals 13-14 and at the same time open the output circuit between
terminals 21-22. The solid state output terminals Y43-Y44 switches and indicates
motor zero speed.

If LED # 4 is not ON, the system will not know that the blade was stopped properly.
This is a safety function and must be set properly anytime a safety motion sensor is
installed.

Installing the Safety Motion Sensor

1. Remove the damaged safety motion sensor from the main electrical enclosure. Its
location is shown on page MT-144.

2. Install the new safety motion sensor into the main electrical enclosure.

3. Connect the windings of the motor to terminals Z1, Z2, and Z3. Z1 and Z3 are the
input terminals, so they must receive the same information from the motor, at the
same time.

A  WARNING

Adjust the safety motion sensor’s sensitivity level
e before powering up saw.

See page MT-159.
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Setting the Sensitivity Level of the Safety Motion Sensor

The potentiometer (pot) switches shown in Figure 2-78 on page MT-157 adjust the
sensitivity of the safety motion sensor, defining “zero” speed.

Turning the potentiometers to the:

",,C\ » Far left (counterclockwise) puts sensitivity at its maximum
}"}g (10mV), which puts “zero” speed movement at its minimum.

» Far right (clockwise) places sensitivity at its minimum (100mV)
which allows more movement at “zero” speed.

1. Check the minimum sensitivity by turning both potentiometer switches (shown on
page MT-157) to the far right and verify that LEDs 1, 2, and 3 are lit.

a) If the lights are not on, reset the wiring using these steps:

1) Remove the 24 VDC power from the safety motion module at
Terminals A1/A2 on the BLADE saw as shown in Figure 2-79.

Pulling the terminal block switch bypasses the safety
motion module. Only 1 operator is allowed in the
restricted zone while the switch is pulled.

2) Run the saw blade and let it coast to a stop and ensure that all 3
lights come on.

Figure 2-79: Removing Power Using the Terminal Block Switch

) |
l!L

Pull orange switch
out to remove
power from the

safety motion module,

b) Ifthe lights are on, continue to next step.

2. Check the maximum sensitivity by turning both potentiometer switches (shown
on page MT-157) to the far left, at their most sensitive setting.

3. Run the saw motor, then let it coast to a stop while someone is watching the safety
motion sensor LED lights.
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4. Both channels (LEDs labeled Ch. 1 and Ch. 2) must turn on at the same time
(<1 second of time difference).

* Ifboth lights do not turn on within 1 sec. of each other, go back to step 1a.

* Ifboth lights turn on within 1 sec. of each other, continue to the next step.

5. After the adjustment process is complete, close the terminal block switch shown
in Figure 2-79 and allow the safety motion sensor to power up.

6. Place the tamper-proof seal that was shipped with the safety motion module over
the potentiometer switches to ensure nobody adjusts them.

/A  WARNING

CUT HAZARD.

Do not change the sensitivity settings of the safety
motion sensor (pot switches) after it has been

installed and adjusted properly.
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Troubleshooting Tips for Safety Motion Sensor

If either one of the channels on the safety motion sensor do not come on, try these
troubleshooting tips:

1. Shut down the safety motion sensor and restart it. This may solve the problem.
2. If the problem persists, the blade motor cable may be faulty. To determine this:

a) Inspect the blade motor cable for nicks in the insulation that may have
resulted in damaged wires.

b) Wiggle the cable while watching the safety motion sensor. It may cause
the channel light to illuminate.

¢) Use a meter to measure power at the leads.

If any of these steps provides evidence that the blade motor cable is faulty, replace
the cable. It may be necessary to perform these steps several times if the problem
appears intermittently.

3. Check SR 3. If it powers up without CH1 or CH2 lit, the problem lies with the
motor or power cable.

4. If the blade motor cable appears to be working, have a qualified electrician
troubleshoot the entire system.

A  WARNING

Never attempt to override a safety feature!

» il
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E-Stop Module

The E-stop module monitors the
E-Stop circuit for CLOSED/OPEN
circuit paths. It is located in the
bottom half of the main electrical
enclosure.

The system monitors two
independent circuits on its input
channels. When the power supply
switch is on and the E-stop,
feedback, and reset circuits are
closed, the unit is ready for
operation.

In monitored reset mode, the reset
circuit is interrogated each time
the unit is switched on. If the reset
contact is closed prior to an E-stop
or power on, the module cannot
enter into the Ready State. This
means the module requires the
RESET pushbutton to be open and
inputs clear before you can reset/
start the module.

Figure 2-80: E-Stop Module LEDs
Showing Channel Circuit is Valid

nKa 0MTE
Circuit 3113_1:::

is valid

when lit.

CH1 IN

CH2 IN

I-TI-B!ESE;

K ¥/

Once the inputs channels are clear (no E-stops) and both CH1 IN and CH2 IN LEDs are
on, the START LED will turn on while the reset button is pressed. If the feedback circuit is
closed, CHI & CH2 will turn on and the corresponding relays will be energized. Once the
RESET pushbutton is released, the START LED will be off and the system is ready for

operation.

When an E-stop is actuated there are 2 different stop conditions, Immediate and Delayed.
The Delay should be set to the maximum setting of 10 seconds.

For more detailed information on the E-stop module and its circuit, refer to page MT-145
which will provide further explanation of the text just discussed.
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VFD Figure 2-81:
(Variable Frequency Drive) Primary VFD

Understanding VFDs
A VFD (variable frequency drive) is a type of motor
_*_»’H. controller that drives an electric motor by varying the
ol frequency and voltage supplied to the electric motor.

The location of . . . . oo
the VFD is shown A VFD is one of the first links in the electrical circuit,

on page MT-144. so verifying voltage in and out of the affected VFD is
always a good first step in an electrical troubleshooting
process.

This machine has a primary VFD and various
additional VFDs to control specific components.
Refer to your electrical drawings.

Setting VFD Parameters

Contact MiTek Machinery Division before attempting to reset any setting.

All errors will be reflected on the saw’s touch screen so there is no need for an operator to
monitor the VFD.

/A  WARNING

Do not change VFD settings unless instructed by a
MiTek representative. Serious electrical hazards may
exist.

Replacing a VFD (Variable Frequency Drive)

The VFD must be ordered through MiTek because it needs to be programmed before it can
be used.
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?_ Overloads

For cleaning dust MOtOI’ Starter Overloads

out of overloads,
see page MT-70. Motor starters turn motors on and off. Overloads are usually mounted to the output side of

Failure to follow the motor starter and act as safety switches.
these guidelines

may result in

damage to the Why Motor Starter Overloads Trip
contacts.

The air temperature around the saw should never exceed 110°F. In high ambient
temperatures, the motors are unable to dissipate heat effectively. When the
temperature of the motor windings exceeds a preset value, the motor overload will
automatically shut down the motor to prevent it from burning up. Do not make any
adjustments to the motor starter overload settings.

Resetting Motor Starter Overloads

If the overload trips occasionally, it is not a problem and can easily be reset. See
Figure 2-82 when resetting a motor starter overload. If frequent overload trips occur,
there may be a serious problem with the motor or electrical system. A qualified
electrician should determine and correct the problem.

Figure 2-82: Resetting a Tripped Motor Starter Overload

Red switch is on
“0” when overload
is tripped and “1”
when working.

To manually test
that reset is working, | |reset button to
push red switch over [} |reset a tripped
to “0”.

{{Do NOT change
the settingon [
these dials.

Pressmg red
button while
motor is running
stops motor.

Blue dial should
remain on “H” for
manual mode.
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Braking Resistor Overload for Saw Blade

Dynamic braking resistors are used on AC variable frequency drives (VFD's) to dissipate
energy that is produced in the motor as the drive provides braking torque to stop the motor.

If the overload trips occasionally, it is not a problem and can easily be reset. See Figure 2-
83 when resetting a tripped braking resistor overload. If frequent overload trips occur,
there may be a serious problem with the electrical system. A qualified electrician should
determine and correct the problem.

EE Figure 2-83: Resetting a Tripped Braking Resistor Overload

Yellow flag appears when
overload is tripped.

See the location
of this overload
on page MT-165

RED DIAL:
Push in to reset.
Leave setting on “M-O”
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Securing the Profinet Module

The Profinet module is used to communicate from the PLC to the VFDs. It is located in
the main electrical enclosure and must be secured properly to avoid component damage.
Failing to secure the Profinet Module may cause it to overheat and shut down the saw.
Follow Figure 2-84 to locate the screw and screw hole.

Figure 2-84: Profinet Module

Profinet
Module

BACKPLANE

Screw hole
in backplane.

Screw hole with cover.
Punch out cover
to access hole.

Inputs

The inputs shown in Figure 2-85 are
in the bottom half of the main
electrical enclosure. A jumper is
required between Input 1/5 and 1/6.

Figure 2-85: Jumper
Between Inputs 1/5-1/6

001080 rev. A
Original Instructions

Maintenance
MT-166



MI BLADE™ Wood Proces_

MiTek’
Fuses

Main Disconnect Fuses (3-Phase Power)

The fuses located at the saw’s point of incoming 3-phase power in the main electrical
enclosure are shown in Figure 2-86.

Figure 2-86: Main Disconnect Fuses on Saw

The Auto Deck staging conveyor has its own disconnect switch, but the fuse protection is
handled inside the saw’s main electrical enclosure with the same fuses used by the saw
(shown in Figure 2-86). The Auto Deck’s main enclosure is shown in Figure 2-87.

Figure 2-87: Auto Deck Disconnect Fuses

i ' I.h;. . _jl_l‘_'_l_n-il"l' i'_' ﬂ"l'*
oo 'L (Ema Llf- m..l =
2 o | e |

*

i

Sl=sidavd.
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Terminal Block Fuses

Some terminal blocks have fuses on top of them. To replace the fuse, pull out on the fuse
box circled in Figure 2-88. Remove and replace the fuse, then push the fuse box back onto
the terminal block.

Figure 2-88: Fuse on Top of Terminal Block (view from side)

Branch Circuit Protection for Servo Motors

Each servo motor has a branch circuit protection fuse. See Figure 2-89 to replace the
fuses.

Figure 2-89: Replacing a Servo Branch Circuit Fuse

1. Pull down black bar to open circuit.
Red markings turn green to indicate it is safe to remove.

2. Turn black knob counterclockwise.
Fuse pops out of assembly.
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Class J Fuses

To replace the fuse in a class J fuse, pull out on the black box assembly (several are shown
in Figure 2-90). The fuse comes out with the black box assembly. Replace the fuse and
push the black box assembly back into place.

Figure 2-90: Safety-J Fuses

Printer Fuse

To replace a printer fuse:

1. Turn the knob circled in Figure 2-91 and pull out the fuse holder to remove a
faulty fuse.

2. Replace the fuse and re-insert the fuse holder.

Figure 2-91: Fuse on Control Unit

AUX HEAD A

ENC/TRIGGER ECHO AUX 1/0

Amplifier Fuse

Spare amplifier fuses are supplied with the installation package when the saw is first
installed. Additional fuses can be ordered from MiTek. If the amplifier needs to be reset,
pull fuse FU10 out, wait 10 seconds, then push it back in.

001080 rev. A Maintenance
Original Instructions MT-169



Refer to...

This procedure
corresponds to
SB214. The parts
can be ordered in
SB214KIT.

MI BLADE™ Wood Processin-

MiTek’

Replacing the Blade Motor Cable

1. After performing lockout/ Figure 2-92: Junction Box in the Stroke/
tagout, disconnect the Elevation Chamber (on newer saws)
blade motor cable from
the junction box inside the
stroke/elevation chamber
in this way:

a) Locate the blade
motor cable terminal
points in the junction
box. Newer saws look
like Figure 2-92.

b) Note and record the
terminal label and
wire label at each
terminal point. The
terminal points should
be labeled 1T1, 1T2,
and 1T3, plus the
ground wire. If they
are not labeled, label
them in a way that
will be useful when
installing the new
cable.

Inside of Junction Box

¢) Loosen the 2 clamps near the junction box that hold all wires routed through
the stroke cylinder.

d) Disconnect all 4 wires in the blade motor cable from the junction box.

fﬁ Do NOT remove the blade motor cable yet. It will be
&}1 used to snake the new cable later in this procedure.
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2. From the saw chamber, remove the blue guard shown in Figure 2-93, at the back
of the saw blade assembly, so the grommet can be accessed.

3. Loosen the screws holding the grommet and the clamp (if present) shown in
Figure 2-93.

Figure 2-93: Remove Guard and Loosen Screws (in Saw Chamber)

Overhead View

Remove

1,

Guard

2 Screws F'

for Guard X

y { -

R " T 3
emove = -
This VN >

4. Inspect the clamp that is labeled in Figure 2-93

+ Ifaclamp is not present or it is damaged, install a clamp as shown in Figure 2-
93.
» Ifa clamp is present and undamaged, proceed to the next step.
Figure 2-94: Overview
(70 cm)

= B 3 ¢ N\ E

N
T Blade Motor
Socket

| ¢ 26-1/2in. 3 |

To Junction Box

Colored Section Marking Spring
Clamp Location

Maintenance
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5. Place the protective
covering and spring onto
the cable using these steps:

a)

b)

d)

Pull the covering apart
enough to fit the cable
into it, then let the
covering wrap back
around the cable.

Thread the junction-
box end of the new
cable through the
supplied spring, and
pull the spring along
the length of the cable/
protective covering
until it reaches the
blade motor socket and
is seated in the groove
shown in Figure 2-96.

Add a cable tie, near
the narrow end of the
spring to hold the

Figure 2-95: Cable Assembly

Protective Covering
(shown in orange)

protective covering in place.

On the opposite end, the protective covering should extend just past the
colored section marking the clamp location. The clamp will hold it in place on

that end.

Figure 2-96: Spring Installed on Blade Motor Socket

w34 in. radius

(740" Crriy 111 i

1st loop of spring seats in groove.
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The socket and
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in the close-up
photo in

Figure 2-96.
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6. Install the blade motor cable by following these steps. Ensure there is no twist in
the cable at each step. This part of the procedure is easier with two people.

a) Use the existing blade motor cable to snake a wire using these steps:

1) From the stroke/elevation chamber, connect the junction-box end of the
existing blade motor cable (disconnected from junction box on page 170)
to a snake wire.

2) From the saw chamber, disconnect the existing blade motor cable from
the blade motor by unscrewing the retaining ring and pulling the socket
out.

Figure 2-97: Connection Point at Saw Blade Motor

3) Also from the saw chamber, pull the existing (old) blade motor cable
toward the front of the saw until the snake wire begins passing through
the grommet.

4) Still in the saw chamber, disconnect the existing (old) blade motor cable
from the snake wire, while ensuring the snake wire does not pull back
through the grommet. Discard the old blade motor cable.

b) From the saw chamber, plug the new blade motor cable’s socket into the blade
motor:

1) Align the keys in the blade motor socket with the motor plug, and push
into place.

2) Screw the retaining ring down until it is tight. It should bottom out on the
rubber seal on the matting. Pliers may be required to tighten correctly.

¢) Use the snake wire to pull the new blade motor cable through the grommet to
the junction box using these steps:

1) From the saw chamber, attach the junction-box end of the new blade
motor cable to the snake wire.

2) From the stroke/elevation chamber, pull the wire snake back toward the
junction box until the new blade motor cable is pulled through the
grommet.

3) Still in the stroke/elevation chamber, disconnect the blade motor cable
from the wire snake. Secure the cable so it doesn’t pull through. It will be
connected to the junction box in a later step.
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d) Secure the new cable with Figure 2-98: Routing of Motor Cable
the clamp using these

steps:

1) From the saw
chamber, straighten
the protective covering
so it is smooth and
covers the colored
section of the cable
that marks the clamp
location. It will 2 r "
provide additional = 2
protection from the ; %
clamp. The colored ; (_
section can still be felt extes past clamp.
under the protective . S~
covering.

2) Tighten the clamp 3
around the colored
section and protective
covering, ensuring
there is no twist in the
cable before or after
the clamp.

LY

e) Ensure the cable has a comfortable bend into the grommet, then tighten the
grommet. The bend should look like the overhead view in Figure 2-93. If the
bend is too tight or loose, push or pull more or less cable through the
grommet.

f) Ensure the cable is routed as shown in Figure 2-98.

g) Re-install the blue guard that was removed. It is shown on page 171.
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7. Once the cable is the correct length at the clamp and grommet, connect the other
end of the cable to the junction box in the stroke/elevation chamber using these
steps:

a) Access the junction box in the stroke/elevation chamber (shown in Figure 2-
92):
« From the left side of the saw, enter the stroke/elevation chamber OR

* For better accessibility, remove the blue cover on the back side of the saw.

b) Locate the free end of the blade motor cable that was threaded through the
grommet, and attach each conductor and the ground wire to the correct
termination point inside the junction box, as listed in Table 2-13.

*,,,\ If the terminals are not marked by MiTek, they should
2_1 have been marked as instructed in step b on page 170.

Table 2-13: Termination Points Inside Junction Box

Wire Label Termination Point Label
1T1 1T1

1T2 1T2

1T3 1T3

green/yellow ground green/yellow ground

c¢) Close the junction box and stroke/elevation chamber door.

d) Reinstall the back side cover, if it was removed.
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A  WARNING

Ensure all personnel are clear of machine before
operating.

Do not operate this equipment unless all guards and
safety devices are secure and in working order.

8. Remove the lockout/tagout devices, ensure all personnel are at a safe distance, and
test the stability of the new cable. Rotate the bevel axis from 0 to 180 degrees and
ensure the following:

a) The blade assembly moves back and forth freely and the cable nor any part of
it is interfering with the saw blade for entire 0-180 degrees rotation.

b) The cable has an adequate and smooth radius at the connector to avoid
crimping (approximately 3-4 in.).

c) The cable stays within the slot on the aluminum housing for entire 0-180
degrees rotation.

d) The quick disconnect connector points towards the back of the motor and
does not rotate when the bevel rotates. A slight movement is acceptable.

e) Ensure that the protective wrap is secure and not slipping.
9. Test the blade rotation:
a) Place the blade in home position.
b) Start the blade motor and ensure the blade is rotating toward the operator.

c) Ifitis rotating in the wrong direction, the wires are connected incorrectly in
the junction box. Connect them as shown in Table 2-13.

001080 rev. A Maintenance
Original Instructions MT-176



MI BLADE™ Wood Processing -

MiTek’

Saw Computer and Electrical System

A monitor, computer, hard drive, or any other electronic device
f,ﬁ‘_ must be purchased through MiTek. Proprietary software must
"w-z_ be downloaded by MiTek. MiTek can not support nor guarantee
any components purchased elsewhere.

Touch Screen Computer Warranty

The touch screen computer has a limited warranty through the original manufacturer. The
warranty instructions were provided in a separate document when the saw or latest
computer was purchased. MiTek purchased the computer and transfered the warranty to
the end user’s name (or company name) at the time of installation.

For computer operating system or hardware issues, your own Information Technology
department should be able to help.

Before calling the original manufacturer for technical help, gather the following
information:

* Service tag number

» Express service code

* Model name

* Model number

* Operating system

Replacing a Hard Drive

If you replace the computer’s hard drive or wipe it clean, all software specific to the saw
will need to be loaded again. Contact MiTek Machinery Division Customer Service to
download the necessary software and apply the existing license.
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Replacing the Computer

When a new computer is needed, it must be purchased through MiTek. Our technicians
will load the necessary software before shipping it. In addition to replacing the unit, refer
to the section starting on page MT-179 for renewing the software licenses.

To replace the touch screen computer:

1. Power down the touch screen computer and wood processing system. Instructions
are in the Operation Manual on page OP-134.

2. Open the back door of the touch screen enclosure.

3. Remove each cable from the
back of the touch screen
computer, making note of the
port location of each cable. Add
labels to the cables if necessary.

Figure 2-99: Remove the
Touch Screen Bracket Screws

4. Remove the damaged touch
screen computer from the
bracket, keeping all hardware.
See Figure 2-99.

5. Install the new touch screen
computer onto the bracket in the
same manner that the damaged
unit was removed, using the
existing hardware when
necessary.

6. Connect each cable to the new
touch screen computer in the
same manner as they were
connected to the damaged unit.
Note that port location and
labels may vary slightly on
touch screen computer
replacements.
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Software

Software Summary

The following software is used within this wood processing system to allow perfect
communication and integration.

Table 2-14: Summary of Software in Use

Software Physical Location
BLADE software Touch screen computer
Reports software Usually on office PC

Kepware™ software
(interface between BLADE software and PLC)

PLC software PLC
Board Stretcher optimizing software Usually on an office PC

Touch Screen computer,
Software for optional lumber retrieval system only on saws integrated with
lumber retrieval system

Touch screen computer

A number of things could cause one or more of the software licenses to require renewal or
re-download, including the following:

* Re-imaging the hard drive

» Upgrading to a new computer
* Changing the user name

* Changing the domain

* Changing the computer name

» Disconnecting the saw computer from the network or leaving it off for more than 21
days
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BLADE Software License

The BLADE software license does not expire. If a hard drive is wiped clean or replaced,
contact MiTek Machinery Customer Service for instructions on downloading the software
to your saw computer.

The license could be deactivated Figure 2-100: Screen at First Use of
for any of the reasons listed on Computer on a Domain
page MT-179. If this occurs, the S5 MiTek Software Licensing Wl et |
screen shown in Figure 2-100 I
appears when an active license for | Please enter your name and usage of MiTek
the BLADE software is not found. software.
When it appears, enter the I Name
required information and press |
NEXT. If no active license is Company
available, an error will be shown i
and you must call MiTek
Machinery Customer Service to ool bin 1ok MY molbamen 20
re-activate the software.
MTek Customer
For licensing or operator issues Customer Sponisored Engineer
with any of the software listed in independent Trainer
Table 2-14, contact MiTek [Tk Cortractor

Machinery Division Customer
Service. For licensing or software
issues with Windows or any [ Mews> || Concel
software supplied by the

computer manufacturer, contact

the computer manufacturer. See

page MT-177 for computer

warranty guidance.

PLC Software

Occasionally, a PLC software update may be needed. MiTek will notify you if this
becomes necessary and can upload it to the BLADE system using the eWON or web page.
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Kepware Software: Installing

Kepware software is the interface between the BLADE software and PLC software. If a
hard drive is wiped clean or replaced, the Kepware software can be downloaded from the
Kepware web site following these instructions. After installing the software, see page MT-
182 for activating the license.

EE This information was obtained from http://www.kepware.com.
1. Install from the Kepware Website

If the software is .
already Navigate your browser to www.kepware.com. If you have already created a My
downloaded, refer Kepware account, select My Kepware to login. Otherwise, select Sign Up to enter
to page MT-182 registration information. Upon completion, an email will be sent to the email
Itf’ activate the address that was provided. To verify your Kepware registration, click on the link
Icense. provided.
An emergency
use license is 2. Sign Into My Kepware
also described
there.

Enter your Email Address and Password. Then, click Login.
3. Choose a Product

Under Product Downloads, locate and select the product of interest.
4. Save the Installation File(s) to Your Computer

The File Download Security Warning dialog will be invoked. Click Save and then
browse to the folder in which the installation file(s) will be saved. Click Save to
proceed.
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If the software
needs to be
downloaded, refer
to the section
beginning on
page MT-179.

If the software is
present but not
active, use one of
these methods.
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Kepware Software: Licensing

There are several options for activating a license for Kepware software:

* Recommended activation process described on page MT-183. A valid Activation ID
is required for this option.

¢ Demo Mode active for 2 hours.

» Temporary license active for 7 days.

2-Hour Kepware
Demo Mode

Figure 2-101: Renewing the
Kepware Demo Mode

If the Kepware license is needed
at a time when renewing the
license is not possible, there is a
Demo Mode where a trial
license can be used for 2 hours
at a time. At the end of the 2-
hour period, the operator may
start the 2-hour period over

Configuration

Start Runtime Service

Stop Runtime Service

Reinitialize
Reset Event Log...

Settings...

again. This can continue for as

OPC UA Configuration
long as necessary.

Quick Client
To begin the Demo Mode License Uil
period, select Start Runtime ty
Service in the right-click menu Help

shown in Figure 2-101. To
extend the Demo Mode for an
additional 2 hours, select Stop Exit
Runtime Service, then select

Start Runtime Service again.

Support Information

Temporary Kepware License for Emergency Use

An Emergency ID is provided with each purchased permanent software license to be
used in the event of a PC/system failure occurring outside of standard business hours.
The emergency license can be activated through the licensing website from any
internet-enabled computer, and will allow the product to run for a period of 7 days.
The Emergency ID is a unique one-time use license: one must be used for each
product that requires emergency activation. After using an Emergency License, users
must contact Technical Support to discuss options for re-commissioning the
application.
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Activating KEPServerEX Software License

When the BLADE wood processing system was first purchased, an Activation ID was
assigned to the Kepware software. This ID helps Kepware track each license and
prevent it from being used on more than one computer at the same time. If a hard drive
is wiped clean or replaced, Kepware must reset the activation status of the Activation
ID so it can be used on the new hard drive. If a completely new computer is purchased
through MiTek, the license will be activated before it is shipped.

EE This information was obtained from http://www.kepware.com.
The following process is required for activating a software license.

Kepware may . . .
need to reset the 1. Open the License Utility on the Host Machine
status of the
Activation ID Start|Programs|Kepware| KEPServerEX 5|
before it can be
activated again License|License Utility (default installation path)
on an existing
computer. 2. Select Manage Software Licenses

Click Next to continue.
3. Select Activate a Product.
Click Next to continue.

4. 1In Create Activation Request File, enter the Activation ID, which is provided by
Kepware with a purchased product. Then, click Save to File...

5. Save the Request File

The License Utility will then display a file-browse dialog, allowing you to save
the generated request file, activation_request.txt. Save the file, making note of
its location. It will be sent to Kepware in the next step.

Important: An internet connection is required to activate a license. If the computer
that the activated license will run on does not have internet access, users must
copy the activation request file to a computer that does in order to log in to the
web-based license portal (and generate the activation response file).

6. Launch the License Management Tools

In an internet browser, navigate to https://my.kepware.com/mykepware/. This will
bring you to the My Kepware Portal. Returning users will be prompted to enter
login information, whereas first users must create a My Kepware Account to
continue.

7. Enter Registration and Activation Information
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Once logged in, select Product Registration and Activation under the License
Management Tools. Enter the registration and activation ID information, and then
browse for the Activation Request File that was previously saved. Upload the
request file and then click OK.

8. Save the Activation Response File

You will provided with a link to download an activation response file called
response.txt from Kepware. Save this file to the Host Machine and then return to
the Manage Software License Activation dialog in the License Utility.

9. Browse for the Activation Response File

Next, click the Import File button. Browse to and select the downloaded
activation response file. Then, click the Open button at which point the response
file will be processed.

10. Restart Runtime Service: The runtime service should be restarted after activating
a license to prevent the license from continuing to run in Demo mode. Access the
Runtime Service using the right-click menu shown in Figure 2-101 on page MT-
182

Note: On successful activation, the View Licenses Page will be displayed listing
the activated products.

KepServerEX5 Configuration

If using KepServerEX version 5, there may be an icon on the desktop or in Windows
system tray. This icon is only needed if a MiTek representative instructs you to access the
Kepware configuration program.

Figure 2-102: Opening Kepware Configuration Software

i Wi i
s v ?'\
1 ]

Kepware Configuration
Icon on Desktop

Windows®
System Tray

click [ to

see the tray.
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Specific Profile Changes on the Saw PC

Removing the Property Requiring a Keyboard

Certain profiles require that a keyboard be connected to start the saw. If receiving an error
stating that a keyboard must be connected, either connect a keyboard or change the profile
so it stops looking for a keyboard. To change the profile:

1. Plug in a keyboard to the Blade PC

2. When starting the computer press the F12 key to show a menu where the BIOS
can be accessed.

3. Use the down arrow key to highlight BIOS Setup and press Enter.
4. Use the down arrow key to select POST Behavior.

5. Use the right arrow key to expand POST Behavior.

6. Use the down arrow key to select Keyboard Errors.

7. Use the Tab key to select Enable Keyboard Error Detection.

8. Press Enter to uncheck Enable Keyboard Error Detection.

9. Press the Tab key to select Apply and press Enter.

10. Select Save or Save and Exit using the arrow keys and press Enter.

Removing the Property Requiring CTRL-ALT-DELETE

Some profiles require the Ctrl+Alt+Delete key sequence be used to log in which requires a
keyboard.

1. Swipe in from the right side of the screen to display the Search selection and
select.

2. Type in netplwiz and select the netplwiz with the graphic beside it.
3. Select the Advanced tab.

4. Deselect Require users to press Ctrl+Alt+Delete, and click OK.
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Networking eWON (Ethernet Switch)

It was recommended when the system was installed that two separate Ethernet lines be
installed: 1 for file access and 1 for remote maintenance. All of the networking
communication in this system goes through the eWON which acts as an hub so all
Ethernet devices can talk to each other. These include the PLC and the saw’s operator
interface. The eWON is located near the PLC in the bottom half of the main electrical
enclosure. It includes a remote maintenance feature referred to as Talk to M.

Figure 2-103: Ethernet Switch (eWON)

2016 Model Prior to 2016 Model

Connecting the eWON

Table 2-15: eWON Connection Descriptions

1 To touch screen computer To touch screen computer
2 To PLC CPU To PLC CPU
3 Ethernet switch VFD
4 Customer’s Ethernet Profinet PLC
Talk to M: Customer’s Ethernet
001080 rev. A Maintenance
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Resetting the e WON

All eWON data (IP address, parameters, etc.) can be erased by pressing and holding the
RESET button for more than 4 seconds (Firmware 6.0s3 or later). At this time, the User
LED stops blinking and becomes solid red.

Stopping in the Middle of the Reset

If the RESET button is accidentally held for more than 4 seconds, and the operator
notices the red LED turn solid red, DO NOT LET GO of the RESET button. While
continuing to hold the RESET button in, remove power from the eWON. The eWON
enter the Full Erase reset process.

After a Reset

If the eWON gets reset (also called “full erase”), the settings will need to be
reprogrammed. Contact MiTek Customer Service for assistance, and use the eWON
configuration tool called eBuddy to define the eWON working IP address.
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Sensors

Overview of Sensors

A complete list of sensors is found inTable 2-16. They are arranged in order of when they

enter the workflow. Photos are shown on subsequent pages.

Table 2-16: Overview of Sensors

Sensor Name Description Refer to...
Indicates that lumber is located at a position page MT-195
Board Sensor L
where the load arms will raise it on the next up
(Load Arms)
movement.
Load Arm Up Indicates when the load arms are up so lumber page MT-195
feed system will not advance.
Load Arm Down Indicates when the load arms are down so page MT-195
lumber feed system will advance.
Gripper Home Determines the position of the gripper during page MT-196
the homing process.
Board Slip Indicates if the board is tight against the gripper page MT-196
face.
Gripper Indicates the gripper is not clamped. page MT-196
Unclamped
Indicates there is a board present just behind page MT-195
the load arms by sensing the leading edge of
Auto Deck the board. When the Auto Deck Lumber Sensor
Lumber Sensor indicates a board is present, the system knows
to index the board when the load arms clear of
wood and are in the down position.
Auto Deck Pusher Indicates the state of the lumber pusher on the page MT-195
Extend/Retract Auto Deck (2 sensors).
Retracted=Home, Extended=Pushed
LASM Home Determines the position of the LASM during page MT-197
the homing process.
LASM Lockout Prevents saw blade from moving when LASM  page MT-197
is within sensor’s vision. Located on the
stationary portion of the LASM assembly at
the centerline of the saw blade. When LASM
block is within the sensor’s vision, the saw
blade will not move because of a collision risk,
unless overridden by software.
LASM Fully Indicates that the LASM clamp is fully clamped, page MT-197
Clamped meaning there is no board present.
LASM Unclamped Indicates when the LASM clamp is open. page MT-197
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Table 2-16: Overview of Sensors (Continued)

Sensor Name Description Refer to...
Bevel home Determines the position of the bevel during the page MT-197
homing process and that the bevel is close to
square.
Outfeed Fully Indicates when the outfeed clamp is fully page MT-197
Clamped clamped meaning there is no board present.
Outfeed Indicates the outfeed clamp is open. page MT-197
Unclamped
Crooked Lumber  Uses ultrasonic wavelengths to determine the  page MT-197
Sensor (CLS) location of the bottom of the board.
Leading Edge Works with the emitter sensor to determine the page MT-199
Receiver location of the leading edge of the board which
is used in the board length measurement
process.
Leading Edge See Leading Edge Receiver description. page MT-199
Emitter
Side Clamp Fully  Indicates when the side clamp is fully clamped page MT-199
Clamped meaning there is no board present.
Side Clamp Indicates when the side clamp on the infeed page MT-199
Unclamped side of saw is open.
-IC-)TSn%Zg]p Indicates when the top clamp is fully clamped page MT-199
(EP/TC Bottom) meaning there is no board present.
Top Clamp Indicates when the top clamp on the infeed page MT-199
Unclamped side of saw is up.
(EP/TC Top)
Top Clamp Indicates the top clamp is clamped on a board. page MT-199
Ski Sensor
Angle home Determines the position of the angle during the page MT-199
homing process.
Stroke home Determines the position of the stroke during page MT-199
the homing process and that the saw is in a
retracted position.
Elevation home Determines the position of the elevation during page MT-199
the homing process.
Saw Chamber Prevents saw chamber door from opening page OP-113
Safety Switch while blade is spinning.
Stroke Chamber  Prevents stroke/elevation chamber door from  page OP-113
Safety Switch opening while axes are moving.
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Sensor Gaps for Prox Switches (Home Sensors)

The home sensors are all inductive proximity switches, also called prox switches. All prox
switches should have an air gap between the sensor and the target of approximately 1/32”.

Troubleshooting Home Sensors

CLS troubleshooting can be found on page MT-192.

Checking Inspection Points
1. Check for obstructions interfering with the sensor.
2. Ensure all prox switches have 1/32” air gap.

3. Ensure dust and debris is not in the way of the sensor or target.

Checking Communication Between the PLC and Sensor
Check the PLC input module to determine if the sensor is communicating with the

PLC. The indicator light on the PLC should illuminate while the PLC is receiving data
from the sensor.

Resetting the System

Ensure “home” is correct by homing the axis or part in question. If “home” is not
correct, the axis will hit a hard stop.

001080 rev. A Maintenance
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Does the Home Sensor Have Power and Functionality?

1. For inductive proximity switches (Home sensors):

a) From the touch screen on the operator interface, select
Diagnostics>Detailed Diagnostics> any servo tab.

A CAUTION

CRUSH OR CUT HAZARD!

Use extreme caution and effective communication

' when a second person is in the restricted zone.

b) With one person watching the screen, have a second person place a
screwdriver or anything with a steel or iron surface in front of the sensor.

1) If the sensor has an LED light, it should illuminate when the
metal object is detected. If the light does not illuminate, there is
either no power to the sensor or the sensor is broken. Check the
wiring and points of power farther up the line to determine where
power transmission ends.

2) On the Detailed Diagnostics screen, the indicator next to the
Home Sensor field should turn blue while the metal object is
detected. If it does not, there is a communication issue.

2. For other sensors (not inductive proximity switches):

a) From the touch screen on the operator interface, select
Diagnostics>Detailed Diagnostics> any servo tab.

A CAUTION

CRUSH OR CUT HAZARD!

Use extreme caution and effective communication

' when a second person is in the restricted zone.

001080 rev. A Maintenance
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b) With one person watching the screen, have a second person watch the
sensor while the operator manipulates the saw so the sensor engages.

If the sensor has an LED light, it should illuminate when the sensor
engages. If the light does not illuminate, there is either no power to the
sensor or the sensor is broken. Check the wiring and points of power
farther up the line to determine where the power transmission ends.

3. Find the source of the problem and resolve:
a) Try substituting the cable that plugs into the junction box.

b) Try substituting the sensor with a sensor from spare parts, or a different
sensor on the saw, but only if they are identical sensors.

Adjusting & Troubleshooting the Crooked Lumber Sensor

The following instructions should be followed when:
 Parts are not accurate and the cause may be the elevation of the blade, OR

» The message Out of Range consistently displays in the CLS status menu (on the
Home Screen Toolbar).

CLS Positioning Figure 2-104: CLS

1. Move the LASM away from the CLS using
the indicator menu on the Home Screen. Top~>
Plate / -

@ Adjust
__infout

2. Remove top plate from CLS by removing
the two screws on top of the CLS housing.

3. Calibrate the CLS.

. Adjust
a) Go to Tools>Calibrate from the side-to-side

operator interface. and angle

b) Follow the on-screen instructions
and select Make Alignment Cut.

4. Lockout/tagout.

5. Drop a plumb bob over the board and down just above the bubble level. Make
sure the string from the plumb bob is in the newly cut slot in the board.

6. The sensor must be positioned so that it is centered on the blade, bubble level, and
the board. Use the bubble level and plumb bob as devices to achieve positioning
of the CLS. Figure 2-104 shows the adjustment screws on the CLS.
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Original Instructions MT-192



MI BLADE™ Wood Processing-

MiTek’

Determine if CLS is Working
1. Move the LASM away from the CLS so it doesn’t interfere with the test.

2. Place a straight 2x4x8 or longer on the Infeed Rail and slide it into the saw
chamber.

3. Unclamp and clamp the infeed and outfeed clamp (using indicator menus on
Home Screen) so the board is firmly clamped in both.

Straight 2x4x8 . . ] ] ]
or longer 4. Go to Diagnostics>Detailed Diagnostics>CLS tab.

5. Note the exact reading in the field circled in Figure 2-105.

6. Press the ACTIVATE button next to Calibrate. If the CLS is operating and
adjusted correctly, the following should be true:

a) The field labeled Current Reading in Figure 2-105 should change by .02
or less.

b) The field labeled Current Reading in Figure 2-105 should be near 0.

Figure 2-105: Diagnostics>Detailed Diagnostics>CLS Screen
[F— = ey TRy s R —

Clars (15 Angie Bawsl | Bwerton Grposr LASM  Stroke | Saw Siade Frivter | Machrs |Halp | Aotz Deck

Cirrgs (L5 Angle Bewsl | Besution Grppsr LASM Sooks Saw Biade Frivter Machirw PIC  Acts Dack

L. 1 s

¥
A
]

tﬁ A working CLS makes a constant clicking sound.
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Testing the Elevation and CLS Communication

1. Place a 2x4x6 or longer on the Infeed Rail and slide it into the saw chamber while
still holding onto the end sticking out of the saw chamber. Ensure it is covering
the CLS.

2. From the saw’s operator interface, go to Diagnostics>Detailed Diagnostics>CLS

Straight 2x4x6 and click the ENABLE button under Elevation Following.
or longer
3. Test the following steps and results:

a) Lift the infeed end of the lumber. It should result in the blade elevation
rising.

b) Set the lumber down in its original position. It should result in the blade
elevation lowering.

¢) The elevation status menu (on the Home Screen indicators) should
display Enabled Homed.

4. If the blade elevation moved as expected:

a) Wait for the blade elevation to settle (should not take more that 15
seconds). Once settled, monitor the blade elevation for 10 minutes.

b) During this period there should be no movement of the blade elevation. If
there is movement, then remove the wire connection (unscrew the metal
ring on the end of the cable at the sensor) from the bottom of the sensor.
Using high-quality, dry compressed air, blow out the connector on the
wire and on the sensor. Replace the wire on the sensor and repeat the test.
If the test continues to fail contact technical support.
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Figure 2-106: Sensors on Auto Deck and Infeed Rail

(Leading Edge
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on opposite side
of Infed Rail.)

Auto Deck
Lumber
Sensor

Leading Edge
Beam Receiver

Auto Deck Pusher
Extend/Retract

Gripper
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Figure 2-107: Sensors on Gripper
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Gripper Unclamped Sensor
{Located in slot on bottom of cylinder,)
Set so gripper “botfoms out” when unclamping.
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Figure 2-108: Sensors on Front Side
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Figure 2-109: LASM Clamp/Unclamp Sensors (Extend/Retract)

Concept shown here can be applied to all extend/retract sensors, but measurements can not.

LASM Fixed

Clamped ’
Jaw Assembly &

Sensor
(Extend)
LED light is on
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is active.

Unclamped
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(Retract)
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is active.

Bolts Holding LASM
Fixed Jaw Assembly
(quantity 2)
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Figure 2-110: Sensors in Stroke/Elevation Chamber & Infeed Side of Saw
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Troubles

Appendix A

Navigating the Troubleshooting Appendix

This appendix is divided into tables according to the system or components that are
showing troublesome symptoms. The tables are presented in the order listed here.

Be sure to read the safety and training sections beginning on page MT-202 prior to

performing any troubleshooting on the equipment.

Trouble Topic Page

Saw, Printer, Infeed Rail Troubleshooting page MT-205
Material Handling/Auto Deck Troubleshooting  page MT-214
Software Errors page MT-216
Indicators on Specific Electronic Devices page MT-225
Axis ldentification page MT-227

If you continue to have problems after performing all applicable troubleshooting steps and
reviewing the topic in the Maintenance chapter, call MiTek Machinery Division Customer

Service for assistance.
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Safety Notes for Troubleshooting

General Troubleshooting Safety Tips
A  WARNING

ELECTROCUTION, HIGH PRESSURE, CRUSH, CUT,
AND CHEMICAL HAZARDS!

Read all notes in this section AND the safety section
in the preliminary pages before operating or
maintaining this equipment.

Most solutions are described in more detail in the
Maintenance chapter and may have more safety notes
included there.

* Read all warnings located in the safety section in the preliminary pages and
adhere to them at all times.

* When the graphic at the left appears, lockout/tagout at the disconnect
switch located on the equipment using approved methods described in OSHA
29 CFR 1910.147 before continuing with the procedure or troubleshooting.

* Ifthe lockout/tagout graphic does not appear, it is recommended that you still
de-energize the machine unless energy is required for the troubleshooting
process. If it is absolutely necessary to troubleshoot an energized machine,
follow NFPA 70E for proper procedures and personal protective equipment.

* All electrical work must be performed by a licensed electrician.

* Read this manual for information and procedures related to the specific
maintenance or troubleshooting issue before attempting any maintenance!

» Safety goggles and a dust mask must be worn for all cleaning steps outlined in
this manual. When using cleaning and lubrication solutions, a respirator rated
for use with those solutions must be worn as well as gloves resistant to the
solution.
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Electrical Troubleshooting Safety Tips

* Make sure you have the proper tools needed for the job. See Tools Needed
on page 203.

* Ensure the person performing the troubleshooting is qualified from an
electrical knowledge standpoint. If you feel uncertain about troubleshooting
electrical power, remember that the cost of hiring an electrician far outweighs
the cost of an injury.

* Remove rings and watches that you are wearing. They are extremely
conductive material and may catch on small components.

* Get a helper. You are most likely going to need a third hand at some point, and
you shouldn’t perform electrical work without someone close by to help if you
get hurt.

* Be patient. Take your time and stay alert. Never shortcut or become too
confident in what you are doing; electrical power will always be stronger than
you.

* Take notes recording what you have checked, and what the readings were. This
is also a good way to check your work when you are finished. Sometimes, the
machine won't work because a wire was removed for testing, and overlooked
when cleaning up. Having proper notes will make the process go much more
smoothly.

* ALWAYS turn the power off if you are checking for ohms or swapping PLC
cards.

* ALWAYS push an E-stop button before approaching a machine for any
reason, but if you are working with the encoders it is especially important. An
interruption to a powered encoder may cause components to move without

warning.
* Wear appropriate personal protective equipment (PPE) for working with
live power.
001080 rev. A Troubleshooting

Original Instructions MT-202



MI BLADE™ Wood Processing -

MiTek’
Getting Started With Troubleshooting

Tools Needed

Gather these tools before beginning the troubleshooting process and before calling MiTek
for technical assistance.

1. Slotted screwdriver, insulated

2. Phillips screwdriver, insulated

3. Equipment manual and drawings, specifically electrical schematics
4. Pen and paper to take notes and document settings

5. Multimeter

A multimeter is an electronic measuring instrument. The analog versions were
referred to as an analog volt-ohm-meter (VOM). A newer, digital model is called a
digital-multi-meter (DMM). There are a large variety of volt-measuring devices
available, but at a minimum, it should have these features:

* Voltage (volts) measurement
* Resistance (ohms) measurement
* Ability to measure both AC and DC power

* Autoranging feature

It is highly beneficial to also have the ability to measure current (amps)
6. Various additional tools depending on specific parts needing repair

7. Personal protective equipment as dictated by NFPA 70e

Phase 1 Troubleshooting Steps

For Mechanical Troubleshooting

Always clean and lubricate the equipment as a first step in most troubleshooting
processes. Most mechanical malfunctions are caused by inadequate preventive
maintenance.

Look for barriers such as jammed wedges, parts rubbing, etc.

001080 rev. A Troubleshooting
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For Electrical Troubleshooting

1. Lockout/tagout at the disconnect switch located on the equipment.

Never use compressed air inside the electrical
enclosures! It may force contaminates into the
electrical connections.

Use a vacuum to remove dust from electrical
enclosures. Canned air is acceptable after vacuuming.

2. Vacuum and dust the electrical enclosure.

3. Remove the lockout/tagout equipment and attempt to run the machine again. If
that didn’t fix the problem, proceed with the next step.

4. Adhere to all regulations and guidelines given in NFPA 70e and in your
company’s energy control program. Some important safety tips are also addressed
on page 202.

A  WARNING

ELECTROCUTION HAZARD!

All electrical work must be performed by a licensed
electrician.

If it is absolutely necessary to troubleshoot an
energized machine, follow appropriate guidelines.

5. Look for a tripped overload if it applies.

6. Determine where the electrical problem begins. To do this, you need a multimeter.
If you are unfamiliar with your multimeter, consult the manufacturer's manual.

* Determine if you are working with AC (alternating current) or DC (direct
current) before checking for voltage. Your multimeter should measure both, but
you’ll have to tell it which one to measure.

* Measure incoming and outgoing voltage to specific components. Proceed along
a logical order determined by your machine’s specific problem, and write down
the order that you check each item and the amount of voltage that it registers.

001080 rev. A Troubleshooting
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Symptoms and Solutions

Saw, Printer, Infeed Rail

Table A-1: Saw, Printer, Infeed Rail Troubleshooting

My saw keeps
shutting off saying that

Make sure that you have followed the pneumatic guidelines in
the Prior to Installation chapter.

Ensure the main regulator is set correctly and the saw is
consistently receiving between 75-110 psi.

IN-28

MT-137

Air .
I don't have enough | The pressure switch should be set to 75 psi. It can be adjusted,
air pressure. but never operate the saw with less than 75 psi.
Replace pressure switch, regulator, or seals in filter/regulator
assembly.
My condition matches | Pull out the FU10 fuse, wait 10 seconds, and push in. The FU10
all of the following: fuse is a terminal block fuse in the top half of the main electrical
o enclosure.
A servo amplifier has
the ALM LED on.
A servo has a Low
Amp voltage on DC Link
error on the PC.
The Caution High
Voltage red LED in the
upper left of an
amplifier is not on
when others are.
My condition matches | Three phase power to the contactors above the amplifiers is
all of the following: missing. Check 3-phase connections and FU9 fuses for
o continuity. Fuse 9 is on the top row of fuses in the main
ALL servo amplifiers electrical enclosure
have the ALM LED on. ure-
One or more servos
Amp have a Low voltage on

DC Link error on PC.

The Caution High
Voltage red LED in the
upper left of the
amplifiers is not on.
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Table A-1: Saw, Printer, Infeed Rail Troubleshooting (Continued)

Blow off the equipment (not inside electrical enclosures).
Look for mechanical barriers such as wedges, fallen tools, parts
rubbing or blocking each other.
All An axis is not moving | Lubricate the areas in question as directed in this manual. MT-72
Check for a tripped overload. MT-164
Check servo amplifiers in main enclosure: check for power MT-144
(red LED), cable connections, power supply,
Sensor is not working | Refer to page MT-203 for a systematic troubleshooting MT-203
or component procedure.
All controlled by a sensor
is not responding
properly
My straight cuts come | Run auto calibration on the angle and elevation. OP-160
Anale out the correct length,
9 but my angled parts
are off.
No board was Ensure the correct length was entered.
detecteq during the Check that board is in gripper properly. Troubleshoot reasons MT-108
measuring process. why not
Board or | |ndicates the Leading . . . .
Length Edge Detector Sensor ch?;lz?;ei r?n[r)ipel; ranr(l Iitrisaw measure again, checking that OP-160
Issue didn't get activated. gripper properly.
Try adjusting the Leading Edge Sensor (emitter or receiver) in
Tools>Options>Saw>Edge Detector Beam Sensor. It measures
from center of beam sensor to center of blade.
Measure board.
Board in the machine Check that board is in gripper properly. Troubleshoot reasons MT-108
. why not.
Board or | is too short.
Length Indicates the Leading bC:grbdrz?:-:‘ir?r?ipe:rangleetrlsaw measure again, checking that OP-160
Issue Edge Detector Sensor gripper property.
didn't get activated. Try adjusting the Leading Edge Sensor (emitter or receiver) in
Tools>Options>Saw>Edge Detector Beam Sensor. It measures
from center of beam sensor to center of blade.
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Table A-1: Saw, Printer, Infeed Rail Troubleshooting (Continued)

Problem
Category | Problem Possible Cause & Solution See Page
or Part
Check the gripper home position by running auto-calibration. OP-160
1. Before the next board is run during a job, measure and
record the length of the next board to be cut.
2. Calibrate the Gripper home position and re-cut the OP-160
My screen says that “board” using a new piece of lumber. If the problem is
Board or | the stock lumber is too not resolved...
Length short, but | measure 3. Make sure that the Actual Length field corresponds with
Issue the lumber and itis the measured length. If the numbers don't correspond,
correct length. change the Edge Detector Photo Eye value in
Tools>Options>Saw by the amount the board
measures off.
4. |If the board measures short, decrease the
measurement for the sensor position.
My straight cuts come | Cut a type 2 part with a 45 degree angle from the Key In Parts | OP-89
out the correct length, | screen. Adjust the elevation up if short by amount that you are
Board or | but my angled parts short and vice versa.
Length are off. The actual Check the angle calibration and recalibrate if necessary. OP-160
Issue angle is not what the
screen is telling me |
should have.
The air pressure should be the same as line pressure. Check MT-134
The last part of my that the regulator is set correctly and the saw is receiving
Board or . . .
Length board is always short | approximately 100-110 psi.
Issue but t_he bladg was Replace the LASM teeth if showing wear. MT-113
making a trailing cut
Check the LASM inches per count through auto-calibration OP-160
Check the last part on the board. There should be a mark from | MT-108
where the gripper clamped onto the board if the end of the MT-109
Board or | The length for the last | Poard was cut square. If there is any indication of the board MT-134
Length part on my board is slipping (Ex. A long scrape mark), the gripper clamp pressure
Issue wrong. may need to be increased.
The gripper home position is incorrect. Auto-calibrate the OP-160
gripper.
Verify the gripper and LASM home positions and inches per OP-160
Board or | | am getting random count by running auto-calibration.
Length lengths off by 1/8" up | The gripper or LASM may be slipping. Check that the regulator | MT-134
Issue to 1" is set correctly. MT-137
Replace the LASM teeth if showing wear. MT-113
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Table A-1: Saw, Printer, Infeed Rail Troubleshooting (Continued)

Problem
Category | Problem Possible Cause & Solution See Page
or Part
Check for obstructions.
Check system pressure (main regulator) and secondary MT-134
regulator for clamp to ensure correct air pressure.
Check the shock absorber and tighten or replace as needed. MT-103
Infeed side or top Determine if coils are working by checking LEDs on coils as you
Clamps clamp is not working. | ¢/amp and unclamp.
Fully Clamped Sensor may be activated too early if not
positioned correctly. Reposition the sensor.
Linear guide bearings may not be properly working. Check MT-89
lubrication and physical condition of bearing block and rails.
Replace bearing block if uncertain of age.
Getting frequent Check that the LASM Max Position is set to 12 inches (305 mm)
Collision | messages that saw or higher.
blade V}’”' contact Check that LASM is aligned properly: Notch in center of LASM
LASM in Auto Mode. | should align with saw blade when LASM is at 0 position.
o . Ensure Infeed Rail finger is in the same plane (straight with) the
Cuts Getting inconsistently | | ASM fixed jaw for the Infeed Rail’s entire length.
inaccurate cuts
CLS is not working; bowed lumber is inaccurately cut.
. Blow dust out of sensor with canned air and check cable
E-Stop Pull cord activates connections.
itself or will not reset
Check alignment (centering) of pull-cord switch. MT-143
cWON The eWON red User | All communications data on the eWON has been reset because MT-186
light is a solid red. the RESET button was held in for more than 4 seconds.
My parts are off The belt has jumped a cog on the pulley. Calibrate the gripper. | OP-160
Gripper | roughly 3/8 of aninch | The white gripper timing belt may be set too loose. Re-tension | MT-85
consistently. the belt.
Ensure the gripper is not hitting the infeed side clamp.
The gripper is hitting The air pressure on the infeed roller might be set too high. MT-134
Gripper an obstruction when Verify it is at the recommended setting.

none can be seen.

If none of the above steps help, then manually move the gripper | MT-108
to find tight spots in the belt.
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Table A-1: Saw, Printer, Infeed Rail Troubleshooting (Continued)

When the gripper Check the gripper home position, counts per inch, and OP-160
goes back to accept maximum position by running auto-calibration.
the maximum length
Gripper board the gripper
jams. (Or the wood
lands on top of the
gripper assembly.)

Check error state of gripper.
Gripper won’t move

Gripper manually.

Move it using the touch screen in Manual Mode.

Wood may be bowed.

Try to move it manually. If it doesn't move check the Status
Indicator on the Toolbar for clues.

Check for obstructions or mechanical binding.
Gripper | Gripper won't move. | Bjow off the Infeed Rail.

Linear guide bearings may not be properly working. Check MT-89
lubrication and physical condition of bearing block and rails.
Replace bearing block if uncertain of age.

Check the tension of the white gripper timing belt, and ensure | MT-84

the gripper motor coupling is not loose. MT-81
MT-78

If problem still exists, calibrate gripper. OP-160
If needed:

Gripper Home sensor 1. Remove the white gripper timing belt.

air gap is too big.

Gripper 2. Check linear bearings to ensure the entire assembly is
Receiving home Z not sagging.

pulse errors.
Remove the screws holding the gripper to the bearings.

4. Add thread adhesive (Loctite) and install the screws
back in place.

5. Adjust gripper home sensor air gap to 1/32".
Calibrate gripper again.
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Table A-1: Saw, Printer, Infeed Rail Troubleshooting (Continued)

Problem
Category | Problem Possible Cause & Solution See Page
or Part
May occasionally occur and is no need for alarm.
If happening often or consistently with a certain length, calibrate | OP-160
gripper.
The board is not If still happening, check that gripper is physically retracting far
Gripper against the gripper enough. If not, adjust it in Tools>Options>Clearance to Accept
Gripper is not clamping tightly:
1. Check the air pressure. MT-134
2. Check tightness of gripper assembly parts. MT-109
Saw blade cut through | Call Customer Service for further instructions before restarting | INTRO-54
LASM . .
the LASM jaw. anything.
LASM LASM unclamp timing | Check position of the extend and retract sensor. Tighten all MT-198
out. bolts.
Lumber Lumber clips the saw | Infeed Rail lumber surface is below the entrance ramp. Level
Feeding entrance ramp the Infeed Rail to the saw.
Lumber Lumber not entering Ensure Infeed Rail finger is in the same plane (straight with) the
Feeding |saw chamber straight. | LASM fixed jaw for the Infeed Rail’s entire length.
Lumber catching on Tighten the Auto Deck chain tension. MT-107
Lumber load arms and not
Feeding |feeding onto Infeed
Rail correctly.
Check for obstructions
Check the servo power (PWR) cable. Re-check all servo
. connections to ensure both screws are on and that the
Abnormally highmotor | connector is not loose at install.
Motors current. To reset this ]
(Servo) error the saw power | Check the cable: If the.encoder cable is not gonnected to the
must be cycled. servo motor, the LED light on the amplifier will not be on.
On angle axis, can use the spare servo motor in the spare parts
kit until the replacement is sent. The angle axis is the only servo
motor with an internal brake
Check that the Auto/Manual switch is in the correct position.
Op Button or field is Read the status banner on the touch screen for clues to the OP-133
Interface | grayed out saw’s status. If the solution is not clear from the status banner
text, perform the procedure on the page indicated here.
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Should you lockout/tagout to /s
safely perform this action?

Table A-1: Saw, Printer, Infeed Rail Troubleshooting (Continued)

Problem
Category | Problem Possible Cause & Solution See Page
or Part
Click on red indicator and notice if bottom menu item says
Enabled Not Homed or Enabled Homed. After homing the
o system, it should say Enabled Homed. If not, investigate
Op Some indicators are . o :
obstructions, lubrication, and other mechanical reasons.
Interface |red
Click CLEAR ERRORS on Toolbar.
Click HOME SYSTEM on Toolbar.
Op Visualize screen is not | Open Diagnostics>Visualize screen prior to pressing the
Interface | working. START CUTTING button.
Check to see if START CUTTING button has yellow banner
Lumber is not feeding | "eading AIR CUT across it. If so, go to Diagnostics menu and
Op after pressing START | remove the check mark next to Air Cut.
Interface
CUTTING. Check for Auto Deck errors, specifically if Load Arm Lumber MT-195
sensor is detecting board.
Op Keyboard needed to Cert’aln customgr profiles could require a keyb.oard to use the MT-185
saw’s operator interface. The solution is explained on the page
Interface | startup or logon. .
listed here.
Op Saw is in Waiting for Select Abor't Cutt'lng Sequenge on th_e Dlagnostlcs_ r|bb'on..
. . Do NOT adjust trigger status in Detailed Diagnostics—it will
Interface | Printer Trigger state. L
cause the printing sequence to be out of order.
Outfeed Outfeed chain is Look for broken bolts or plastic obstructing the chain.
utfee -
binding. Check chain tension. MT-117
Short Wedges may be stuck between the two outfeed rollers.
Remove and retry.
Adjust the outfeed clamping roller sensor.
Align and/or tighten the lumber exit chain.
, If the problem persists, the following tips will help further
l'am gett!ng an troubleshooting:
Outfeed outfeed timeout
failure. 1. When a board is clamped, the lights on both sensors
(extend and retract) should be off.
2. When the clamping rollers are at full extend (without
wood), the light on the extend sensor should be on.
3.  When the clamping rollers are fully retracted only the
retract sensor light should be on.
Powered Tighten belt tension MT-130
Rollers are slow to
Skewed
reach full speed
Conveyor
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Should you lockout/tagout to ||
safely perform this action?

Table A-1: Saw, Printer, Infeed Rail Troubleshooting (Continued)

May happen if the printer trigger state is changed in Detailed
: . Diagnostics. For now, abort cutting sequence and start the job
. Cutting sequence is . . ) ;
Printer out of order over at the right place. To prevent in future: When you receive
’ the saw status Waiting for Printer Trigger, use the Abort Cutting
Sequence button on Diagnostics ribbon.
Upgrade Java to latest version.
Java exception error | Determine if 32-bit or 64-bit software is needed. Check both at
Remote . ; )
when trying to run the following web address:
Help Talk2M (remote help)
P) | http://wiki.ewon.biz/Support/06_Knowledge_Base/
Questions_and_Answers/Talk2M_connection_checker
Safety motion sensor Inspect blade motor cable for physical damage.
Safety channels are not both | Complete safety motion sensor setup procedure given on the MT-157
lighting up. page indicated.
The PC is having Check power supply and cabling, including all connections.
trouble
Saw C .
communicating with
the saw (PLC).
Saw Head Saw blade is Replace with a sharp blade MT-97
unusually hot
Check that the housing and bracket are in good condition to
protect the CLS and keep it in place.
Check that the CLS cable is securely connected.
Sensor CLS not working Check the CLS positioning. MT-192
Check that CLS is receiving power and sensor is working MT-193
(check positioning first).
Check that the CLS and elevation are communicating. MT-194
. Adjust the in/out adjustment bolts to prevent the encoder from
Sensor Error: Loss of encoder : :
making contact with the coupler.
Sensor is not working | Refer to the systematic troubleshooting procedure.
or component Troubleshoot the Auto Deck sensors, specifically, ensure the
Sensor controlled by a sensor ; :
. . Load Arm Lumber sensor is detecting the board.
is not responding
properly
Sensor Component timing out. | Check location of extend and retract sensors.

001080 rev. A

Original Instructions

Troubleshooting
MT-212



redir.aspx?C=KgoaS-F9Dkyv1IGGHnWPmCj3AMV7INEIlce5EFnD3AkaHHkqRmA1JVX7RWr_0_k-AZyiiZIZiTc.&URL=http%3a%2f%2fwiki.ewon.biz%2fSupport%2f06_Knowledge_Base%2fQuestions_and_Answers%2fTalk2M_connection_checker

BLADE™ Wood Proce_

Table A-1: Saw, Printer, Infeed Rail Troubleshooting (Continued)

Calibrate. OP-160
Stroke Stroke error Stroke travel may be bottoming out. Set minimum position to
1.25 in Detailed Diagnostics screen.
May need to upload drivers again.
User Touch screen is May need a firmware update.
Interface responding .
unpredictably. Could be caused by a Windows update. May consider turning
off Windows Updates in the Control Panel.
Waste Waste conveyor not Check for tripped overload. MT-164
Conveyor moving or not moving Check around edges and ends of belt for wedges or debris.

smoothly
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Material Handling
Table A-2: Material Handling/Auto Deck Troubleshooting

Should you lockout/tagout to
safely perform this action?

Problem Possible Cause & Solution See Page
Auto Auto Deck is running | Your motor is wired incorrectly.
Deck in the wrong direction. | gelector switch on Auto Deck operator interface panel is wrong.
Auto Deck is not Adjust the location of the Auto Deck Board sensor. MT-195
Auto advancing the board for sensor
Deck correctly onto the load location
arms.
Auto Deck load arms | Adjust the entire square tube that holds the load arms by
Auto are not moving down | loosening the hex nut.
Deck far enough to accept
lumber.
Auto Auto Deck is not Check the Auto Deck s varl_able frequency drive (VFD) for
Deck running errors. The VFD is located in the control panel on the Auto
Deck. Check the wires from the motor to the VFD.
The Auto Deck may be overcrowded. Remove excess boards.
Auto Mqre tlhan 1 board E Adjust the Auto Deck Board sensor position. MT-195
Deck being loaded onto the
Infeed Rail at a time. | Use the lumber stops to limit the number of boards being OP-157
indexed.
Auto Dec Getting error from Conveyor chain may be tensioned too tight. MT-107
Auto Deck VFD.
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Printer
Table A-3: Printer Troubleshooting

BLADE " Wood Processing S-

Should you lockout/tagout to
safely perform this action?

Problem Possible Cause & Solution See Page
Select a message to print using Board Stretcher software.
No printout and no Ensure there is text (or graphic) in the message chosen. Refer
) clicking sound heard | to the Board Stretcher manual.
Printer from head during Ensure the control unit’'s power switch is on and that it is on in OP-100
printout. the BLADE software.
Ensure print head cable is connected.
No printout or poor Ensure hose from ink bottle is connected and ink bottle is full. OP-181
printout quality but Check hose for blockage.
Printer clicking sound is Ink pressure should be 0.4 - 0.8 bar.
heard from head Dot size must be within acceptable range. OP-101
during printout. Clean or replace ink filter.
Check ink supply, clean nozzle, purge and flush, and check OP-168
Printer Print head won't print | ¢logs in line.
Check gripper encoder and cable.
My printing has a
Printer blfank Ilne_thrc?ugh the Flush and clean the printers. OP-176
middle of it. It's not
printing properly
The encoder LEDs
Printer stay lit even when the | This is normal if the controller was powered down from the

controller is powered
down.

touch screen computer. It is not a problem.

001080 rev. A

Original Instructions

Troubleshooting

MT-215



BLADE " Wood Processing S-

Software Errors

Table A-4: Errors in Software

Should you lockout/tagout to /|
safely perform this action?

Error Code Text on Screen Definition or Solution
AutoDeck Adjust the Auto Deck board sensor (for load arms) and check
Board not on sensor .
Error002 connections
Indicates the Auto Deck pusher is not working. It may be
caused by:
+ Damaged Auto Deck Pusher Extend/Retract sensor is
é;‘rfr%ggk Air cylinder out of position damaged or location needs to be adjusted
* Mechanical obstruction
* Inspect for other reasons the pusher is not retracted
when it should be
Indicates the Auto Deck Pusher Retract (for 004) or Extend (for
005) sensor is not working. It may be caused by:
AutoDeck Pusher home position (or + Sensor is damaged or location needs to be adjusted
Error004 or pushed position) sensor not ) .
Error005 seen * Mechanical obstruction
* Inspect for other reasons the sensor may not be
working
Pusher is not getting off the Auto Deck Pusher Retract (for 006)
or Extend (for 007) sensor soon enough. It may be caused by:
AutoDeck Pusher failed to move from ]
Error006 or home position (or from pushed *  Low air supply pressure
Erro007 position) «  Air valve coil is damaged
*  Mechanical obstruction
Pusher is not on either the Auto Deck Pusher Retract nor the
Extend sensor. It may be caused by:
AutoDeck Invalid air cylinder sensor * Sensor is damaged or location needs to be adjusted
Error008 condition «  Mechanical obstruction
* Inspect for other reasons the sensor may not be
working
AutoDeck C Auto Deck Lumber sensor did not trip after chains ran during
No board after initialize o
Error010 initialization. Replace sensor.
é?rfrDO?;;k No board after stage Check operation of Auto Deck Lumber sensor.
AutoDeck ) ) .
Time out during load Check operation of Auto Deck Lumber sensor.
Error013
AutoDeck Command other than initialize .
. Clear errors and restart the cutting process.
Error014 received
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Table A-4: Errors in Software

Should you lockout/tagout to /|
safely perform this action?

Error Code Text on Screen Definition or Solution
AutoDeck Corqmand other than stage Clear errors and restart the cutting process.
Error015 received
CalError . Check air supply to saw, air regulator setting, and pressure
General001 No Air Pressure switch setting. Clean pneumatic filter.
Stroke Home sensor is not sensing that the stroke completely
retracted. Inspect the Stroke Home sensor for:
CalError Saw Not Retracted + Damage or location needs to be adjusted
General002
* Mechanical obstruction
+ The need to reset home offset and calibrate the stroke

CrookedLumb Check connection to CLS sensor.
erSensor Unsteady output ) )
Error002 Check CLS alignment and bracket location.
CrookedLumb
erSensor Out of range Calibrate CLS, and check temperature probe.
Error003

Moving this servo axis while
DGNO0001 the saw strpke 's extended Retract the stroke.

may result in damage to the

saw. Do you want to continue?

The saw blade may contact

I

DGNO0002 the LASM! Damage t‘.) the saw Verify clearance of LASM and move LASM to safe position.

may result. Do you wish to

continue?

The saw motor may contact

the LASM because the LASM
DGNO0003 jaw is open! Damage to the Verify clearance of LASM and move LASM to safe position.

saw may result. Do you wish

to continue?

Maximum number of retries
ENG0029 occurred while sgndlng {0} on Check connections at print controller/Moxa converter.

Com {1} to the printer

controller.

. When clamping on the board, the Gripper Unclamped sensor is
GripperClamp | . :
Error002 Time out clamping not uncovered after 2 seconds. Check board feeding and

gripper mechanics.

. When unclamping, the Gripper Unclamped sensor is not
GripperClamp Ti | . fter 2 heck feedi .
Error003 ime out unclamping covered after 2 seconds. Check board feeding and gripper

mechanics.
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Table A-4: Errors in Software

Should you lockout/tagout to /|
safely perform this action?

Error Code Text on Screen Definition or Solution
The board is not against the
gripper face. Before selecting
Retry, the board must be
against the gripper face.
Perform the following steps
before executing Retry:
GripperClamp | 1- Switch to Manual mode Follow instructions in message. If problem happens frequently,
Error004 2. On the status bar select observe the load process to determine where the issue is.
Clamps - Unclamp All
3. Push the board back
against the gripper
4. Switch to Auto mode
5. Select Retry
The board in the machine is
InfeedRail too short. Select Continue to | Check the board is the required length.
Error002 continue cutting or Stop to end | If so, calibrate the gripper.
the cutting process.
InfeedRail No board was detected during | Verify that the correct length board was loaded. If so, observe
Error003 the measuring process. the loading process to determine the loading issue.
The end of the board
uncovered the board beam
sensor at a different location | T reset the
than the stored position. This | EngSawConstants.GripperStoredCalibrationCheckCount
most likely means the gripper | o an initialized value of -1, one of the following operations
servo axis is out of calibration. | heeds to happen:
Click Ignore to ignore this .
message or Stop Cutting to +  Click the STOP button on the error message.
InfeedRail end the cutting process at the « Calibrate Gripper Home Offset
Error004 end of the current board.

Stopping the cutting process
will reset the stored position to
the new position. It is
recommended that the cutting
in process be stopped and the
gripper Home Position
calibration be checked by
using:
Tools>Calibration>Gripper.

+ Calibrate Gripper Home Offset and Counts Per Inch
calibration

« Calibrate All Home Position

Once the stored value is set to -1, the next time the end of the
board uncovers the thru-beam sensor while cutting, the saw
computer will set this position as the new stored value.
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Table A-4: Errors in Software

Should you lockout/tagout to /|
safely perform this action?

Error Code Text on Screen Definition or Solution
Check air supply to saw, air regulator setting, and pressure
switch setting. Clean pneumatic filter.
LasmClamp Timed out clamping LASM Unclamped sensor is damaged or location needs to be
Error002 .
adjusted
Check for mechanical obstruction.
LasmClam When clamping on the board, the Gripper Unclamped sensor is
Error003 P Timed out unclamping not uncovered after 2 seconds. Check board feeding and
gripper mechanics.
The LASM clamped all the way closed when it was expected to
LasmClamp . ) e
Unexpected full clamp clamp onto lumber. Determine why board is not feeding into
Error004
saw chamber properly.
LoadArmError | Timeout moving up while on The load arms have been told to move up, but they never came
gup off the Load Arm Down sensor. Check signal to air cylinders
002 down sensor .
and couplings to load arms.
LoadArmError The load arms never saw the up sensor while being told to lift,
003 Timeout moving up but did come off the Load Arm Down sensor. Check that the up
sensor is working and no jam has occurred.
LoadArmError | Timeout movina down while on The load arms have been told to move down, but they never
9 came off the Load Arm Up sensor. Check signal to air cylinders
004 up sensor .
and couplings to load arms.
The load arms never saw the down sensor while being told to
LoadArmError | . . :
005 Timeout moving down drop but did come off the Load Arm Up sensor. Check up
sensor is working and no jam has occurred.
LoadArm Board removed from load Board sensor (load arms) sensor is damaged or location needs
Error006 arms unexpectedly to be adjusted
Machine NO air pressure Check air supply to saw, air regulator setting, and pressure
Error001 P switch setting. Clean pneumatic filter.

MachineError
002

Saw stroke is not retracted
(not on the home sensor)

Follow on-screen instructions. The stroke is not retracted when
the machine requires it to be.

MachineError
008

The infeed board through
beam sensor is blocked after
clearing the saw

The board beam sensor located by the print heads is blocked
when it should not be, indicating there is either an obstruction or
an issue with the sensor, cabling, or PLC.

MachineError
010

The bevel is not square before
the saw stroke

The bevel is required to be square before the saw strokes
unless the PC allows it not to be. The home sensor is used to
know if the bevel is generally square.

MachineError
011

The saw blade not running at
velocity

The saw blade is either not running or running at a velocity
lower than it should be.
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Table A-4: Errors in Software

Should you lockout/tagout to /s
safely perform this action?

Error Code

Text on Screen

Definition or Solution

MachineError
014

The stroke is not on the home
sensor after a Home System
was performed. If the stroke
does not currently have an
error, it is most likely that the

stroke home offset is incorrect.

To reset the stroke home offset go to Diagnostics>Detailed
Diagnostics>Stroke and click the Home Offset RESET button.
Follow the on-screen instructions.

MachineError
015

The bevel is not on the home
sensor after a Home System
was performed. If the bevel
does not currently have an
error, it is most likely that the
bevel home offset is incorrect.

To reset the bevel home offset go to Diagnostics>Detailed
Diagnostics>Bevel and click the Home Offset - Reset button.
Follow the on-screen instructions.

The bevel is required to be square after homing. The home
sensor is used to know if the bevel is generally square. This is a
basic calibration check.

MachineError
016

The LASM lockout sensor was
unexpectedly covered during a
saw extend

There is a sensor that is centered on the saw blade that the
LASM will trip if the LASM position is plus or minus about 4
inches. If this sensor is tripped and the software has not
allowed it to be tripped, this error will show.

Check air supply to saw, air regulator setting, and pressure

Outfeed switch setting. Clean pneumatic filter.
Time out clamping
Error002 Outfeed Unclamped sensor is damaged or location needs to be
adjusted
OutfeedError When unclamping, the Outfeed Unclamped sensor is not
003 Timed out unclamping covered after 2 second. Check that cylinder is not jammed and
is receiving signal to relay.
The outfeed clamp clamped all the way closed when it was
OutfeedError : .
004 Unexpected full clamp expected to clamp onto lumber. Determine why board is not
exiting saw chamber properly.
Outfeed Unclamped sensor is damaged or location needs to be
Outfeed Timed out running until empty | adjusted
Error005
Inspect outfeed chain for wear
The machine is not in an If the servos are not ready or the machine is not in the ready
PMGO0005 : . ) )
appropriate state for cutting. homed state when trying to start cutting.
The saw stroke will not be . .
PMGO006 | executed because the blade Zggf:f;‘é"féfngﬁgzrjiz :g'fhzrg’[é" hen calculating the data
will intersect with the LASM. 9 :
The rip bevel angle specified is
out of range. . .
PMG0010 The software generates this error when calculating the data

Rip Angle = {0}
Valid range = 0 - 56.

before sending the data to the PLC.
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Table A-4: Errors in Software

Should you lockout/tagout to /|
safely perform this action?

Error Code Text on Screen Definition or Solution
SawBlade Output current exceeds trip The saw motor is using more current than it should. The saw
Error2310 limit. blade is binding or the power cable is shorting.
SawBlade Control board temperature is : .
Errord110 above 88°C. The VFD control board temperature is too high.
SawBlade Drive IGBT temperature is The VFD motor dnvg CIFC'EUItry. temperature is too high. The saw
: motor may be experiencing high loads such as a dull saw
Error4210 excessive
blade.
SawBlade _Converte_r module temperature The VFD motor drive circuitry temperature is too high.
Error4290 is excessive.
SawBlade . The saw blade braking resistor is being overloaded. The
Brake resistor overload . .
Error7112 deceleration parameters may be set incorrectly.
Drive disabled, axis motion not
possible. The servo may be
encountering an obstruction.
ServoError If this servo is contacting the Check for obstructions.
05B stop at either end of travel, . .
calibrate the Home Offset for Calibrate axis
this specific servo only using
Tools>Calibrate>[this servo]>
Home Position.
ServoError Check for obstructions.
Over current condition
0D1 Calibrate axis
Position was no longer valid
(Position Valid axis status bit is
off). The servo may be
encountering an obstruction.
ServoError If this servo is contacting the Check for obstructions.
264 stop at either end of travel, Calibrate axis
calibrate the Home Offset for
this specific servo only using
Tools>Calibrate>[this servo]>
Home Position.
ServoError Timeout while waiting for
300 power feedback from the Check safety modules.
amplifier
. When clamping on the board the Side Clamp Unclamped
SideClamp ) : : . .
Error002 Timed out clamping sensor is not uncovered after 2 second. Check cylinder is not

jammed and is receiving signal to relay.
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Table A-4: Errors in Software

Should you lockout/tagout to /|
safely perform this action?

Error Code Text on Screen Definition or Solution
. When unclamping the Side Clamp Unclamped sensor is not
SideClamp ) . \ . )
Error003 Timed out unclamping covered after 2 seconds.Check that cylinder is not jammed and
is receiving signal to relay.
SideClamp Side Clamp Fully Clamped sensor is damaged or location
Error004 Unexpected full clamp needs to be adjusted.
The {0} servo was requested
to move to {1} {2} which is out
of range.
The limits are {3} to {4} {2}. Calibrate axis.
SRV0004 o :
If the machine is processing | verify minimum and maximum positions.
parts, the saw cannot process
this part. Reject the board with
this part and re-start the
machine.
The saw has detected a
possible out of calibration
SRV0006 situation on the {0} axis. Itis Calibrate axis.
recommended to calibrate the
{0} home offset using Tools>
Calibrate.
. _ Home sensor for indicated axis is damaged or location needs to
SRV0007 {0} servo has timed out during | pe adjusted.
a move or cycle.
Check for mechanical obstruction.
{0} servo has encountered an
obstruction.
If this Servo 1 contacting the Check for mechanical obstruction.
SRV0011 stop at either end of travel,
calibrate the Home Offset for | Calibrate axis.
this specific servo only using
Tools>Calibrate>[this servo]>
Home Position
When moving the clamp down onto the board, the operation
TopClamp ) . S ) . :
Error002 Time out moving down dldnlt complgte af_ter 4 seconds. Check cylinder is not jammed
and is receiving signal to relay.
E?focrcl)%rgp Time out moving up The top clamp took longer than it should have when moving up.
The board beam sensor located by the print heads is blocked
TopClamp Lumber sensor blocked when | when the 'ready' command is sent. The 'ready' command
Error004 sent to ready moves the top clamp down when the board beam sensor is

broken.
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Table A-4: Errors in Software

Should you lockout/tagout to /|
safely perform this action?

Error Code Text on Screen Definition or Solution
TopClamp Unexpected full clamp The top clamp attempted to clamp a board but no board was
Error007 present.
OutfeedVFD | Output current exceeds trip : L .
Error0001 limit. Most likely a physical jam. Clear the obstruction.
OutfeedVFD | Short-circuit in motor cable(s)
Replace cable and/or motor.

Error0004 or motor.

Motor is operating in stall
OutfeedVFD | region due to e.g. excessive : L .
Error0012 load or insufficient motor Most likely a physical jam. Clear the obstruction.

power.

One of motor phases is lost
OutfeedVFD | due to fault in motor, motor Repair/replace parts listed as necessa
Error0034 cable, thermal relay (if used) P P P Y-

or internal fault.
OutfeedVFD STO (Safe torq_ue Oﬁ). An E-stop has been requested and the dual circuit channels

requested and it functions
Error0044 opened properly.

correctly.

STO (Safe torque off) input

channel 1 has not de- -
OutfeedVFD | energized, but channel 2 has. When an E-stc?p was |n|t|§ted, only 1 of the 2 channels opened

. properly, the circuit that did not open may be shorted or a
Error0045 Opening contacts on channel
. contact welded.

1 might have been damaged

or there is a short-circuit.

STO (Safe torque off) input

chanqel 2 has not de- When an E-stop was initiated, only 1 of the 2 channels opened
OutfeedVFD | energized, but channel 1 has. o .

: properly, the circuit that did not open may be shorted or a
Error0046 Opening contacts on channel
. contact welded.

2 might have been damaged

or there is a short-circuit.
WasteConv Output current exceeds tri
VFDError -utp P Most likely a physical jam. Clear the obstruction.

limit.
0001
WasteConv S
VFDError Short-circuit in motor cable(s) Replace cable and/or motor.

or motor.
0004
WasteCony | o exceasive
VFDError 9 . €.9. Most likely a physical jam. Clear the obstruction.
0012 load or insufficient motor

power.
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Table A-4: Errors in Software

Should you lockout/tagout to
safely perform this action?

Error Code Text on Screen Definition or Solution
WasteConv One of motqr phases is lost
due to fault in motor, motor . .
VFDError . Repair/replace parts listed as necessary.
cable, thermal relay (if used)
0034 :
or internal fault.
WasteConv STO (Safe torq_ue Oﬁ). An E-stop has been requested and the dual circuit channels
VFDError requested and it functions onened properl
0044 correctly. P properly.
STO (Safe torque off) input
WasteConv chann_el 1has not de- When an E-stop was initiated, only 1 of the 2 channels opened
energized, but channel 2 has. o .
VFDError . properly, the circuit that did not open may be shorted or a
Opening contacts on channel
0045 . contact welded.
1 might have been damaged
or there is a short-circuit.
STO (Safe torque off) input
WasteConv chann_el 2 has not de- When an E-stop was initiated, only 1 of the 2 channels opened
energized, but channel 1 has. o :
VFDError . properly, the circuit that did not open may be shorted or a
Opening contacts on channel
0046 contact welded.

2 might have been damaged
or there is a short-circuit.
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Should you lockout/tagout to /|
safely perform this action?

Indicators on Specific Electronic Devices

See the Operation Manual for indicator lights required for normal operation of the equipment.

PLC CPU Indicators

Refer to the PLC manufacturer’s manual.

' If there is power there will be many LEDs lit throughout the PLC rack. Although the “Power”
“:‘\‘ light located on the left end of the PLC rack may still be lit, full 24 VDC may not be present.
4“1 If the PLC rack does not have multiple LEDs lit, then a full 24 VDC is not present.

Ethernet Indicators

Table A-5: Explanation of Ethernet Indicators

LED LED State CPU Operating State

100 On, green Network data speed is 100 Mbps
Off Network data speed is 10 Mbps

LINK On, green The link is physically connected
Blinking green Traffic is detected at the port

Amplifier Indicators

The servo amplifier unit detects error conditions and provides alarm information. The indicator lights on the front
of the servo amplifier unit communicates the following:

Table A-6: Explanation of Amplifier Indicators

LED LED State CPU Operating State

POWER On, green 24 VDC power is present.

DC LINK CHARGED  On, red High (motor) voltage DC is present.
LINK On, green Fiber optic interface is functioning.

Alarm condition is detected.When an alarm is detected, power
is dropped and the motor is stopped by dynamic braking action.

ALM On, yellow Alarm information is displayed as diagnostic data in the motion
controller.

E-Stop Module Indicators

Refer to page MT-145.
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Servo Motion Module Indicators

Should you lockout/tagout to /s
safely perform this action?

The servo motion module provides communication between the servo axes and the PLC. The indicator lights are

defined here.

Table A-7: Axis Indicators on Servo Motion Module (Model PMM335)

LED LED State PMM335 Operating State

Axis 1 On, green The axis drive corresponding to this LED is enabled.
AX?S 2 On, red A normal stop error has occurred on this axis.

ﬁi:z 3 Blinking red (500 ms intervals) A fast stop error has occurred on this axis.

Table A-8: PMM Status Indicators on Servo Motion Module (Model PMM335)

LED LED State PMM335 Operating State
Off The module does not have power.
On, green The module is functioning properly and there are no errors.
Blinking green (1 sec intervals) Indicates that a Warning or an Error not requiring a stop
has occurred.
Blinking green (500 ms intervals) Indicates that an Error requiring a fast or normal stop has
occurred.
Status Blinking green (interval is a The blink pattern indicates that a fatal error has occurred.
pattern) and CONFIG and all axes  Record the number of blinks in the sequence and contact
LEDs are off the module’s manufacturer’s Technical Support.
Green, blinking simultaneously
with the CONFIG and LEDs are off The module is currently loading a firmware upgrade.
for all axes.
A severe module hardware error watchdog timeout has
On, amber
occurred.
On. areen The module has received a valid configuration from the
9 RX3i CPU.
L The module has not yet received a configuration from the
i Blinking green
Config programmer.

On, amber

The module is in boot mode.

Blinking amber

The module received an invalid configuration from the
programmer.

001080 rev. A
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Should you lockout/tagout to ||
safely perform this action?

Table A-8: PMM Status Indicators on Servo Motion Module (Model PMM335)

Off FSSB communications is inactive
On, green FSSB communications is active.
FSSB FSSB setup is in progress or servo ampli'fiers not yet
Blinking green available. Axes can be used with synthetic motor.
This is normal operation.
On, red FSSB communication link has failed.
Off Fiber 1/0O communications is inactive.
On, green Fiber /O communications is active.
Blinking green Fiber I/O configuration is in progress
FTB On, red Fiber I/O communication link has failed.

Indicates an FTB ID error. The module is attempting to
Alternately blinking green and red communicate with an FTB that does not have the correct
PMM/FTB communications link ID.

Axis ldentification

Table A-9: Identification Number for Each Axis

Gripper
LASM
Elevation
Stroke
Angle
Bevel

| WIN|=-

001080 rev. A Troubleshooting
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Appendix B

Navigating the Parts List Appendix

Finding the Part Number

The parts list provided here shows spare parts that should be kept in stock at all times. Use
one of the methods shown in Table B-1 to locate your part number.

For a complete list of replacement parts, or if you’re unsure of which spare part you need
and would like to see a picture, use the electronic Parts Guide for this machine. The
electronic Parts Guide can be found on our Web site.

Table B-1: How to Find Your Part Number

If it is a part that should be
kept in stock, it is listed in
the Parts List in the manual
and in the electronic Parts
Guide. Locate the correct
part name and description
in the manual to find the
part number. If you're
unsure of which part you
need, use the electronic
Parts Guide instead to see
a picture.

1.

Click Machinery.

In the drop-down menu,
select Parts Guide to
access the Quick
Reference Parts Guide.

. Choose your equipment

name and browse
through the pictured
parts to find your part
number.

. Place the CD in your

computer’s CD drive. It
should automatically
launch a Main Menu
screen.

. If more than one

machine shows on the
Main Menu, click the
machine for which you
are ordering parts.

. Browse through the

pictured parts to find
your part number.

Ordering the Parts With Your Part Number

Call us at 1-800-523-3380 and select Parts Orders.

001080 rev. A
Original Instructions
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MiTek’

Safety Notes for Replacing Parts

Only use the exact replacement parts that are
specified by MiTek. Substitutions may harm your
equipment.

/A  WARNING

ELECTROCUTION, CRUSH, CUT, and

HIGH-PRESSURE HAZARDS
Perform the safety tests described in the Safety Tests
section on page SAFETY-11 before operating the

equipment at the initial startup, after performing any
maintenance, and in accordance with the maintenance
schedule.

/A  WARNING

ELECTRICAL HAZARD!

All electrical work must be performed by a licensed
electrician.

Follow approved lockout/tagout procedures
(OSHA 29 CFR 1910.147).

/A  WARNING

ELECTROCUTION AND HIGH PRESSURE HAZARDS.

ftf Always turn the power off by activating an E-stop

when the equipment is not in operation.

Always verify that all power to the machine has been

turned off and follow approved lockout/tagout safety
procedures (OSHA 29 CFR 1910.147) before
ﬁ\ performing any maintenance on this equipment.

Turn off the air switch or shutoff valve if appropriate.

Bleed pneumatic lines if appropriate.

001080 rev. A Parts List
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MiTek’

Part Numbers

Spare Parts Kit

The spare parts kit is part number 89061-901. For a list of parts included in the spare parts
kit, refer to our website. The Keep in Stock column does not indicate it is in the spare parts
kit. It is the customer’s responsibility to ensure you have these parts.

Mechanical Parts

Here is a list of mechanical parts that may not be in the online Parts Finder.

Table B-2: Mechanical Replacement Parts and Sensors

MiTek Part # Part Description

SB209KIT-A linear bearing block for stroke, elevation, and LASM

SB209KIT-B I;?aeri:)’bgigligleoec;éfarni]gpper, infeed side clamp, top

337171 Spikes (teeth) (set screws) on LASM jaws

423439 sensor, LASM clamp extend & retract

423448 sensor, HSC-12 for outfeed clamp cyl and top clamp cyl

447006 bumper, black rubber, LASM and Angle belts

447007 bumper, black rubber, at Angle motor

447008 bumper, black rubber, Elevation

471339 servo motor: LASM, stroke, bevel, gripper, elevation

471340 servo motor: angle (has internal brake)

474173 motor for saw blade, 5hp, 3450rpm, 230/460

503176 e-chain on Infeed Rail

515947 prox, 1'8mm, Home sensor for Gripper, Stroke,
Elevation, and LASM (right end of travel)

515948 prox, 18mm, LASM at “0” (center of travel)

515964 prox, 8mm HOME SENSOR angle and BEVEL assy

005-02501 pulley, used in LASM and stroke drive assemblies

SB202KIT saw blade replacement kit (includes 1 box of screws)

305184 screws for saw blade replacement, gty 50

(does not include saw blade)

530030-552.00

belt, timing, gripper, 552” long
(trim to size for any timing belt

see online
Parts Guide sensor, CLS w/BLADE program
508094 protective sleeve for blade motor cable

001080 rev. A
Original Instructions
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MiTek’

Electrical Parts

Refer to your electrical drawings for part numbers. It is recommended that you keep a
variety of extra fuses and sensors in stock.

Printer & Pneumatic Parts

Table B-3: Pneumatic and/or Printer Replacement Parts

MiTek Part # Part Description
see Prlpter black ink for printer
appendix
see Printer .
. cleaner for printer
appendix
438575 filter element for main filter/regulator
438579 service kit for main filter/regulator
005-00135 filter for printer bottles
filter element for touch screen enclosure cooler
809054 g
(located next to main filter/regulator)
809055 Rebuild kit w/O-rings for cooler filter

Documentation Part Numbers

Table B-4: Documentation

MiTek Part # Documentation

001080 Manual

SB202KIT (nclucs blace and sorows)
SB209 Lubricating linear bearings Service Bulletin
SB223KIT Replacing LASM seals Service Bulletin
SB181 Restricted Zone Tape and instructions
89550-501 Operation and safety labels kit, mechanical
691290 Label: 230 Volt

691351 Label: Read manual

691411 Label: Danger, arc flash

691507 Label: Warning, hazardous voltage
691528 Label: Warning, do not touch, hot

691606 Label: Caution, not a step

691701 Label: Notice, turn off at main panel
691821 Label: MiTek contact information
001080 rev. A Parts List
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Appendix C

Navigating the Maintenance Checklists

These checklists guide you through all preventive maintenance tasks required to keep this
equipment in top working condition.

These pages are supplied with the intent that you will photocopy them and leave the
original in the manual for future use. Space is provided in each chart to place the date that
the work is done and the initials of the person performing the work.

Daily & Weekly Checklist page 234
Monthly Checklist page 235
Annual Checklist page 236
Periodic Checklist page 236
001080 rev. A Maintenance Checklists
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BLADE Wood Processing System

Safety Notes For Maintenance Checklists

A  WARNING

ELECTROCUTION, CRUSH, CUT, and
HIGH-PRESSURE HAZARDS

Perform the safety tests described in the Safety Tests
section on page SAFETY-11 before operating the
equipment at the initial startup, after performing any
maintenance, and in accordance with the maintenance
schedule.

A  WARNING

ELECTROCUTION AND HIGH PRESSURE HAZARDS.

Always turn the power off and activate an E-stop when
the equipment is not in operation.

Always verify that all power to the machine has been
turned off and follow approved lockout/tagout safety
procedures (OSHA 29 CFR 1910.147) before
performing any maintenance on this equipment.

Turn off the air switch or shutoff valve if appropriate.

Bleed pneumatic and hydraulic lines if appropriate.

001080 rev. A
Original Instructions
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BLADE Wood Processing System

Daily & Weekly

Checklist

Month and Year:

Lockout/tagout before performing any maintenance!

If power is required, ensure all personnel are clear.

Week:

Perform all safety tests. | Daily 1S1AFETY'
Blow off system,

including Auto Deck,

Infeed Rail, lumber exit Daily | MT-68
chain, and outfeed

table/conveyor

Vacuum stroke/elev. Daily | MT-68
chamber

Clean printer nozzles 2x/Day | MT-69
Inspf_ect Imgar guide Weekly | MT-89
bearing rails for grease

Replace saw blade Weekly | MT-99

Notes

Date

001080 rev. A
Original Instructions
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BLADE Wood Processing System

Monthly
Checklist

Year:

Lockout/tagout before performing any maintenance!

If power is required, ensure all personnel are clear.

Check lumber exit chain

: : 1 month | MT-117
tension and alignment
Qrease 2 fittings on elevation 3 months | MT-96
jack screw
Check oil level in all gearboxes | 3 months | MT-73
Powered Skewgd Conv. drive 6 months | MT-131
wheel bearings: grease
Replace main regulator’s filter 6 months | MT-135
element
Replace cooler’s filter element | 6 months | MT-136

Check lumber exit chain

. . 1 month | MT-117
tension and alignment
_Grease 2 fittings on elevation 3 months | MT-96
jack screw
Check oil level in all gearboxes | 3 months | MT-73
Powered S!<ewed Conv. drive 6 months | MT-131
wheel bearings: grease
Replace main regulator’s filter 6 months | MT-135
element
Replace cooler’s filter element | 6 months | MT-136

001080 rev. A
Original Instructions
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BLADE Wood Processing System

Annual

Checklist

Year:

Lockout/tagout before performing any maintenance!

If power is required, ensure all personnel are clear.

Lubricate 2 grease fittings on saw blade assy | 1x/year MT-96

Auto Deck motor/gearbox: grease 1x/year MT-107
31:;?] (Ij:)eck drive shaft: grease 1 fitting per Ixlyear MT-107
Lubricate outfeed clamp camfollowers 1x/year MT-115
Lumber exit chain drive gear motor: grease 1x/year MT-117
Waste conveyor drive bearings: grease 1x/year MT-124
Inspection 1x/year MT-71

Periodic Checklist

Year:

Auto Deck motor/gearbox: replace oil | standard oil: MT-72
Lumber exit chain drive gear motor: 10,000 hrs or
; 2 yrs MT-72
replace oil
. .| Synthetic oil:
Waste conveyor gear motor: replace oil 20,000 hrs or MT-72
Saw blade motor: replace oil 4 yrs MT-72
Nabtesco gearbox: replace oil 20,000 hrs MT-76

001080 rev. A
Original Instructions
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Appendix D

Drawings are inserted at the back of the manual or in a
separate binder.

Table D-1: Attached Drawings

Description Drawing Number
Blade saw assembly, top level (saw only) 89060-501
Mechanical assy, top-level (saw only) 89061-501
Auto Deck no drawing
Guards and safety devices 89100-501
Frame assy 89120-501
CLS assy 89155-501
LASM assy 89160-501
Lumber exit chain drive 89170-501
Outfeed clamp assy 89640-501
Waste conveyor assy 89195-501
Infeed Rail assy 89200-501
Gripper assy 89280-501
Top and side clamp assy 89300-501
Pneumatic assy 89346-501
Saw blade head assy 89430-501
Stroke and elevation assy 89435-501
Printer schematic 89448-xxx
Printer assy 89460-xxx
Lumber exit ramp assy 89465-501
Outfeed table 89490-501
Electrical assy, top-level 90615-501
Main enclosure assy 90615-502
Auto Deck electrical 90626
Operator interface assy 90615-507
001080 rev. A Drawing Set
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Glossary

actuate

affected employee

amperage

authorized employee

Auto Deck

Auto Mode

automated lumber
feed system

axis

bevel

board

bow

to activate, put into action

an employee whose job requires him/her to operate or
use a machine or equipment on which servicing or
maintenance is being performed under lockout or tagout,
or whose job requires him/her to work in an area in
which such servicing or maintenance is being performed

the strength of an electric current, expressed in amperes

a person who locks out or tags out a machine or
equipment in order to perform servicing or maintenance
on that machine or equipment; an affected employee
becomes an authorized employee when that employee’s
duties include performing servicing or maintenance
covered under this section

a staging conveyor that feeds lumber to the Infeed Rail

the normal operation mode when the saw is using job
files to cut the lumber in the correct order

mechanical system used to feed lumber to the Infeed
Rail; can be the Auto Deck staging conveyor or an
automated lumber retrieval system

a main line of direction, motion, growth, or extension;
includes angle, bevel, elevation, and stroke; plural is
axes

the cut on the 4” dimension of a 2x4, is an optional
feature

A specific piece of lumber with specific dimensions
required by the saw to cut out specific parts

a curve of the face of a board (3-1/2” surface on a 2x4);
the bow points to the side on floor and wall studs

001080 rev. A
Original Instructions
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bumper a small, black rubber shock resistor used throughout the
interior of the saw

bus bar an electrical device that allows multiple gantry heads to
be used simultaneously

CLS Crooked Lumber Sensor; senses when a piece of lumber
is crooked and adjust the cut to compensate

connector plate a metal plate with “teeth” that hold truss or wall
components together

crown a curve of the edge of a board (1-1/2”” edge on a 2x4); the
crown points up for floor studs or out for wall studs

disconnect noun, the handle, often on a machine’s main electrical
enclosure, that shuts off incoming power at that spot in
the electrical system

elevation the assembly that moves the saw blade up and down

energized connected to an energy source or containing residual or
stored energy

energy isolating device a mechanical device that physically prevents the
transmission or release of energy, including but not
limited to the following: manually operated electrical
circuit breaker; a disconnect switch; a manually operated
switch by which the conductors of a circuit can be
disconnected from all ungrounded supply conductors,
and in addition, no circuit can be operated
independently; a line valve; a block; and any similar
device used to block or isolate energy—push buttons,
selector switches, and other control circuit type devices
are not energy isolating devices

energy source any source of electrical, mechanical, hydraulic,
pneumatic, chemical, thermal, or other energy

001080 rev. A Glossary
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felt strip

foot switch
gas spring

gripper

hold-down

home

infeed gripper

job

illuminate

Infeed Rail

infeed side clamp

inventory

jigging

job

LASM

an anti-friction border on the metal plate that the stroke
joins with inside the stroke-elevation chamber

an operating device on the Auto Deck staging conveyor
the mechanism that hold the saw chamber door open

the component on the Infeed Rail that holds the end of
the board and pushes it into the saw chamber

now called the top clamp; located on infeed side of saw

the default location of a component, the act of “homing”
a component means to send it to it’s home position

see gripper

A group of parts requiring specific boards to cut it
efficiently

to light up, to turn on a light, to glow

the rail that lumber rests on before entering the saw
chamber

see side clamp

in the saw software, inventory is the lumber entered into
the software that is available to assign parts to in a job

any of several devices used to hold something; typically
describes holding the truss in place on assembly tables

A group of parts requiring specific boards to cut it
efficiently

Lumber Advance Short Move; grabs the board as it
enters the saw chamber, and moves it to the outfeed side
of the saw chamber, if necessary

001080 rev. A
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LASM lockout sensor

layout

leveling screws

limit switch

load arms

lockout device

lockout/tagout

lumber

lumber exit chain

lumber feed system

lumber pusher

sensor that prevents collisions between the LASM and
the saw blade

a scaled diagram of the location of components and the
space that they occupy

used to refer to any structural leg that can be adjusted up
or down by a screwing motion

an electro-mechanical device that consists of an actuator
mechanically linked to a set of contacts; when an object
comes into contact with the actuator, the device operates
the contacts to make or break an electrical connection

arms that load lumber from the lumber feed system
(Auto Deck or) to the Infeed Rail

a device that utilizes a positive means such as a lock,
either key or combination type, to hold an energy
isolating device in the safe position and prevent the
energizing of a machine or equipment, including blank
flanges and bolted slip blinds; should be standardized
within the facility in at least one of the following criteria:
color; shape; or size; and additionally, in the case of
tagout devices, print and format shall be standardized

ameans of isolating a piece of equipment from its energy
source so maintenance can safely occur; guidelines
provided in OSHA 29 CFR 1910.147

A group of boards or a non-specific board; no
consideration given to the final size or shape

outfeed chain, part of the outfeed assembly

any system that feeds lumber to the Infeed Rail; usually
the Auto Deck staging conveyor or an automated lumber
retrieval system

on Auto Deck, pushed the lumber onto the Infeed Rail

001080 rev. A
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Lumber Yard

Manual Mode

master printer
enclosure

Miser

operator control
interface or operator
interface

operator interface
panel

outfeed assembly

panel

part

PC
plate

PLC

The virtual lumber yard in the saw software that lists
lumber available to use and allows the operator to assign
each board in a job to a specific lumber in the virtual
inventory.

the mode the saw is in when operating it from the
Diagnostics screen

the enclosure that powers the first printer in the system
(included in saw purchase)

a linear saw created by The Koskovich Company and
sold by MiTek

the physical components and methods in which the
operator controls the machine; for this equipment, it is a
touch screen and panel of mechanical buttons

a group of controls located on the operator interface, to
the right of the touch screen

the entire area between the saw chamber and the outfeed
table or conveyor; includes the lumber exit chain and
outfeed clamp

may refer to an electrical enclosure or a group of
controls, such as the operator interface panel located on
the touch screen enclosure

A piece of a board, cut to the exact size and shape
required for the job

personal computer
see connector plate

Programmable Logic Controller; a solid-state control
device that can be programmed to control process or
machine operations.

001080 rev. A Glossary
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port
potentiometer
Powered Skewed
Conveyor

proximity switch

qualified person

a connection point for a peripheral device

a control knob that is a dial; allows a range of values to
be set by turning the dial, also called pot switch

an optional outfeed conveyor that integrates with the
system to transport and sort the lumber

a switch that uses an electromagnetic field to detect
when an object is near, there is no physical contact
between the object and the switch; inductive proximity
switches detect only metal objects, capacitive proximity
switches can sense both metallic and non-metallic
objects

a person or persons who, by possession of a recognized
degree or certificate of professional training, or who, by
extensive knowledge, training, or experience, has
successfully demonstrated the ability to solve problems
relating to the subject matter and work—ANSI B30.2-
1983; one who has skills and knowledge related to the
construction and operation of the electrical equipment
and installations and has received safety training on the
hazards involved—NEC2002 Handbook

regulator a component of the pneumatic system that connects to
the main air source and regulates the air pressure allowed
into the system

side clamp roller clamp on infeed side of saw that contacts the face
of the lumber

solenoid an assembly used as a switch consisting of a coil and a
metal core free to slide along the coil axis under the
influence of the magnetic field

station a physical location on an automatic lumber feed system

stroke the assembly that moves the saw blade in and out
(toward or away from operator)

001080 rev. A Glossary
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tagout device a prominent warning device, such as a tag and a means
of attachment, which can be securely fastened to an
energy isolating device in accordance with an
established procedure, to indicate that the energy
isolating device and the equipment being controlled may
not be operated until the tagout device is removed;
should be standardized within the facility in at least one
of the following criteria: color; shape; or size; and
additionally, in the case of tagout devices, print and
format shall be standardized

top clamp roller clamp on infeed side of saw that contacts the top
edge of the lumber; has been called a hold-down

torque a turning or twisting force

touch screen monitor a computer monitor that operates from human touch

VFD Variable Frequency Device; controls the speed of the
cycle

voltage Equal to the difference of electric potential between two

point on a conducting wire carrying a constant current of
one ampere when the power between the points is one
watt

wane a defect in a board where a portion of the wood is
missing from the board edge or face

warp a curve where the face of a board (3-1/2” side on a 2x4);
is higher or lower in one spot than on the rest of the
board

waste conveyor a conveyor under the saw blade that transports waste

lumber to a waste receptacle supplied by customer

wood processing the entire system including the saw, and all devices that
system transports lumber to and away from the saw
001080 rev. A Glossary
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Numerics

3-phase
fuse 167
wiring 82

A

air knives 142
amplifier
indicators 225
amplifiers
location 144
angle
motor location 74
Auto Deck
graphic 63
lubricating shaft 107
lumber stops 106
raising lumber stops 105
sensor locations 195
sensors 188
sequence of events 105
tensioning chain 107
troubleshooting 214
axis number 227

B

bearings 72
exit chain 116
linear guide 89, 90, 91, 92, 93, 94
belt
Powered Skewed Conveyor 131
timing belts 84
waste conveyor 125, 126, 127
belts
gripper 85, 86, 87
length 84
bevel
motor location 74
sensors 188, 189
blade
direction of teeth 97
lubrication 96

measuring motion 157

motor location 74

overload 165

replacing 98

when to replace 97
blade motor cable 170
Board Stretcher

manual 54

software summary 179
bumpers 101

C

calibrating 67
crooked lumber sensor 192
calibration 67
chains
Auto Deck 105, 107
lubricaton 72
lumber exit 114
lumber exit chain 116
checklists 232
clamps
outfeed 114
raising 110
sensors 188, 189, 198
shock absorbers 103
top and side 110
cleaning
electrical components 70
filter element for cooler 136
general 68
printer 69
CLS 192
communicating with elevation 194
location graphic 197
computer 177
profile 185
condensation 138
conveyor
Auto Deck 105
outfeed 130
replacing waste conveyor 128
waste 124
cooler
filter element 136

001080 rev. A
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Index

maintaining 139
coupling, tighten 81
Customer Service 54

D

disconnect switch
fuse 167
drawing set 52, 237

E

electrical
checking voltage 203
graphic of enclosure 66
main enclosure 144
elevation
communicating with CLS 194
felt strips 100
graphic 64
lubrication 96
motor location 74
sensors
safety
sensors 189
elevation pin 101
errors 216
air pressure 140
BLADE software 216
E-stop
perimeter safety cable 143
pull-cord 142, 143
E-stop module 145, 162
ethernet
indicators 225
ethernet switch 186
eWON
connecting 186
overview 186
resetting 187

F

felt strips 100

filter
cooler 136
filter/regulator
graphic 66
replacing filter element 135
fire 28
fuses 167
location 144

G

gearboxes 73
graphics
motor locations 74
overview 62
sensors 195, 196, 197, 198,
grease
linear guide bearings
volume 90
gripper
adjusting 108
belts 85
moving manually 87
sensor locations 196
tension, adjusting 85

H

handle in saw chamber 110
hazardous substances 28
homing 67

incline waste conveyor
adjusting 127
indicators
amplifier 225
E-stop module 145
ethernet 225
PLC 225
servo motion module 226
infeed
adjusting gripper 108
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Index

motor location 74

top clamp and side clamp 110
Infeed Rail

sensor locations 195
inspection 71

K

Kepware
software summary 179
Kepware software 181

L

LASM 113
belt and bearings 113
belts 88
graphics 113
sensor location 198
sensors 188
spikes 113
tension, adjusting 88
license 179
load arms
adjusting 109
sensors 188
lockout/tagout
graphic 53, 57
guidelines 5
procedure 6, 9, 35, 38
lubrication
Auto Deck shaft 107
bearings 72
exit chain bearings 116

general 72

linear guide bearings 89, 90, 91,
92, 93, 94

lumber exit chain drive 116

motors 75

motors and gearboxes 73
outfeed clamp 115
overview 72

lumber exit chain
adjusting location 117
alignment 114

chain guide brackets 118
lubrication 116
tension 117
lumber stops
operating 106
raising 105

maintenance
annual 236
checklists 232
daily and weekly 234
inspection 71
monthly 235
periodic 236
safety during 56
manual
how to use 52
introduction 50
navigation 53
part number 52
purpose 50
understanding formatting 53
motor
coupling or collar 81
slippage 78, 79, 80, 81
motors
changing rotation 82
checking oil 75
location graphic 74
oil 75
overview 73
multimeter 203

N

networking
ethernet
switch 186

notice of change iii

O

operator interface
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Index

computer maintenance 177
graphic 62
outfeed
graphic 65, 66
lubrication 116
motor location 74
outfeed clamp 115, 119
overview 114
outfeed conveyor
adjusting belt 131
aligning 130
lubricating 130
overload
braking resistor 165
overloads
location 144
motor starter 164

P

page change iii
parts 228
documentation part numbers 231
electrical part numbers 231
mechanical part numbers 230
pneumatic part numbers 231
safety while replacing 229
parts list 228
perimeter safety cable 142, 143
PLC
indicators 225
overview
software 180
software summary 179
PLC (programmable logic controller) 155
pneumatics
adjusting system pressure 137
air knives in saw chamber 142
components controlled by 134
drain 138
filter 135
maintenance, general 142
minimum air pressure 140
overview 133
pressure, adjusting 137
printer system relief valve 141

regulator 137, 138
regulator 140
settings 134

Powered Skewed Conveyor

adjusting belt 131
aligning 130
graphic 63
lubricating 130

pressure switch 140
printer

raising 110

relief valve 141
supplies graphic 65
troubleshooting 215

printing the manual 1
profile 185

programmable logic controller, see PLC
pull-cord 142, 143

R

regulator 137

relief valve for printer 141
reporting errors ii
Reports

software summary 179

restricted zones 17
return goods ii
rope E-stop 142

S

safety

during maintenance 233

during troubleshooting 201

E-stop module 162
hazardous substance 28
in Spanish 29
indicators 1
lockout/tagout 5, 53
maintenance 56
replacing parts 229
restricted zones 17
rules 2

safety rules 1, 30
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signal words 1
test 11
troubleshooting w/energy 10
understanding E-stop circuit 145
safety motion sensor 157
location 144
safety symbols 19
saw chamber
air knives 142
graphic 65, 66
scrap conveyor, See waste conveyor
Sensors
Auto Deck & Infeed locations 195
CLS 192
front side location graphic 197
front side locations 197
gripper locations 196
LASM clamped & unclamped 198
locations on infeed side of saw 199
overview 188, 189
sensor gap for prox switches 190
stroke & elevation locations 199
troubleshooting the basics 190
servo motion module
indicators 226
shock absorbers 103
side clamp 110
Software
summary 179
software
BLADE license 180
Kepware license 181
license 179, 180
PLC license 180
summary 179
stroke
belts
LASM & Stroke 88
graphic 64
motor location 74
sensors 189
stroke/elevation chamber
sensors 199

-

take-away conveyor, See waste conveyor
thermostat 139
top clamps 110
troubleshooting
Auto Deck 214
axes identification 227
CLS 192
errors 216
infeed rail 205
material handling 214
printer 205, 215
safety 201
saw 205
saw, printer, and Infeed Rail 205

Vv

VFD 163
location 144
powered skewed conveyor 130
saw 163

W

waste conveyor
adjusting 125, 126, 127
graphic 66
lubricating
motor location 74
replacing belt 128
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